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1 About this guide

This guide describes how to install and configure CA Gateway 3.5 in Docker.

® Revision information
¢ Related documentation
* Documentation feedback

Revision information

See the following table for the issued versions of this document.

Issue Date Section Description

1.0 May 2026 All sections The first release of this document

Related documentation

See the following table for the documentation related to this guide.

Document Contents
CA Gateway 3.x - Entrust nShield Integration of an nShield Hardware Security Module (HSM) with
Integration Guide Entrust CA Gateway

CA Gateway 3.x - Thales Luna Integration  Integration of a Thales Luna Hardware Security Module (HSM) with

Guide Entrust CA Gateway

Documentation feedback

You can rate and provide feedback about product documentation by completing the online feedback form:

https://go.entrust.com/documentation-feedback

Any information you provide goes directly to the documentation team and is used to improve and correct the

information in our guides.

CA Gateway 3.7 - Docker Deployment Guide
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2 Overview

CA Gateway is a lightweight, container-based module implementing a CA-agnostic Certificate Lifecycle and Policy
Management API. Using CA Gateway, your applications can provide certificate issuance, renewal, and revocation
actions across different Certification Authorities (CAs). CA Gateway provides policy retrieval capabilities so
applications can customize APl and user-facing dialogs to ensure that certificate actions conform to organizational
policies.
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See below for a description of each component.

® Client

® |ntegrator
® Tenant

* Managed CA

° CA-specific plugins communicate with the underlying CAs through mutually authenticated TLS.

Client

Each client is an authorized end entity of the CA Gateway APl and is mapped either to a tenant or an integrator.

¢ Clients mapped to an integrator can access many Managed CAs.
® Clients mapped to a tenant can access only that tenant's Managed CA.
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Thus, each CA Gateway client can access one or several CAs.

[ Client ] [ Client ] [ Client ]
A 4 A4 A

[ Tenant H Integrator H Tenant ]
Y Y

‘ Managed CA \ l Managed CA \

The CA Gateway APl is regularly updated to add functionalities. Therefore, client applications:

¢ Should tolerate and ignore new fields.
¢ Should be recompiled against the new data model of each CA Gateway release.

Integrator

Each integrator is an access controller for one or more tenants.

Tenant

Each tenant is an access controller for a Managed CA. Thus, each tenant:

® Has only one integrator.
e Controls access to a different CA.

Managed CA

Each "managed CA" is a set of information that CA Gateway uses to connect to a CA. For example:

¢ Microsoft Active Directory Certificate Services.
* AWS Certificate Manager Private Certificate Authority.
¢ Entrust Certificate Authority.

CA Gateway 3.7 - Docker Deployment Guide



@ ENTRUST

3 Release notes

See below the release notes for CA Gateway 3.2.0to0 3.5

¢ Release notes for 3.2.0
¢ Release notes for3.2.1
¢ Release notes for 3.3.0
¢ Release notes for 3.4.0
¢ Release notes for 3.7.0

Release notes for 3.2.0

See below the CA Gateway 3.2.0 release notes.

* New features for 3.2.0
® Bugs fixed for 3.2.0
¢ Known issuesin 3.2.0

New features for 3.2.0

CA Gateway 3.2.0 adds the following features to CA Gateway.

Cache management (ATEAM-17140)

Sectigo CA support (ATEAM-18339)

Profile selection on request (ATEAM-18358)
Multiple KeyUsage on request (ATEAM-18374)

Cache management (ATEAM-17140)
This release adds support for enabling and disabling CA Gateway API caches.

Sectigo CA support (ATEAM-18339)

This release adds support for integrating Sectigo certificate authorities with CA Gateway.

Profile selection on request (ATEAM-18358)

This release adds support for selecting the user role of certificates issued by an Entrust Security Manager certificate
authority.

Multiple KeyUsage on request (ATEAM-18374)

This release adds support for a plaintext comma-separated list of KeyUsage values on enrollment requests.

Bugs fixed for 3.2.0

CA Gateway 3.2.0 fixes the following CA Gateway bug.

¢ Error when revoking certificates without Subject (ATEAM-11625)
e Missing HTTP Strict Transport Security header (ATEAM-16176)

¢ Missing Content Security Policy header (ATEAM-16215)

¢ Unspecified validation error (ATEAM-17472)

¢ Sectigo CA not supported (ATEAM-18790)

CA Gateway 3.7 - Docker Deployment Guide 10
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Error when revoking certificates without Subject (ATEAM-11625)

CA Gateway returns an error when trying to revoke a certificate with an empty Subject field.

Missing HTTP Strict Transport Security header (ATEAM-16176)
CA Gateway does not add an HTTP Strict Transport Security (HSTS) header to responses.

Missing Content Security Policy header (ATEAM-16215)
CA Gateway does not add a Content Security Policy (CSP) header to responses.

Unspecified validation error (ATEAM-17472)

When entering a malformed value in the Choose a key name field, the Management Console displays a generic
"Please match the requested format" breadcrumb message without indicating the source of the error.

Bug fixing: explicitly indicate that the CA key value must include only lowercase letters, numbers, and dashes ("-").

Sectigo CA not supported (ATEAM-18790)

Certificate Hub 4.2.0 does not support requesting certificates from a CA Gateway 3.2.0 instance integrated with a
Sectigo CA.

To fix this bug, you must install Certificate Hub 4.2.1 and CA Gateway 3.2.1.

Known issuesin 3.2.0

CA Gateway 3.2.0 has the following known issues.

® Mandatory parameters are mutually exclusive (ATEAM-16246)
¢ Slashes not supported in passwords (ATEAM-18325)

Mandatory parameters are mutually exclusive (ATEAM-16246)

When configuring a CA Gateway client, the following mandatory parameters are mutually exclusive (that is, you
must select one but not both).

® TenantID
* Integrator ID

However, the Management Console raises an error during validation if any of these values is unselected.
Detected in: CA Gateway 3.0.0 to 3.0.5.
Workaround:

1. Delete the client settings.
2. Recreate the client settings using either the Tenant ID or Integrator ID parameter.

Slashes not supported in passwords (ATEAM-18325)

CA Gateway deployments on appliances do not support slashes ('/') in passwords (such as keystore passwords,
truststore passwords, Entrust Profile File passwords, etc.).

CA Gateway 3.7 - Docker Deployment Guide 11
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Detected in: CA Gateway installations on EDM (Entrust Deployment Manager) and PKI Hub.

Release notes for 3.2.1

See below the CA Gateway 3.2.1 release notes.

¢ Fixed bugs for3.2.1
® Known issues for 3.2.1

Fixed bugs for 3.2.1

CA Gateway 3.2.1 fixes the following bug.

® Missing HTTP Strict Transport Security header (ATEAM-16176)
* Missing Content Security Policy header (ATEAM-16215)
¢ Sectigo CA not supported (ATEAM-18790)

Missing HTTP Strict Transport Security header (ATEAM-16176)
CA Gateway does not add an HTTP Strict Transport Security (HSTS) header to responses.

Missing Content Security Policy header (ATEAM-16215)
CA Gateway does not add a Content Security Policy (CSP) header to responses.

Sectigo CA not supported (ATEAM-18790)

Certificate Hub 4.2.0 does not support requesting certificates from a CA Gateway 3.2.0 instance integrated with a
Sectigo CA.

To fix this bug, you must install Certificate Hub 4.2.1 and CA Gateway 3.2.1.

Known issues for 3.2.1
CA Gateway 3.2.1 has the following known issues.

¢ Mandatory parameters are mutually exclusive (ATEAM-16246)
¢ Slashes not supported in passwords (ATEAM-18325)

Mandatory parameters are mutually exclusive (ATEAM-16246)

When configuring a CA Gateway client, the following mandatory parameters are mutually exclusive (that is, you
must select one but not both).

¢ TenantID
* Integrator ID

However, the Management Console raises an error during validation if any of these values is unselected.
Detected in: CA Gateway 3.0.0 to 3.0.5.
Workaround:

1. Delete the client settings.

CA Gateway 3.7 - Docker Deployment Guide 12
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2. Recreate the client settings using either the Tenant ID or Integrator ID parameter.

Slashes not supported in passwords (ATEAM-18325)

CA Gateway deployments on appliances do not support slashes ('/') in passwords (such as keystore passwords,
truststore passwords, Entrust Profile File passwords, etc.).

Detected in: CA Gateway installations on EDM (Entrust Deployment Manager) and PKI Hub.

Release notes for 3.3.0

See below the CA Gateway 3.3.0 release notes.

* Bugs fixed for 3.3.0
® Known issues for 3.3.0

Bugs fixed for 3.3.0

CA Gateway 3.3.0 fixes the following bugs.

¢ CA lookup fails when the DN includes tildes (ATEAM-18768)
¢ LDAP and LDAPS port incompatibility not documented (ATEAM-18779)
¢ Incorrect option name in the plugin selector (ATEAM-18782)

CA lookup fails when the DN includes tildes (ATEAM-18768)

The lookup for a CA (Certificate Authority) fails when the DN (Distinguished Name) of the CA contains tildes, like in "
MODERNIZAGCAQ".

LDAP and LDAPS port incompatibility not documented (ATEAM-18779)
The user guide does not properly outline that the LDAP Port and LDAPS Port settings are mutually exclusive.

Incorrect option name in the plugin selector (ATEAM-18782)

The Connector Name selector of the Management Console lists the Sectigo CA plugin as com.Sectigo instead of
com.SectigoCA.

Workaround:

1. Export the CA Gateway configuration using the clusterctl solution config export command
2. Replace com.Sectigo with com.SectigoCA in the following files.

® config-schema.json

® sectigo-schema.json

e application.yml (onlyif CA Gateway has been deployed with the Sectigo CA plugin).
3. Apply the new configuration with the clusterctl solution config import command.

4., Deploy or redeploy the solution with the clusterctl solution deploy command.

Known issues for 3.3.0

CA Gateway 3.3.0 for Docker has the following known issues.

CA Gateway 3.7 - Docker Deployment Guide 13
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¢ Mandatory parameters are mutually exclusive (ATEAM-16246)

¢ subject.certificates field omitted (ATEAM-16264)

Slashes not supported in passwords (ATEAM-18325)

¢ Incorrect option name in the plugin selector (ATEAM-18782)

Sectigo CA profile synchronization requires redeploying CA Gateway (ATEAM-18819)

Mandatory parameters are mutually exclusive (ATEAM-16246)

When configuring a CA Gateway client, the following mandatory parameters are mutually exclusive (that is, you
must select one but not both).

¢ TenantID
* Integrator ID

However, the Management Console raises an error during validation if any of these values is unselected.
Detected in: CA Gateway 3.0.0 to 3.0.5.
Workaround:

1. Delete the client settings.
2. Recreate the client settings using either the Tenant ID or Integrator ID parameter.

subject.certificates field omitted (ATEAM-16264)

For performance reasons, the PKlaaS CA Plugin will not honor the subject.certificates field in the following
endpoint.

api/vl/certificate-authorities/{cald}/subjects/dn

0 Future releases may restore this functionality.

Detected in: CA Gateway 3.0.1 to 3.0.5.

Slashes not supported in passwords (ATEAM-18325)

CA Gateway deployments on appliances do not support slashes ('/') in passwords (such as keystore passwords,
truststore passwords, Entrust Profile File passwords, etc.).

Detected in: CA Gateway installations on EDM (Entrust Deployment Manager) and PKI Hub.

Incorrect option name in the plugin selector (ATEAM-18782)

The Connector Name selector of the Management Console lists the Sectigo CA plugin as com.Sectigo instead of
com.SectigoCA.

Workaround:
1. Export the CA Gateway configuration using the clusterctl solution config export command
2. Replace com.Sectigo with com.SectigoCA inthe following files.
® config-schema.json
® sectigo-schema.json

e application.yml (onlyif CA Gateway has been deployed with the Sectigo CA plugin).

CA Gateway 3.7 - Docker Deployment Guide 14
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3. Apply the new configuration with the clusterctl solution config import command.

4. Deploy or redeploy the solution with the clusterctl solution deploy command.

Sectigo CA profile synchronization requires redeploying CA Gateway (ATEAM-18819)
Changes to Sectigo CA custom fields are not automatically effective in the requestedProperties field.

Workaround: redeploy CA Gateway using the Management Console or the clusterctl solution

deploy command.

Release notes for 3.4.0

See below the CA Gateway 3.4.0 release notes.

¢ New features for 3.4.0
® Known issues for 3.4.0

New features for 3.4.0
CA Gateway 3.4.0 adds the following new feature.

DigiCert CA Support (ATEAM-18568)

CA Gateway 3.4.0 introduces support for issuing DV (Domain Validation) certificates with DigiCert certificate
authorities.

Known issues for 3.4.0
CA Gateway 3.4.0 has the following known issue.

® Mandatory parameters are mutually exclusive (ATEAM-16246)

Mandatory parameters are mutually exclusive (ATEAM-16246)

When configuring a CA Gateway client, the following mandatory parameters are mutually exclusive (that is, you
must select one but not both).

® TenantID
* Integrator ID

However, the Management Console raises an error during validation if any of these values is unselected.
Detected in: CA Gateway 3.0.0 to 3.0.5.
Workaround:

1. Delete the client settings.
2. Recreate the client settings using either the Tenant ID or Integrator ID parameter.

Release notes for 3.7.0

See below the CA Gateway 3.7.0 release notes.

* New features for 3.7.0

CA Gateway 3.7 - Docker Deployment Guide
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® Bugs fixed for 3.7.0
e Known issues for 3.7.0

New features for 3.7.0
CA Gateway 3.7.0 adds the following new features.

¢ Support for renewing Sectigo-issued certificates (ATEAM-18908)
e EJBCA support (ATEAM-18931)
¢ Support for post-quantum cryptography algorithms (PKI-42161)

Support for renewing Sectigo-issued certificates (ATEAM-18908)

This release adds support for issuing certificates issued by a Sectigo CA.

A\ Inthe current CA Gateway release, GlobalSign integration is supported for testing purposes only.

EJBCA support (ATEAM-18931)
This release adds support for Integrating an EJBCA CA.

Support for post-quantum cryptography algorithms (PKI-42161)

This release adds support for post-quantum cryptography (PQC) algorithms. Specifically, when Integrating an
Entrust CA, CA Gateway supports the following algorithms.

¢ Module-Lattice-based Digital Signature Algorithm (ML-DSA)
® Module-Lattice-based Key Encapsulation Mechanism (ML-KEM)

Bugs fixed for 3.7.0

CA Gateway 3.7.0 fixes the following bugs.

¢ Unexpected warning logs (ATEAM-18776)

URL not hardcoded on Sectigo configuration (ATEAM-18856)

Error when renewing a Sectigo-issued SSL certificate (ATEAM-18858)

Sectigo plugin requires profile synchronization enabled by default (ATEAM-18863)

Failed deployments reported as successful (ATEAM-18893)

Digicert CA with Certificate Enrollment Gateway not supported (ATEAM-18920)

Documentation does not describe the risks of enabling SAN attributes on request (ATEAM-19009)
EJBCA plugin ignores the default-query-page-size setting (ATEAM-19038)

Error when enrolling certificates with a DigiCert CA (ATEAM-19060)

Unexpected warning logs (ATEAM-18776)

CA Gateway records unexpected warning logs triggered by the Spring framework. For example:

Check the corresponding BeanPostProcessor declaration and its dependencies/advisors.
If this bean does not have to be post-processed, declare it with ROLE_INFRASTRUCTURE.

CA Gateway 3.7 - Docker Deployment Guide 16
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URL not hardcoded on Sectigo configuration (ATEAM-18856)

When integrating a Sectigo CA, the configuration settings require entering a URL setting. However, this URL value
should be hardcoded, as is always the following.

https://cert-manager.com

Error when renewing a Sectigo-issued SSL certificate (ATEAM-18858)

CA Gateway returns an error when trying to renew an SSL certificate using a Sectigo CA.

Sectigo plugin requires profile synchronization enabled by default (ATEAM-18863)

The enable-ca-profile-sync setting defaultsto false forall profiles. However, the Sectigo configuration

requires this setting to defaultto true.

Failed deployments reported as successful (ATEAM-18893)

When a CA Gateway deployment fails, the management console incorrectly displays the deployment as successful,
even though the process has failed.

Digicert CA with Certificate Enrollment Gateway not supported (ATEAM-18920)
Certificate issuance fails in the following situation:

¢ The Certificate Authority is Digicert CA
¢ The client application is Certificate Enrollment Gateway
® The enrollment protocol is ACME

Documentation does not describe the risks of enabling SAN attributes on request (ATEAM-19009)

The CA Gateway documentation does not clearly explain the risks associated with allowing Subject Alternative
Name (SAN) attributes in enrollment requests.
Bug resolution: A new section in Enabling SAN attributes in the enrollment request describes the risks.

EJBCA plugin ignores the default-query-page-size setting (ATEAM-19038)

The plugin to integrate EJB Certificate Authorities ignores the value of the following configuration setting.

config:cagw.cert-event-tracking.default-query-page-size

Error when enrolling certificates with a DigiCert CA (ATEAM-19060)

CA Gateway returns a "cagw-5000" error when using a DigiCert CA.
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Known issues for 3.7.0
CA Gateway 3.7.0 has the following known issues.

¢ Mandatory parameters are mutually exclusive (ATEAM-16246)
¢ subject.certificates field omitted (ATEAM-16264)
¢ Slashes not supported in passwords (ATEAM-18325)

Mandatory parameters are mutually exclusive (ATEAM-16246)

When configuring a CA Gateway client, the following mandatory parameters are mutually exclusive (that is, you
must select one but not both).

¢ TenantID
* Integrator ID

However, the Management Console raises an error during validation if any of these values is unselected.
Detected in: CA Gateway 3.0.0 to 3.0.5.
Workaround:

1. Delete the client settings.
2. Recreate the client settings using either the Tenant ID or Integrator ID parameter.

subject.certificates field omitted (ATEAM-16264)

For performance reasons, the PKlaaS CA Plugin will not honor the subject.certificates fieldin the following
endpoint.

api/vl/certificate-authorities/{cald}/subjects/dn

0 Future releases may restore this functionality.

Detected in: CA Gateway 3.0.1 to 3.0.5.

Slashes not supported in passwords (ATEAM-18325)

CA Gateway deployments on appliances do not support slashes ('/') in passwords (such as keystore passwords,
truststore passwords, Entrust Profile File passwords, etc.).

Detected in: CA Gateway installations on EDM (Entrust Deployment Manager) and PKI Hub.
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4 Requirements

See below for the CA Gateway hardware and software requirements.

® Docker requirements
® HSM requirements

Docker requirements

CA Gateway is distributed and operates as a Docker container. Our objective in leveraging Docker is to allow
customers to utilize the broad array of Docker capabilities, features, and plug-in drivers. Entrust will make
reasonable efforts to support our CA Gateway product on the customer's chosen Docker deployment.

Platform Version Note

Docker 20.x Operation as a Docker container is supported on all OS platforms supporting Docker.

HSM requirements

CA Gateway on Docker supports the following hardware security modules (HSMs).

Hardware Client driver Firmware Guide

Entrust nShield 13.9.0 (FIPS 140-2 Level 3 mode 12.60.15 & CA Gateway 3.x - Entrust nShield
Connect XC supported) 12.60.2 Integration Guide

Entrust nShield 5¢ 13.9.0 13.2.4

Thales Luna HSM 7 10.8.0 7.7.1-20 CA Gateway 3.x - Thales Luna

Integration Guide

Thales TCT 10.8.0 7.7.1-20

o Log in trustedcare.entrust.com to download the integration guides.
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5 Preparing the deployment

Prepare the CA Gateway deployment as explained in the following sections.

® Getting the CA Gateway license

¢ Downloading the installation files

e Verifying the downloaded files

® | oading the CA Gateway Image

* Tagging the CA Gateway Image

e Listing the images

¢ Generating the systemd service for Podman
¢ Creating the configuration and credentials folders
® Running the Profile Creation Utility

e Verifying the installation

® Securing settings with jTinyUAL

¢ Obtaining the server certificate

Getting the CA Gateway license

To deploy CA Gateway you need a license. After making the order, you will receive an email
from licensing@pki.entrust.com containing:

® The order number.
¢ Asigned license file. Place this file in the configuration folder and grant the required permissions. See
Creating the configuration and credentials folders for details.

0 To switch from password-protected licenses to signed licensed files, replace the zip-path and zip-

password settings under license with signed-path .

Downloading the installation files

You need to download the following installation files from TrustedCare.

File Description

CA Gateway for Docker The image file for deploying CA Gateway on Docker.

Installation

CA Gateway Config Utility The tool described in Running the Profile Creation Utility for generating and

managing the CA Gateway configuration.

To download the CA Gateway installation files

1. Loginto https://trustedcare.entrust.com

2.Go to PRODUCTS / PKI [ Authority.

3. Click on the CA Gateway version you want to download.

4, Select the SOFTWARE DOWNLOADS tab to download the installation files.
5. Select the DOCUMENTS tab to download the product documentation.
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Verifying the downloaded files

Generate a digest to verify the integrity of each downloaded installation and documentation file. On a Windows
machine, you can run the following command line to generate the digest of the <file> file.

certutil -hashfile <file> SHA256

For example:

>certutil -hashfile c:\Users\john\Downloads\edm-2.0.2.iso SHA256
SHA256 hash of c:\Users\john\Downloads\edm-2.0.2.7so0:

d841d57c7e1433622d219a7dea405935ff593a6831clc94balc9dbde763b5baa
CertUtil: -hashfile command completed successfully.

On the SOFTWARE DOWNLOADS and DOCUMENTATION tabs, click the Digest column for each downloaded file
and verify the displayed SHA-256 digest matches the generated one.

Although TrustedCare also displays the MD5 and SHA-1 digests, we recommend using only the SHA-256
algorithm, which is more secure. Further versions of TrustedCare will remove the MD5 and SHA-1
algorithms from the digest list.

Loading the CA Gateway Image

Load the CA Gateway image into Docker or Podman.

[docker|podman] load --input cagw-api-<VERSION>-docker.tar.gz

Where <VERSION> isthe CA Gateway version - for example:

$ docker load --input cagw-api-3.3-2559.docker.tar.gz

Tagging the CA Gateway Image

Once loaded into Docker or Podman, tag the image as the latest.

[docker|podman] tag cagw/api:<VERSION> cagw/api:latest

We recommend tagging your images with the version information - for example:

$ docker tag localhost/cagw/api:3.3 cagw/api:latest

Listing the images

To verify that you have the correct image, list the images deployed into Docker or Podman.
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[docker|podman] 1image 1s

Generating the systemd service for Podman

When using Podman instead of Docker, generate a systemd service as explained below.

® Generating the systems service file
¢ Starting the systemd service
* Checking the systemd service status

Generating the systems service file

Run the following commands to generate the user's systemd service file.

mkdir -p $HOME/.config/systemd/user
cd $HOME/.config/systemd/user
podman generate systemd --new --files --name cagw

See below fora container-cagw.service sample file generated with these commands.

# container-cagw.service
# autogenerated by Podman 4.4.1
# Wed Sep 20 03:47:02 EDT 2023

[Unit]

Description=Podman container-cagw.service
Documentation=man:podman-generate-systemd (1)
Wants=network-online.target
After=network-online.target
RequiresMountsFor=%t/containers

[Service]
Environment=PODMAN_SYSTEMD_UNIT=%n
Restart=always
TimeoutStopSec=70
ExecStart=/usr/bin/podman run \
-—cidfile=%t/%n.ctr-1id \
--cgroups=no-conmon \
-—-rm \
--sdnotify=conmon \
--replace \
-d \
--name cagw \
-p 8444:8080 \
-p 9444:9090 \
-e LOADER_PATH=/etc/cagw/config/plugins \
-v /home/myuser/cagw/config:/etc/cagw/config:Z localhost/cagw/api:latest
ExecStop=/usr/bin/podman stop \
--ignore -t 10 \
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--cidfile=%t/%n.ctr-1id
ExecStopPost=/usr/bin/podman rm \
_-F\
--ignore -t 10 \
--cidfile=%t/%n.ctr-1id
Type=simple
NotifyAccess=all

[Install]
WantedBy=default.target

Starting the systemd service

Run the following commands to start the systemd service managing the cagw container.

systemctl --user daemon-reload
systemctl --user enable container-cagw
systemctl --user start container-cagw.service

Checking the systemd service status

Run the following command to check the service status (it must be running).

systemctl --user status container-cagw.service

Creating the configuration and credentials folders

You need the following folders for the configuration and credential files.

Folder Contents Sample path
<HOST_CONFIG> Host configuration files /home/myuser/cagw/config
<HOST_CONFIG>/<CREDENTIALS> Credential files /home/myuser/cagw/config/credentials

To create the configuration and credentials folders

1. Create the empty folders - for example, running a single command:

mkdir -p /home/myuser/cagw/config/credentials

2. Copy all configuration and credential files to their respective folders.

0 The tool described in Running the Profile Creation Utility creates sample configuration and
credential files for these folders.
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3. Run the following commands to make the folder files accessible to the predefined user and group with the
1339 identifier.

chown -R :1339 <HOST_CONFIG>
chmod -R g+rx <HOST_CONFIG>
chmod -R g+s <HOST_CONFIG>

For example:

chown -R :1339 /home/myuser/cagw/config
chmod -R g+rx /home/myuser/cagw/config
chmod -R g+s /home/myuser/cagw/config

Running the Profile Creation Utility
The CA Gateway distribution includes the Profile Creation Utility to:

¢ Create a basic configuration for testing the CA Gateway deployment.
e Migrate or validate an existing configuration.

See below for how to install and run this tool.

¢ Installing the Profile Creation Utility

Setting the Java path

Normalizing exceptional Camel Case keys

Normalizing a legacy configuration with the Profile Creation Utility
Creating a basic configuration with the Profile Creation Utility
Bootstrapping CA Gateway with the generated configuration
Validating the configuration with the Profile Creation Utility

Installing the Profile Creation Utility
See below for installing the Profile Creation Utility.
To install the Profile Creation Utility

1. Login to https://trustedcare.entrust.com

2. Navigate to Products > PKI > authority

3. Select your CA Gateway release.

4. Click Download for CA Gateway Config Utility.
5. Extract the contents of the downloaded Zip file.

Setting the Java path

If the Java path is not in your global settings, configure the JAVA_HOME variable using the following scripts.

Script 0s Example

bin/setenv.sh Linux export JAVA_HOME=/usr/java/jdk-17.0.6
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Script 0s Example

bin/setenv.bat Windows set JAVA_HOME=C:\Program Files\Java\jdk-17.0.6

Normalizing exceptional Camel Case keys

When Normalizing a legacy configuration with the Profile Creation Utility, the tool can be instructed how to
normalize exceptional Camel Case keys by making use of the strings listed in the following file.

conf/UpperCaseWords. txt

By default, this file contains the following lines.

DN
DNS
MSCA
AWS

Therefore, when normalizing to kebab-case, the utility formats subjectDNCache as subject-dn-cache instead
of subject-d-n-cache . Edit this file to add additional exceptions.

Normalizing a legacy configuration with the Profile Creation Utility

Beginning with CA Gateway 2.8 all the keys in the application.yml configuration file must meet kebab-case
(words separated by a hyphen). If you are reusing a legacy configuration, open a command-line interpreter in
the bin folder of the Profile Creation Utility and run the following command.

cagw-util normalize-yaml <INPUT_YAML> <OUTPUT_YAML>

Where:

e <INPUT_YAML> isthe path of the file containing the YAML configuration to normalize.
® <OUTPUT_YAML> isthe path for the output file containing the normalized YAML configuration.

For example:

cagw-util normalize-yaml c:/test/input.yml c:/test/output.yml

In the output YAML, the normalizer excludes the comments and the keys with null values ( null, !!
null, ~,spaces,and empty lines).
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Creating a basic configuration with the Profile Creation Utility

To generate a basic CA Gateway configuration, open a command-line interpreter in the bin folder of the Profile
Creation Utility and run the following command.

cagw-util create-skeleton-config [-f] -pwd -env=<ENVIRONMENT> -host=<HOST> [-
1=<LICENSE_FILE>] [-0=<OUTPUT_FOLDER>] -p=<PORT> [-e | -d -hc=<CREDENTIALS_DIR>]

For example:

cagw-util create-skeleton-config -f -pwd -env cagwtest -host cagw.test.org -1
license.json -o c:/test/config -p 8080

cagw-util create-skeleton-config -f -pwd -env=cagwtest -host=cagw.test.org
-1=license.json -o=c:/test/config -p=8080

When prompted, enter the password and press ENTER. For example:

Enter the Keystore password:
c:\test\config\server.pl2 successfully created
:\test\config\cagw-client-1.p12 successfully created
:\test\config\ca.pl2 successfully created
:\test\config\application.yml successfully created

Client DN: cn=cagwtest client 1, o=cagwtest
CAGW Server DN: cn=cagw.test.org, o=cagwtest
CA DN: cn=cagwtest CA, o=cagwtest

CAGW URL: https://cagw.test.org:8080/cagw/vl
CAGW API Docs: https://cagw.test.org:8080/cagw/api-docs
Swagger URL: https://cagw.test.org:8080/cagw/swagger-ui

See below for a description of each parameter.

-d, --docker

® —env, --environment=<ENVIRONMENT>

-f, --force-overwrite

-hc, --host-config-dir=<CREDENTIALS_DIR>
-host, --hosthname=<HOST>

-1, --license-file-name=<LICENSE_FILE_NAME>
® -m, --msca-proxy

® -0, --output-dir=<OUTPUT_DIR>

® -p,--port-number=<PORT>

e -pwd

-d, --docker

Customize the generated application.yml configuration file for Docker environments.
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O when using this convenience flag, each file path in the generated application.yml configuration file
has a base path suited for Docker environments. Alternatively, you can omit this flag and select a
customized base path with the --host-config-dir command.

-env, --environment=<ENVIRONMENT>

Set <ENVIRONMENT> asenvironment name. CA Gateway will use this value when setting unique subject names for
the certificates.

Mandatory: Yes.

-f, --force-overwrite

Overwrite any existing configuration file.

-hc, --host-config-dir=<CREDENTIALS_DIR>

Use <CREDENTIALS_DIR> asthe base path to reference credential files in the

generated application.yml configuration file. For example:

trust-store: <CREDENTIALS_DIR>/truststore.pl2

O This flag is mutually exclusive with --docker .

Mandatory: No. When omitting both this option and the --docker flag,the application.yml file assumes an
empty value - for example:

trust-store: truststore.pl2
-host, --hostname=<HOST>
Set <HOST> asthe IP address or hostname for CA Gateway URLs.

O utility populates <HOST> into the Subject Alternative Name of the generated server certificate.

Mandatory: Yes.

-1, --license-file-name=<LICENSE_FILE_NAME>

Usethe <LICENSE_FILE_NAME> license, where <LICENSE_FILE_NAME> isthe name (notthe path) of the license

file. The application.yml configuration file will reference this file using the following path.

<CREDENTIALS_DIR>/<LICENSE_FILE_NAME>
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Where <CREDENTIALS_DIR> isthe folder selected with one of the following commands.
e —-docker

¢ —-host-config-dir

This command does not support legacy password-protected license files; it only supports signed license
files.

Mandatory: No.

-m, --MscCa-proxy
Customize the generated configuration for supporting Entrust Microsoft CA Proxy.

Mandatory: No.

-0, --output-dir=<OUTPUT_DIR>

Save the generated files in the <OUTPUT_DIR> folder of the host where the utility is executed.

Move the generated files to the <CREDENTIALS_DIR> folder selected with either the --docker, or -~

host-config-dir command.

Mandatory: No. This optional value defaults to the current folder.

-p, --port-number=<PORT>
Configure CA Gateway for listening in the <PORT> port.

Mandatory: Yes.

-pwd
Prompt the user for the keystores password.

Mandatory: Yes.

Bootstrapping CA Gateway with the generated configuration

After Creating a basic configuration with the Profile Creation Utility, you can bootstrap a testing deployment of CA
Gateway.

To bootstrap CA Gateway

1. Copy the following files, generated by the cagw-util tool, to the host configuration folder.
® application.yml
® server.pl2
® cagw-client.p12
® ca.pl2

@ sce Creating the configuration and credentials folders for details on the host configuration folder
path and the required permissions.

CA Gateway 3.7 - Docker Deployment Guide 28



@ ENTRUST

2. Run CA Gateway as explained in Starting up and deploying.

application.yml

The YAML file contaning the main CA Gateway settings. The tool generates this file with a basic configuration that
does not include managed CAs.

server.pl2

The keystore and truststore of the CA Gateway server.

cagw-client.p12

The keystore and truststore of the CA Gateway client. On a Windows host, you can: double-click this file, follow the
dialogue to add the key and certificate into a Windows certificate store, and use the browser for connecting to one
of the CA Gateway URLs.

ca.pl2

The keystore and truststore of an ephemeral CA for starting CA Gateway.

Validating the configuration with the Profile Creation Utility

To validate the application.yml configuration file, open a command-line interpreterin the bin folder of the
Profile Creation Utility and run the following command.

cagw-util validate-yaml <APPLICATION_YML>

Where <APPLICATION_YML> isthe path of the application.yml configuration file - for example:

$ cagw-util validate-yaml application.yml

Validating YML File...

YAML File s Valid but only 1in syntax, content has not been evaluated.

When detecting any error, the tool returns detailed information - for example:

$ cagw-util validate-yaml application.yml

Validating YML File...

YAML File failed to validate: mapping values are not allowed here
in 'reader', line 51, column 21:
properties:
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Verifying the installation

Verify that you have successfully installed CA Gateway as a Docker container. Run this quick and unsecured test
before configuring the SSL and CA connections.

® Running the latest CA Gateway image
® Browsing to an endpoint

Running the latest CA Gateway image

In a new terminal, run the latest CA Gateway image, mapping the internal CA Gateway port 8080 to the localhost
port 8444.

[docker|podman] run -d --rm -p 8444:8080 -p 9444:9090 -v <HOST_CONFIG>:/etc/cagw/
config cagw/api:latest

Where <HOST_CONFIG> isthe folder described in Creating the configuration and credentials folders. For example:

docker run -d --rm -p 8444:8080 -p 9444:9090 -v /home/myuser/cagw/config:/etc/cagw/

config cagw/api:latest

See the table below for a description of each option.

Option  Description

-d, - Launches the container in the background. Skip this option to see the CA Gateway log output while
detach running, although it might terminate CA Gateway when closing the terminal.

-p, -- Binds a port.

expose

-rm Cleans up the container and removes the file system when the container exits.

V- Maps the <HOST_CONFIG> folder (described in Creating the configuration and credentials
volume

folders) with a folder in the Docker container.

Refer to the Docker documentation for more details on the supported options.

Browsing to an endpoint

In the CA Gateway server, open a Web browser and navigate to:

http://localhost/cagw/v1l

You canreplace localhost with the server's hostname or IP address. This URL omits the port number because
the CA Gateway port is mapped to port 8444,
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o See Checking the CA Gateway health for how to check the CA Gateway health endpoints.

Securing settings with jTinyUAL
The CA Gateway deployment provides the jTinyUAL utility for securing sensitive information in plain text files.

® Checking entropy
¢ Creating jTinyUAL files to protect settings
¢ Creating a jTinyUAL properties file

o If you secure a setting using jTinyUAL and specify a plaintext version of the same setting in another CA
Gateway configuration file (such as application.yml), the jTinyUAL-protected setting takes
precedence.

Checking entropy

The entropy required by the TinyUAL library of the jTinyUAL utility may exceed the available entropy on the CA
Gateway system. If TinyUAL does not have sufficient entropy to encrypt settings, CA Gateway may experience
significant delays during startup.

To check if your host system has enough entropy, run the following command.

head -c 8192 /dev/random | hexdump

If the command completes almost immediately, the server has enough entropy. However, if it takes several
minutes, the server does not have enough entropy, and you must install a daemon.

o Run the below commands in the host machine because the Docker containers use the entropy provided by
this machine.

If your system has a random number generator, install the rngd daemon. For example, in CentOS:

sudo yum -y dinstall rng-tools

sudo systemctl start rngd
sudo systemctl enable rngd

If your system does not have a random number generator, install the haveged daemon.

sudo yum -y install haveged

sudo systemctl start haveged
sudo systemctl enable haveged

Creating jTinyUAL files to protect settings

For each setting you want to protect, create a separate jTinyUAL file with the following contents.
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decrypted=<VALUE>

Where <VALUE> isthe plaintext value of the setting you want to encrypt. When encrypting the file, jTinyUAL will
change decrypted to encrypted, and replace the plaintext value with an encrypted value. For example:

#Sat Jun 29 16:34:47 EDT 2019

encrypted=VELOWVVBTAFOF/
1mY3XEXgyRLNP3q05cjToYUIWG7NcION+617INxg2XkPtVYE5ZNrIkQxVzqrVFcbrmV10rd4snp/HNU91jnIa/
SthwGlgomakWgE+x0z1IK8+cn5ggSIF6IrnsRqghxCxppEN1SZGarOtUARNXLLA9+okmwTUF+1TWRRWab+06nWj
mRov9ax+CTSTzuFhGjajCuBoJl5qPImIr48hu+5+z5QCGeGScYphcawlreTuWSo34BZLdi3q7qq0ZmcwO5xIdE
alEnSXTARSDYQKY4wYelxAhgzP1hi100TcFYTzk+xDZACpu0j42WZsEh9Y1TItgUYb6n1rBN1XcPQo18CrKFL
RCBcPjieU3IicI+LUfXOK8RSHqz/lv1lc46Vo8v/
wYFjJyZQpO75wyUJvzXte8pKXuMgptoFnpr+tyl3Gf4MOrwW7zkgX5FFUaV/

LAszy2j fux8Az1ldMnJatM+ZJI47N8Ohh3B6a+q8LSt3cYisBUuLgNEPFN2j2YwG67FOEgLgXENrxchnelk509KK
P/0qZI80sZIS9UAieplfCuyzOw5+AmAanUqVgDOsScWLkallo311Ay79MqI4h1gADIMZycYpUSK17mLOhL/
UKHGbTy3egg3418R/
1z70+XAxtfO7ptOZ4E7cSPZFgEUBTPVKNUKOXRGIgXxjdgxg2jVfCpoBUUtHpc876npDPsnPBLBA2QY6YPO

Q Do not share jTinyUAL files between instances of CA Gateway. These files only work for one CA Gateway
instance.

Creating a jTinyUAL properties file

The jTinyUAL properties file maps each CA Gateway setting you want to protect with the jTinyUAL file that contains

the setting value. In this file, add <SETTING>=<FILE> pairswhere:
e <SETTING> isthe CA Gateway setting in Java properties format.
e <FILE> isthe name of the file that contains the setting value.

For example:

cagw.authorities.managed_cas.example_ca_id.properties.admin_epf_password=example_ca_a
dmin_epf_password.tual

After creating the jTinyUAL properties file:

1. Save the file (for example, as tual.properties )inthe same folder containingthe jTinyUAL files.
2. Add the file path to the tual.properties setting.

Obtaining the server certificate

CA Gateway requires a digital certificate for securing communications between the CA Gateway and authorized
clients. See below to generate this certificate for a production environment.

® Generating the server key pair

¢ Obtaining the key pair CSR

¢ Obtaining the server certificate

* Importing the server certificate into the keystore
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* Importing CA certificates into a truststore

The certificate must contain the server's fully qualified domain name (FQDN) as a DNS type Subject
Alternative Name (subjectAltName) extension.

Generating the server key pair

To generate the key pair of the server, run the following command.

keytool -genkeypair -alias <ALIAS> -dname <DN> -keyalg <KEYALG> -keysize <KEYSIZE>
-sigalg sha256WithRSA -ext san=dns:<DNS> -keystore <KEYSTORE> [-keypass <KEYPASS>] [-
storepass <STOREPASS>]

See the following table for a description of each flag.

Flag Value
-alias An alias for the key pair.

-dname  The DN for the key pair (and later, the certificate). Use the DN format expected by the CA that will
issue the certificate.

-keyalg  The algorithm for the key pair (for example, RSA).
-keysize = The Key size. Select a secure key size (for example, 2048).
-ext The DNS-type value of the Subject Alternative Name (subjectAltName) extension.

-keystor  The full path of the keystore file. If the keystore does not exist, the keytool utility will create it.
e

-keypas  The password of the private key. When you omit this option, the tool prompts for a password.
s

-storep  The password for the keystore. When you omit this option, the tool prompts for a password.
ass

Obtaining the key pair CSR
Create a Certificate Signing Request (CSR) by entering the following command:

keytool -certreq -alias <ALIAS> -file <FILE> -storetype pkcsl2 -keystore <KEYSTORE>
[-storepass <STOREPASS>]

CA Gateway 3.7 - Docker Deployment Guide



@ ENTRUST

For example:

> keytool -genkeypair -alias example_alias -dname '"cn=CA Gateway,ou=CA
Entry,o=Example,c=US" -keyalg RSA -keysize 2048 -sigalg sha256WithRSA -ext

san=dns:domain.example.com -keystore /CAGW/config/keystore.ks
> keytool -certreq -alias example_alias -file /tmp/cagw/cagw_csr.txt -keystore /CAGW/
config/keystore.ks

See the following table for a description of each option.

Option Value
-alias The alias previously specified when Generating the server's key pair.
-file The full path of the CSRfile.

-keystore The full path of the keystore file.

-storepass  The password of the keystore. When you omit this option, the tool prompts for a password.

Obtaining the server certificate
Issue the certificate with either:

¢ Your Entrust Certificate Authority.
¢ Atrusted certificate provider such as the Entrust Certificate Services at store.entrust.com.

Importing the server certificate into the keystore

Import the certificate into the keystore:

keytool -importcert -alias <ALIAS> -file <FILE> -keystore <KEYSTORE>

For example:

keytool -importcert -alias example_alias -file /tmp/cagw/cagw_cert.p7b-keystore /

home/myuser/cagw/config/keystore.ks

See the following table for a description of each option.

Option Value
-alias The alias previously specified when Generating the server's key pair.
-file The full path of the PKCS #7 file containing the certificate and the certificate chain.
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Option Value

-keystore The full path of the keystore file.

Importing CA certificates into a truststore

For each managed Certificate Authority, CA Gateway requires the following certificates.

CA type Required certificates
Root The self-signed root CA certificate.

Subordinate  The complete CA certificate chain, from the subordinate CA certificate up to the root CA
certificate.

Import these certificates in either:

® The Truststore used when Importing the server certificate into the keystore.
* Anew Truststore.

To import a CA certificate into a truststore using the Java keytool utility, run the following command.

keytool -importcert -trustcacerts -alias <ALIAS> -file <FILE> -keystore <KEYSTORE> [-
storepass <STOREPASS>]

For example:

keytool -import -trustcacerts -alias managed_cal -file /tmp/cagw/managed_cal.cer

-keystore /home/myuser/cagw/config/keystore.ks

See the following table for a description of each parameter.

Option Value
-alias The alias of the CA certificate.
-file The full path of the CA certificate file.

-keystore The full path of the Java keystore file. If not present, the keystore is created.

-storepass = The password of the Java keystore. When you omit this option, the tool prompts for a password.
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6 Integrating Certificate Authorities

The below sections explain how to integrate CA Gateway with Certificate Authorities of different providers.

* Integrating a DigiCert CA
Integrating a GlobalSign CA
Integrating a Microsoft CA
Integrating an AWS CA
Integrating an EJBCA
Integrating an Entrust CA
Integrating a Sectigo CA

A\ See CAGateway - Configuration Reference for the supported fields and Docker-specific considerations on
referencing files.

Integrating a DigiCert CA
DigiCert CAs do not require preliminary integration steps. See Configuring for instructions on:

* Configuring a DigiCert CA.
* Add a DigiCert CA certificate profile.

See Digicert CA capabilities for a complete description of the operations supported by these CAs.

Integrating a GlobalSign CA

GlobalSign Certificate Center (GCC) authorities do not require preliminary integration steps. See Configuring for
instructions on:

e Configuring a GlobalSign Certificate Center (GCC).
e Add a GlobalSign Certificate Center (GCC) certificate profile.

See GlobalSign capabilities for a complete description of the operations supported by these CAs.

A\ Inthe current CA Gateway release, GlobalSign integration is supported for testing purposes only.

Integrating a Microsoft CA

As illustrated by the following figure , CA Gateway manages each Microsoft CA instance through an Entrust Proxy for
Microsoft CA.

Entrust REST Entrust Proxy
CA Gateway over HTTPS for Microsoft CA

Microsoft CA

Windows Domain
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In this architecture, CA Gateway is a client of Microsoft CA. See in the following sections how to configure the
Entrust Proxy for Microsoft CA and CA Gateway to manage Microsoft CAs.

¢ Adding Microsoft Management Console snap-ins

® Enabling supply in the request

¢ Configuring Request Handling in the Microsoft CA

* Enabling SAN attributes in the enrollment request

¢ Installing the Entrust Proxy for Microsoft CA

* Creating RA agents

* |ssuing the SSL certificates

¢ Generating a client keystore for Entrust Proxy for Microsoft CA
¢ Generating a truststore for CA Gateway

¢ Generating the server keystore of the Entrust Proxy for Microsoft CA
¢ Running the Entrust Proxy for Microsoft CA

See Microsoft CA capabilities for a complete description of the operations supported by these CAs.

o Only Microsoft Enterprise CA is supported; standalone CA is not supported.

Adding Microsoft Management Console snap-ins
Run the Microsoft Management Console and add the following snap-ins.

® Certificate Templates
e Certificates
e Certificate Authorities

See below for how to add a span-in to the Microsoft Management Console.
To add a Microsoft Management Console shap-in

1. Log into the Microsoft CA server machine.

2. Press Win + R to open the Run dialog.

3. Type "mmc” and press Enter to open Microsoft Management Console.
4. Select File > Add Remove Snap-In.

5. Select the snap-in in the Available snap-ins field.

B Consolel - [Console Root
[@ File Action View Favo

= | = E

Add or Remove Snap-ins X

You can select snap-ins for this console from those available on your computer and configure the selected set of snap-ins. For -

~ Console Root extensible snap-ins, you can configure which extensions are enabled.
Available snap-ins: Selected snap-ins:
Snap-n Vendor ~ [ console Root Edit Extensions...

=] ActiveX Control Microsoft Cor...
Authorizan’on Manager Microsoft Cor...
] Microsoft Cor...
Gl Certificates Microsoft Cor... Move Up
iﬂJCerﬁﬁcaﬁon Authority Microsoft Cor...

Remove

. Component Services  Microsoft Cor... BoveDown

Add >
"é' Computer Managem... Microsoft Cor...

& Device Manager Microsoft Cor...

= Disk Management Microsoft and...

3;3 Enterprise PKI Microsoft Cor...

@ Event Viewer Microsoft Cor...
_|Folder Microsoft Cor...

=/ Group Policy Object ... Microsoft Cor... Advanced...
= e . - P

Description:

The Certificate Templates snap-in allows you to create and manage certificate templates.

Cancel

6. Click Add to include the snap-in in the Selected snap-ins field.
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7. Click OK.

Enabling supply in the request

In all the managed Microsoft CA templates for issuing entity certificates, make sure that the Subject Name is
supplied by the certificate request.

To enable supply in the request in a template

1. Log into the Microsoft CA server machine.

2. Press Win + R to open the Run dialog.

3. Type "mmc” and press Enter to open Microsoft Management Console.

4. Go to Certificate Authority.

5. Right-click Certificate Templates and select Manage.

6. Right-click the template and select Properties.

7.In the Subject Name tab, enable the Supply in the request radio button.

Superseded Templates Extensions Security Server
General Compatibility Request Handling Cryptography = Key Attestation
Subject Name Issuance Requirements

(® Supply in the request

mation from existing certificates for autoenroliment

(O Build from this Active Directory information

Select this option to enforce consistency among subject names and to
simplify certificate administration.

None
Include e-mail name in subject name
Include this information in altemate subject name:
E-mail name
DNS name
User principal name (UPN

Service principal name (SPN

* Control is disabled due to compatibility settings

oK Apply Help

Configuring Request Handling in the Microsoft CA

If the Microsoft CA settings configure Request Handling as follows.

Parameter Value
Purpose Signature

Delete revoked or expired certificates
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Parameter Value
Allow private key to be exported

For automatic renewal of smart card certificates, use the existing key if a new key
cannot be created

Do the following when the public subject is enrolled and when the private key Prompt the user
associated with this certificate is used during enrollment

As we see, the Archive subject's encryption private key option is disabled when selecting the
Signature template.

Superseded Templates Extensions Security Server
Subject Name Issuance Requirements
General Compatibilty Request Handling  Cryptography ~ Key Attestation

Pumpose: Signature v
[C] Delete revoked or expired certificates (do not archive)

Include symmetric algorithms allowed by the subject

Archive subject’s encryption private key

Use advanced Symmetric algorithm to send the key

to the CA

] Allow private key to be exported
Renew with the same key ("

0 For automatic renewal of smart card certificates, use the existing key if a
new key cannot be created

Do the following when the subject is enrolled and when the private key
associated with this certificate is used:

(O Enroll subject without requiring any user input

(® Prompt the user during enrollment

'e) Prompt the user during enrollment and require user input when the
private key is used

* Control is disabled due to compatibility settinas

ox oy | [ v

Enabling SAN attributes in the enrollment request

Microsoft CA can be configured to allow Subject Alternative Name (SAN) values in enrollment requests and include
them in the issued certificates.

¢ Security risks of allowing SAN fields in enrollment requests
® Enabling the Config_CA_Accept_Request_Attributes_SAN flag

If you don't enable this feature, you will lose the capability to extend the SAN attributes of the issued
certificates with SAN from the certificate request.
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Security risks of allowing SAN fields in enrollment requests

Allowing Subject Alternative Name (SAN) fields in enrollment requests creates a serious security risk. Once enabled,

any certificate template may accept alternate names regardless of how the template defines the subject. An
attacker could exploit this to obtain a certificate with an alternate name and impersonate another user.

For this reason, the CA must limit enrollment permissions to only trusted accounts. Specifically, the security model

described in Installing the Entrust Proxy for Microsoft CA focuses on allowing only the Proxy Admin to have

enrollment permission.

Enabling the Config_CA_Accept_Request_Attributes_SAN flag

If you want Microsoft CA to accept Subject Alternative Name (SAN) fields in enrollment requests, enable the

following flag.

Config_CA_Accept_Request_Attributes_SAN

To enable Config_CA_Accept_Request_Attributes_SAN flag

1. Log in to the Windows machine hosting the Microsoft CA server.
2.Runthe regedit command to open the Registry Editor.

3. Select the following registry key ( <CA_CN> is the Common Name of the Microsoft CA).

HKLM/SYSTEM/CurrentControlSet/Services/CertSvc/Configuration/<CA_CN>/
PolicyModules/CertificateAuthority_MicrosoftDefault.Policy/EditFlags

4, Calculate an OR of the current key value and 0x000040000 . For example, if the current valueis 11014e,

calculate:

0x00011014e OR Ox000040000

= 0x0015014e

5. Set the OR result as the new key value.
6. Runthe certsrv command to display the CA service settings.

File Action View Help

;;,J certsrv - [Certification Authority (Local)\abccorpsub]

ez Ec=H| > =

L5 Certification Authority (Local)

v @i abccorpsuh
| Rewvt All Tasks

| Issu .

% Pen View

| Faile Refresh

il Cert Export List...
Properties
Help

H Name

> Start Service

Stop Service

Submit new request...

Back up CA...
Restore CA...

Renew CA Certificate...
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7. In the navigation tree, right-click the CA name.
8. Select All Tasks > Stop service to stop the Microsoft CA server.
9. Select All Tasks > Start service to restart the Microsoft CA server.

Installing the Entrust Proxy for Microsoft CA

Install the Entrust Proxy for Microsoft CA, as explained in the following sections.

¢ System requirements for the Entrust Proxy for Microsoft CA

® Creating a Proxy Admin account

¢ Configuring the Windows domain account

* Adding the Windows domain account to the logon as a service policy
* |nstalling Java

¢ Downloading the Entrust Proxy for Microsoft CA installer

¢ Configuring logs

® Running the Entrust Proxy for Microsoft CA installer

¢ Uninstalling the Entrust Proxy for Microsoft CA

System requirements for the Entrust Proxy for Microsoft CA

To install the Entrust Proxy for Microsoft CA, you need a machine with Windows Server 2016 (x64) or above.

Creating a Proxy Admin account
Create a Proxy Admin user belonging to the Cert Publishers and Domain User groups.
To create a proxy admin user

1. Press Win + R to open the Run dialog.
2.Type dsa.msc and press Enter.
3. Select Users under the Windows domain
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4. In the right pane, double-click on mscaproxyadm.

A

File Action View Help

| 2E 8 XE Q| HE

2R

] Active Directory Users and Computers [dcab;
| Saved Queries

v 3 abccorp.dev.entrust.local

| Builtin

Computers

3| Domain Controllers

ForeignSecurityPrincipals

| Keys

LostAndFound

Managed Service Accounts

3. PKI

Program Data

System

Users

NTDS Quotas

TPM Devices

< >

Name

%Domain Computers
ﬁgDomain Controllers
%Domain Guests
%Domain Users

E) domainadm

5 ebraheem

E) enrolimentAgent1
ﬁgEnterprise Admins
h@, Enterprise Key Admil
ﬁgEnterprise Read-only]
5 eve

%Group Policy Creatol
8.;Guest

%Key Admins

S keyrecoveryagent1
E‘; krbtgt

& mscaproxyadm

S MscaSSLIntegrationT
&EProtected Users

8) proxyadm

% RAS and IAS Servers
%Read-only Domain (
&ESchema Admins

mscaproxyadm Properties ? X
Security Environment Sessions Remote control
Remote Desktop Services Profile COM+ Attribute Editor

General Address  Account  Profile Telephones ~ Organization
Published Certficates Member Of  Password Replication  Dialin ~ Object
Member of:
Name Active Directory Domain Services Folder
Cert Publishers abccomp dev entrust local/Users

Domain Users abccorp dev entrust local/Users

Add... Remove

Primary group: Domain Users

There is no need to change Primary group unless
you have Macintosh clients or POSIX-compliant
applications.

Set Primary Group

Cancel Apply Help

S secureproxyadm

5. Create a Proxy Admin user

6. Add the users only to the Cert Publishers and Domain User groups.

Configuring the Windows domain account

Configure the Windows login account of the Entrust Proxy for Microsoft CA. See below for the supported

combinations when the Entrust Proxy for Microsoft CA and the Domain Controller share the same server or run on

different servers.

User

A local service account

A domain user

In either case, enable only the following user permissions.

¢ Issue and Manage Certificates
® Request Certificates
* Read

Service startup type

Automatic or Automatic (Delayed Start)

Automatic (Delayed Start)

Same server
(V] o
(V] (x)

Adding the Windows domain account to the logon as a service policy

Add the new Windows account to the Logon as a service policy.

To add the Windows domain account to the logon as a service policy
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1. Press Windows + R to open the Run window.

2. Type secpol.msc and press Enter.

3. In the Local Security Policy window, navigate to Local Policies > User Rights Assignment.
4. In the right pane, double-click on Log on as a service.

5. Click Add User or Group,

6. Select the account created in the previous section, Creating a Proxy Admin account

T..

8. Click OK,

9. Click Apply.

Installing Java
Install Java on the machine that will host the Entrust Proxy for Microsoft.
Toinstall Java

1. Login using the account created in the previous section, Creating a Proxy Admin account.
2. Install one of the following LTS (Long Term Support) Java distributions.

® QOracle Java x86_64 version 17

* OpenJDK 17

¢ AdoptOpenJDK 17

3.Setthe JAVA_HOME environment to the Java installation path.

4, Extend the value of the PATH environment variable to:

%JAVA_HOME%\b1in

5. Run the following command to check the Java version and architecture details.

java -XshowSettings:properties -version

Downloading the Entrust Proxy for Microsoft CA installer
Download and extract the Entrust Proxy for Microsoft CA installer files.
To download the Entrust Proxy for Microsoft CA installer

1. Login trustedcare.entrust.com

2. Go to PRODUCTS > Cryptographic Security Platform

3. Select the latest version.

4, Click the download link of the Entrust Proxy for Microsoft CA.

5. Unzip the compressed file contents to your selected installation directory on the Windows machine - for

example,in c:\mscaproxy

Installinginto c:\Program Files may not be functional due to Windows privilege enforcement.

Configuring logs
Optionally, edit the configuration files to modify the default log recording settings.
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Configuration file Parameter Value
MSCAProxy.xml logpath The folder where to save logs.

config\application.yml com.entrust.msc  The supported log levels. Supported values in increasing severity
aproxy are TRACE , DEBUG, INFO, WARN, ERROR, FATAL and OFF.

0 If you edit these pages after starting Entrust Proxy for Microsoft, run the MSCAProxy.exe

restart command to restart it.

For example, adding the following code to the config\application.yml file setsthe loglevelto INFO.

logging:
level:
root: INFO
com.entrust.mscaproxy: INFO

Running the Entrust Proxy for Microsoft CA installer

See below for running the Entrust Proxy for Microsoft CA installer and registering the Entrust Proxy for Microsoft CA
as a Windows service.

To run the Entrust Proxy for Microsoft CA installer

1. Login to a Windows machine as the Proxy Admin user (created in section Creating a Proxy Admin account).
2. Run the following command.

MSCAProxy.exe install /p

3. When prompted, type the <domainName> domain name and the <proxyAdminUserName> Proxy
Admin username. Supported formats are:
¢ User Principal Name (UPN) - for example: <domainName>@<proxyAdminUserName>

® The Down-Level Logon Name - for example: <domainName>\<proxyAdminUserName>

4. Type the password of the Proxy Admin user.

5. Type "y" to allow the log-on as a service.

0 The installer does not wait for you to press the Enter key.

Uninstalling the Entrust Proxy for Microsoft CA

Run the following command as an administrator in case you want to uninstall the Entrust Proxy for Microsoft CA.

MSCAProxy.exe uninstall
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Creating RA agents
Create RA recovery and enrollment agents as explained below.

® Creating the CA enrollment agents
* Creating RArecovery agents
® Creating RA enrollment agents

Creating the CA enrollment agents
You must create a CA Enrollment Agent (EA) before creating the RA recovery agents and the RA enrollment agents.

® Publishing the enrollment template
¢ Creating an enrollment certificate for the CA Administrator

o A CA enrollment agent is self-enrolled and internal to the CA, while a RA enrollment agent is co-located
with CA Gateway.

Publishing the enrollment template
If not already published, publish the enrollment agent template as explained in this section.
To publish the enrollment agent template

1. Log into the Microsoft CA server machine.

2. Press Win + R to open the Run dialog.

3. Type "mmc” and press Enter to open Microsoft Management Console.
4. Under the certificate authority name, right-click Certificate Templates.
5. Select New > Certificate Template to issue.

6. Select Enrollment Agent.

Creating an enrollment certificate for the CA Administrator

Create an enrollment certificate for the CA administrator user of the Microsoft CA server.

0 Do not export the CA administrator's enrollment key.

To create an enrollment certificate for the administrator

1. In the Microsoft CA server machine, run MMC.
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2. Under the Personal node, right-click Certificates and select All Tasks >Request New Certificate.

[a Consolel - [Console Root\Certificates - Current User\Personal]

E File Action View Favorites Window Help
L e Ao (N ERRERER 7 Mia:

| Console Root Object Type
v I Certification Authority (Local) “| Certificates

@ abccorpsub
v _ﬂjJ Certificates - Current User

"~ Personal
| Trusted Root Certification Authorities
| Enterprise Trust

3. Follow the wizard instructions. When prompted, select the Enrollment Agent template.

Creating RA recovery agents

If you want to store and recover keys generated by the Microsoft CA, create one or more recovery agents as
explained below.

To create a recovery agent

1. Log in to the Microsoft CA server machine.
. Press Win + R to open the Run dialog.
Type "mmc” and press Enter to open Microsoft Management Console.
. Under the Certificate Authority node, right-click Certificate Template, and select Manage.
. Right-click Key Recovery Agent and select Duplicate Template.
. Configure the following settings in each tab of the Properties of the New Template dialog.
® General
® Request Handling
® |ssuance Requirements
® Security
7. Under the Certificate Authority node, right-click Certificate Template and select New > Certificate
Template to issue.
8. Select the newly created template.
9. Create a user in Active Directory.
10. Under the Personal node, right-click Certificates and select All Tasks > Advanced Operations > Enroll On
Behalf Of
11. Follow the wizard instructions. When prompted, select the newly created user.
12. Right-click the issued certificate and select Export.
13. Follow the wizard instructions. In the Export Private Key dialog, select Yes, export the private key.

General

Click this tab and write a name for the new template in the Template display name field.

Request Handling
Click this tab and check the Allow private key to be exported box.

Issuance Requirements

Click this tab and set the following values.
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Parameter Value

CA certificate manager approval Disable this option

This number of authorized signatures 1

Policy type required in signature Application policy

Application Policy Certificate Request Agent
Security

Click this tab and assign the following permissions to users and user groups.

Permission Authenticated user Proxy Admin
Full Control

Read V] (V]

Write

Enroll o

Autoenroll

Creating RA enrollment agents

To publish the issued certificates in Active Directory, you need one or more RA (Registration Authority) enrollment
agents. See below for the supported credential generation modes.

¢ Creating RA enrollment agent credentials in a keystore file
¢ Creating RA enrollment agent credentials in a PKCS#11 HSM
Creating RA enrollment agent credentials in a keystore file
You can create the RA enrollment agent credentials in the following file formats.

® PKCS#12 (Personal Information Exchange Syntax Standard).
¢ JKS (Java KeyStore).

e JCEKS (Java Cryptography Extension KeyStore).

® PFX (Personal Information Exchange).

See the example below for how to create them in PKCS#12.
To create RA enrollment agent credentials in a keystone file

1. Log into the Microsoft CA server machine.
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. Press Win + R to open the Run dialog.
. Type "mmc” and press Enter to open Microsoft Management Console.
. Under the Certificate Authority node, right-click Certificate Template, and select Manage.
. Right-click Enrollment Agent and select Duplicate Template.
. Configure the following settings in each tab of the Properties of the New Template dialog.
® General
® Request Handling
® |ssuance Requirements
® Security
7. Under the Certificate Authority node, right-click Certificate Template and select New >Certificate
Template to issue.
8. Select the newly created template.
9. Create a user in Active Directory.
10. Under the Personal node, right-click Certificates and select Tasks > Advanced Operations > Enroll On
Behalf Of.
11. Follow the wizard instructions. When prompted, select the newly created user.
12. Right-click the issued certificate and select Export.
13. Follow the wizard instructions. In the Export Private Key dialog, select Yes, export the private key.

o Ul WwWN

General

Click this tab and write a name for the new template in the Template display name field.

Request Handling
Click this tab and check the Allow private key to be exported box.

Issuance Requirements

Click this tab and set the following values.

Parameter Value

This number of authorized signatures 1

Policy type required in signature Application policy

Application Policy Certificate Request Agent
Security

Click this tab and assign the following permissions to users and user groups.

Permission Authenticated user Proxy Admin
Full Control
Read o (V]
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Permission Authenticated user Proxy Admin
Write

Enroll o

Autoenroll

Creating RA enrollment agent credentials in a PKCS#11 HSM

When creating enrollment agents for the Microsoft CA, you can generate keys in a PKCS#11 HSM along with a CSR.
When processing this CSR, the Microsoft CA issues a certificate chain for the RA Enrollment Agent that you can
import into the HSM to pair with the private key.

o See the integration guides of the supported HSM for the required operations.

Issuing the SSL certificates

CA Gateway and the Entrust Proxy for Microsoft CA communicate with HTTP over SSL using mutual authentication.
Thus, two SSL certificates are required:

* Aserver SSL certificate for the Entrust Proxy for Microsoft CA.
¢ Aclient authentication certificate for CA Gateway.

You can obtain both SSL certificates from any CA. Those steps are outside the scope of this document.

Generating a client keystore for Entrust Proxy for Microsoft CA

Generate a keystore containing:

® The private key of Entrust Proxy for Microsoft CA for client authentication.
® The key’s certificate.
¢ The certificate’s chain.

See below the required steps.

¢ Creating a client authentication template for Microsoft CA

¢ Certifying a client key pair for Entrust Proxy for Microsoft CA

¢ Importing a key pair and a certificate in the client keystore for Entrust Proxy for Microsoft CA
¢ Deleting temporary files of the client keystore Entrust Proxy for Microsoft CA

O when configuring CA Gateway, you will later assign the path of this file to the client-cert-key-
store parameter described in Microsoft CA properties.

Creating a client authentication template for Microsoft CA

Create an authentication template for generating the client keystore. For example, you can copy an existing
template and configure it as explained below.

To create a client authentication template for Microsoft CA
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1. Login to the Microsoft CA server machine.

2. Press Win + R to open the Run dialog.

3. Type "mmc” and press Enter to open the Microsoft Management Console.
4. Go to Certificate Authority.

5. Right-click Certificate Templates and select Manage.

ﬁ Consolel - [Console Root\Certification Authority (Local)\abccorpsub\Certificate T

i File Action View Favorites Window Help
o= 25 6= HE

] Console Root Name
2 Certificate Templates (dcabccorp.a
> [V Certificates - Current User
v L) Certification Authority (Local)
v @i abccorpsub
| Revoked Certificates

| Issued Certificates
] Pending Requests 3 Enroliment Agent

| Failed Requests 3 Authenticated Session
| Certificate Templat~- 3 PIV-PIVAuthentication
Manage

) Key Recovery Agent New

# Enroliment Agent (Computer)
& Client Authentication New
) CAGWRecoveryAgent

3] CAGWENrolimentAgent

New >

View >
New Window from Here ication

New Taskpad View...

Refresh
Export List...

Help
|| & User
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6. Right-click the User template and select Duplicate Template.
& Certificate Templates Console

File Action View Help
Lo Aol RENERN 7 Min:
] Certificate Templates (dcabccor) Template Display Name Schema Version )

13 Cross Certification Authority

& Directory Email Replication

1# Domain Controller

1# Domain Controller Authentication
i EFS Recovery Agent

& EncryptionWithBackup

13| EncryptionWithPublishinAD

1 Enrollment Agent

JE Enrollment Agent (Computer)

& Exchange Enroliment Agent (Offline requ...
& Exchange Signature Only

& Exchange User

(& IPSec

3@ IPSec (Offline request)

1@ Kerberos Authentication

& Key Recovery Agent

& ocsp Response Signing

(& PIV-PIVAuthentication

(&l RAS and IAS Server

1 Root Certification Authority

JE Router (Offline request)

1# Smartcard Logon

13 Smartcard User

1@ Subordinate Certification Authority

I R S T VS TN (N TR N SO OO T e R T 0]

4] Trust List Signing
1#] User Signature Only Duplicate Template
1 Web Server All Tasks >
13| Workstation Authentication
Properties
Help

7.In the template properties dialog, configure the settings described below.
¢ General
® Security
¢ Subject Name
® Extensions
8. Click OK to close the dialog.
9. Go to Certificate Authority.
10. Right-click Certificate Templates and select New >Certificate Template to Issue.
11. Select Client Authentication from the list.

CA Gateway 3.7 - Docker Deployment Guide



@ ENTRUST

General

In this tab, set Template display name to Client Authentication.

Properties of New Template X
Subject Name Server Issuance Requirements
Superseded Templates Extensions Securty

Compatbity Generdl  Request Handing Cryptography  Key Attestation
Template display name
{Cient Authentication]
Template name
Chent Authentication
Vakditty penod Renewal penod
yeas ~ [ 6| weeks ~
4] Publsh certficate n Active Directory

[[] Do not automatically reenvoll f a duplicate certficate exists in Active
Drectory

o [ ] e [ e

Security
In this tab:

® Grant necessary permissions to a user group - for example, click Read, Write, Enroll for the Domain Admins
group.

¢ Deselect the Write and Enroll permissions from the Authenticated Users group.

® Remove unnecessary groups.
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Subject Name

In this tab, enable the Supply in request radio button.
X

Properties of New Template

Supersaded Templates Extensions Secunty
Compatbity General Request Handing Cnptography Key Attestation
Subject Name Server lssuance Requrements

@ Supply in the request

() Buid from this Active Directory information

Select this option 1o enforce consistency among subject names and to
smpify cetficate admnistration

Include this information in akemate subject name

ox e
Click OK to close the warning pop-up message.

Extensions

In this tab, edit Application Policies and remove:

® Encrypting File System
® Secure Email

Certifying a client key pair for Entrust Proxy for Microsoft CA

In a temporary directory under the Microsoft Proxy Server, run the following commands to generate and certify a

key pair.
Generate a key pair and keystore

keytool -genkey -noprompt -alias <alias> -dname <dname> -keyalg <keyalg> -keysize
<keysize> -keystore <keystore> -storepass <storepass> -keypass <keypass>

Generate a Certificate Signing Request (CSR)

keytool -certreq -alias <alias> -file <file> -keystore <keystore> -storepass

<storepass>

CA Gateway 3.7 - Docker Deployment Guide

53



@ ENTRUST

Submit CSR to Microsoft CA and get certificate chain

certreq.exe -f -attrib "<atrib>" -config "<host>\<CA>" <file> CertChainFileOut
<CertChainFileOut>

o Depending on the Microsoft CA setup, you may need to manually approve the request and retrieve the
certificate.

See the following table for a description of the main parameters.

Option

<alias>

<attrib>

<Ca>

<dname>

<file>

<host>

<keyalg>

<keypass>

<keysize>

<keystore>

<storepass
>

For example:

Value

A label for the new keystore

The name of the template described in Creating a client authentication template for Microsoft CA.

The CA name assigned to the Microsoft CA in CA Gateway.

The distinguished name of the key pair holder

The path of the generated certificate request

The Microsoft CA’s hostname

The algorithm for generating the key pair

The password for protecting the key pair withing the keystore

The size of the generating keys

The path of the generated keystore

The password for protecting the keystore

Generate a key pair and keystore

keytool -genkey -noprompt -alias mscaproxyclient -dname '"cn=mscaproxy client" -keyalg
RSA -keysize 2048 -keystore mscaproxyclient.jks -storepass *xx*xx —keypass xx*xx

CA Gateway 3.7 - Docker Deployment Guide

54



@ ENTRUST

Generate a Certificate Signing Request (CSR)

keytool -certreq -alias mscaproxyclient -file mscaproxyclient.csr -keystore
mscaproxyclient.jks -storepass **xxxx*

Submit CSR to Microsoft CA and get certificate chain

certreq.exe —-f -attrib "CertificateTemplate:ClientAuthentication" -config
"<HOST>\<CA>" mscaproxyclient.csr CertChainFileOut mscaproxyclient.p7b

Importing a key pair and a certificate in the client keystore for Entrust Proxy for Microsoft CA

Import into a keystore the certificate and the keys generated when Certifying a client key pair for Entrust Proxy for

Microsoft CA.

keytool -import -noprompt -alias <alias> -file <file> -keystore <keystore> -storepass
<storepass>

Import the keys and the certificate into the keystore.

Option

<alias>

<file>

<keystor
e>

<storep
ass>

Value

The keystore <alias> selected when Certifying a client key pair for Entrust Proxy for Microsoft CA

The <CertChainFileOut> file path of the certificate chain obtained when Certifying a client key
pair for Entrust Proxy for Microsoft CA

The <keystore> file path of the keystore generated when Certifying a client key pair for Entrust
Proxy for Microsoft CA

The <storepass> keystore password selected when Certifying a client key pair for Entrust Proxy for
Microsoft CA

keytool -import -noprompt -alias mscaproxyclient -file mscaproxyclient.p7b -keystore
mscaproxyclient.jks -storepass **xxxx*

Deleting temporary files of the client keystore Entrust Proxy for Microsoft CA

Delete the temporary files created in the previous sections. For example:
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del mscaproxyclient.csr
del mscaproxyclient.p7b

Generating a truststore for CA Gateway

¢ Creating the SSL directory
* Importing the CA certificates

You need a truststore containing the CA chain for validating the Entrust Proxy for Microsoft CA's connection during
tls handshake. This is a chain of CA certs which has issued the server certificate of Entrust Proxy for Microsoft CA.

The following instructions create a Java KeyStore (JKS) with the Java keytool command line utility.
Consider using a more secure PKCS#12 type instead.

Creating the SSL directory

Create an SSL directory under the Entrust Proxy for Microsoft CA installation. For example:

c:\mscaproxy\ssl

Importing the CA certificates

In the SSL directory, run the following command to include the certificate of the root CA and all the intermediate
CAs. See below for a description of each parameter.

keytool -import -noprompt -alias <alias> -file <file> -keystore <keystore> -storepass
<storepass>

See below for a description of each parameter.

Option Value

<alias> The alias of the CA in CA Gateway

<file> The path of the CA certificate file

<keystore> The path of the truststore file

<storepass> The password of the trustore
For example:
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keytool -import -noprompt -alias myca -file myca.crt -keystore truststore.jks
-storepass *xxx

Generating the server keystore of the Entrust Proxy for Microsoft CA

You need a keystore containing:

e The SSL authentication certificate of the Entrust Proxy for Microsoft CA.
¢ The private key of the certificate.
e The validation chain of the certificate.

See below the required steps.

® Generating the keystore

¢ Setting the Subject Name

Adding the keystore password to the configuration
Adding the truststore password to the configuration
¢ Restarting Entrust Proxy for Microsoft CA

The following instructions create a Java KeyStore (JKS) with the Java keytool command line utility.
Consider using a more secure PKCS#12 type instead.

Generating the keystore

Go to the SSL directory containing the truststore.jks file previously generated. For example:

c:\mscaproxy\ssl

Run the following commands to generate the key.
The below commands use the default Web Server certificate template. If you need to customize any

settings of the Web Server certificate template, use a copy of it.

keytool -genkey -noprompt -alias mscaproxy -dname '"cn=MS CA proxy server FQDN"
-keyalg RSA -keysize 2048 -keystore mscaproxy.jks -storepass <STOREPASS> -keypass
<KEYPASS>

keytool -certreq -alias mscaproxy -ext SAN=dns:MS CA proxy server FQDN -file
mscaproxy.csr —-keystore mscaproxy.jks -storepass <STOREPASS>

certreq.exe -f -attrib "CertificateTemplate:WebServer" -config "MS CA host name\CA
name" mscaproxy.csr CertChainFileOut mscaproxy.p7b
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keytool -import -noprompt -alias mscaproxy -file mscaproxy.p7b -keystore
mscaproxy.jks -storepass <STOREPASS>

del CertChainFileOut
del CertChainFileOut.rsp
del mscaproxy.csr

del mscaproxy.p7b

Where:

e "MS CA proxy server FQDN" isthe fully qualified domain name of your Entrust Proxy for Microsoft CA’s
server.
e <STOREPASS> isthe password of the keystore.

e <KEYPASS> isthe password of the private key.

Setting the Subject Name

Editthe application.yml file of the Entrust Proxy for Microsoft CA installation folder.

config\application.yml

Uncomment all lines (by removing #) and assign to subject-dn the distinguished name set with -dname when
generating the client keystore. For example:

subject-dn: “cn=mscaproxy client”

Adding the keystore password to the configuration
Edit the following file.

MS CA Proxy Installation\config\key-store-password.scrt

Set the following parameter:

decrypted=<STOREPASS>

Where <STOREPASS> isthe password of the keystore described in Generating the keystore.

Adding the truststore password to the configuration
Edit the following file:

MS CA Proxy Installation\config\trust-store-password.scrt
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Set the following parameter.

decrypted=<STOREPASS>

Where <STOREPASS> isthe password of the keystore described in Generating the keystore.

Restarting Entrust Proxy for Microsoft CA

If the Entrust Proxy for Microsoft CA is running, execute the following command as an administrator to restart it.

MSCAProxy.exe restart

Running the Entrust Proxy for Microsoft CA
Administrators can start, stop, and restart the Entrust Proxy for Microsoft CA with the following commands.

® MSCAProxy.exe start
® MSCAProxy.exe stop

® MSCAProxy.exe restart

Once started, you can check the correct execution of the Entrust Proxy for Microsoft CA using a Chrome browser.

To check the execution of the Entrust Proxy for Microsoft CA

1. Run the following command to generate a PKCS#12 from the mscaproxyclient.jks keystore.

keytool -importkeystore -srckeystore mscaproxyclient.jks -destkeystore
mscaproxyclient.pl2 -srcstoretype JKS -srcstorepass <SRCSTOREPASS>
-deststoretype PKCS12 -deststorepass <DESTSTOREPASS>

2. Import the generated mscaproxyclient.pl12 fileinto Chrome.
3. Go to:
https://<proxyserver>:8443/MSCAProxy/rest/status/ping

4. Check the server response. The "MS CA proxy is running" message indicates a correct operation.

Integrating an AWS CA

This section explains how to configure CA Gateway for integrating CAs of the Amazon Web Services (AWS).

¢ Installing and configuring the AWS CA plugin
¢ Handling certificate events with DynamoDb

Installing and configuring the AWS CA plugin

Entrust distributes each <VERSION> version of AWS CA plugin in a file with the following name.
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cagw-plugin-awsca-<VERSION>.zip

This ZIP file contains the following folders:

e lib
¢ config/ledm/mc

See below for how to install and configure the AWS CA plugin.
To install the AWS CAs plugin

1. Extract the contents of the ZIP distribution file.

2.Createa <HOST_CONFIG>/plugins folderinthe CA Gateway machine. Where <HOST_CONFIG> isthe
folder described in Creating the configuration and credentials folders.

3. In this folder, copy the the JAR files of the 1ib folder.

4, Make the plugins directory accessible to the cagw userinside the CA Gateway container.

sudo chown -R :1339 <HOST_CONFIG>/plugins sudo chmod -R g+rx <HOST_CONFIG>/
plugins

5. When starting the CA Gateway instance, set the LOADER_PATH environment variable to the location of the
plugins directory within the container.

docker run -p 8444:8080 -e LOADER_PATH=/etc/cagw/config/plugins -v
<HOST_CONFIG>: /etc/cagw/config cagw/api:latest

Handling certificate events with DynamoDb

You can handle certificate events with the DynamoDb table hosted in your AWS environment. This method has
additional costs but also improved performance: AWS will charge for the DynamoDb service and all of the traffic to
and from CA Gateway. With this cost, however, comes increased speed and scalability.

Our testing found that, in the worst case, DynamoDb performs evenly with the AWS Audit Report method. Still, as
the number of events in the CA grows, DynamoDb performs significantly faster than the AWS Audit Report method.
The improvement is particularly evident when the number of requested events is small compared to the total
number of events in the CA. DynamoDb also uses no additional memory in CA Gateway.

When a certificate is issued or revoked by an ACM Private CA:

1. Amazon CloudTrail logs an IssueCertificate or RevokeCertificate event.

2. An Amazon EventBridge rule triggers an AWS Lambda function.
3. The lambda function receives the event data and extracts the relevant details to create a record.
4, The lambda function saves the record in the DynamoDb table where CA Gateway queries certificate events.

See the following sections for how to configure this method in AWS and CA Gateway.

® Creating the AWS DynamoDb table

¢ Creating the AWS Lambda function

¢ Configuring the AWS Lambda function

¢ Limiting AWS DynamoDB permissions (optional)

Limiting AWS Private Certificate Manager permissions (optional)
Creating the AWS EventBridge rule
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¢ Configuring the AWS DynamoDB table in CA Gateway

Creating the AWS DynamoDb table
Create an AWS DynamoDb table for storing the certificate events.

To create an AWS DynamoDb table

1. Search for DynamoDB in the search box at the top of the AWS Management Console.
2. Navigate to the main page of the DynamoDB service.

@

3. Select Create table.

4. Provide a table name. You will later add the selected name in Creating the AWS Lambda function and
Configuring the AWS DynamoDB table in CA Gateway. The Lambda script provided by Entrust uses the
certificate-events default table name.

5. Under Partition key, enter certificate_authority_arn forthe primary key and select String for the

type (default value).
6. Check Add sort key.

7. In the resulting text box, enter time and select String for the type (default value).

8. In the Table settings section, do not uncheck Use default settings (checked by default) unless you know
what you’re doing and would like to change these settings for your own needs.
9. Review the configured settings:

® The partition key must be certificate_authority_arn.

® The sort key must be time

¢ The table name s up to you.
10. Click Create to create the table.

Creating the AWS Lambda function

Create a Lambda function for storing certificate event records in the AWS DynamoDb table.

To create the Lambda function

1. Search for Lambda in the search box at the top of the AWS Management Console.

2. Navigate to the main page of the Lambda service.
3. Select Create function.
4, Select Use a blueprint.

5. Search for microservice-http-endpoint-python Inthe Blueprints search box.

6. Selectthe microservice-http-endpoint-python blueprint.
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. Click Configure.
. In the resulting page, provide a function name.
9. In Execution role, select Create a new role from AWS policy templates.
10. Provide a name for the role.
11. Under Policy templates, select Simple microservice permissions: DynamoDB.
12. In the API Gateway trigger section under API, select Create an API.
13. For APl type, select REST API.
14. For security, select IAM.
15. Click Create function.

16. Review the performed steps. For example, after selecting the save-certificate-event-record-in-

0 ~

dynamodb name for the Lambda function, you should go to a page like the following.

sve-certificate-event-record-in-dyramodd

Configuring the AWS Lambda function
Configure the Lambda function previously created in Creating the AWS Lambda function .

To configure the Lambda function

1. Copy the contents of the dynamo-db-lambda.py file provided with the AWS CA Gateway plugin artifact.
2. Paste the contents under the Code source tab to replace the dynamo-db-lambda.py contents.
3.Assign to the TABLE_NAME variable the name of the DynamoDB table created earlier. For example:

TABLE_NAME = "certificate-events”

0 Be careful if you choose to edit the Lambda code in any other way. The Lambda code is directly
responsible for storing certificate event records in the DynamoDB table, so the correctness of CA
Gateway certificate events APl depends on the correctness of this Lambda code.

. Click Deploy above the code file.

. Click the Configuration tab.

. On the left pane, select Permissions.

. In the Execution role section, click the role associated with this Lambda function. You should see a
summary of the Lambda function role in a new tab.

. Inthe new tab, click Attach policies under Permissions.

9. On the resulting page, search for AWSCertificateManagerPrivateCAReadOnly .

~N o 0 bh

oo}

10. Select the AwWSCertificateManagerPrivateCAReadOnly policy.
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11. Click Attach policy. Attaching this policy to the role allows the Lambda function to retrieve certificate
content from an AWS private CA.
12. Verify that your role has all of the necessary permissions. The following permissions will suffice.
* Certificate Manager Private Certificate Authority: List, Read
* DynamoDB: Read, Write
* CloudWatch Logs: Write

Limiting AWS DynamoDB permissions (optional)
You may wish to limit the DynamoDB permissions to saving certificate events in the AWS DynamoDb table.
To limit the DynamoDB permissions

1. In the AWSLambdaMicroserviceExecutionRole section containing the DynamoDB permissions, click Edit
policy.

2.In the JSON tab, replace the value in the Resource field with the ARN of the DynamoDb table previously
created in Creating the AWS DynamoDb table. To get this ARN in the DynamoDB service console, go to the
Table details section and click the Overview tab.

Limiting AWS Private Certificate Manager permissions (optional)

You may wish to limit Certificate Manager Private CA permissions to the CA(s) the Lambda code will access. As the
policy already attached to the Lambda role is a pre-packaged AWS-managed policy, you won’t be able to edit it.
Instead, you’ll have to create a policy.

To limit the Private Certificate Manager permissions

1. Remove the AWSCertificateManagerPrivateCAReadOnly policy by clicking the X to the right of it. Confirm
this action when prompted.

2. Click Attach policies.

3. Click Create policy.

4, Create the policy either via the Visual editor or the JSON editor.

Creating the AWS EventBridge rule
Create an AWS EventBridge rule for invoking the Lambda function.

To create an EventBridge rule

.Search for Amazon EventBridge inthe search box at the top of the AWS Management Console.

. Navigate to the main page of the Amazon EventBridge service.

. Select Create rule.

. Provide a name and description for the rule.

. In the Define pattern section, select Event pattern.

.in Event matching pattern, select Pre-defined pattern by service.
. In Service provider select AWS.

. In Service name, select Certificate Manager Private CA.

. In Event type select AWS API Call via CloudTrail.

. Select Specific operation(s) instead of the default Any operation.
. Add the IssueCertificate and RevokeCertificate operations.

. Review the configuration. The Event pattern should look like this.

O oo ~NOoO U WN =

[
N = O

{

"source": ["aws.acm-pca"],
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"detail-type": ["AWS API Call via CloudTrail"],
"detail": {

"eventSource": ["acm-pca.amazonaws.com"],

"eventName": ["IssueCertificate", "RevokeCertificate"]

}

13. In the Select event bus section, select AWS default event bus (selected by default).
14. In the Select targets section under the first Target, select Lambda function (selected by default).

15. Under Function select the Lambda function previously created in Creating the AWS Lambda function.

16. Click Create.

Configuring the AWS DynamoDB table in CA Gateway

Edit the CA Gateway application.yml file and configure the following AWS CA properties.

Setting Value
certificate-events-storage-method “DynamoDb”
dynamodb-table-name The table name selected in Creating the AWS DynamoDb table .
For example:
AWSWITHDYNAMODB:

name: "AWS Private Root CA"

issuer-dn: "L=Dallas, CN=WY Root CA 1, ST=Texas, OU=Terraforming, O=Weylan-

Yutani Corporation, C=US"
connector—-name: com.entrust.awsca
properties:
aws-region: "us-east-1"

aws-ca-arn: "arn:aws:acm-pca:us-east-1:422825380052:certificate-authority/

2b33862c-e9f0-490d-9a3a-ad74476f7bca"
aws-ca-s3-crl-arn: ""
aws-ca-audit-report-s3-bucket-name: "cagw-audit-report"
aws—-api-url: "https://acm-pca.us-east-1.amazonaws.com:443/"

aws-user-login-url: "https://edc-admin-services-dev.signin.aws.amazon.com/

console"
aws-user-arn: "arn:aws:iam::422825380052:user/cagw-ca-user"
aws-user-access—key-id: "ABCDEFG1234567890123"
aws-user-secret-access—key: "ABCDEFG123456789012345678901234567890123"
certificate-events-storage-method: "DynamoDb"
dynamodb-table-name: "certificate-events"

Integrating an EJBCA

This section explains how to configure CA Gateway for integrating Enterprise Java Beans Certificate Authorities

(EJBCAS).
¢ Configuring and issuing the EJBCA client certificate
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Configuring client EJBCA authorization
Enabling EJBCA API protocols

Configuring SANs in EJBCA certificates
Verifying the EJBCA server SSL certificate

¢ Enabling EJBCA dynamic profile generation

See EJBCA capabilities for a complete description of the operations supported by these CAs.

Configuring and issuing the EJBCA client certificate
CA Gateway requires a client authentication certificate to authenticate in the EJBCA's APlIs.

¢ Creating an EJBCA certificate profile

¢ Creating an EJBCA entity profile

e [ssuing the EJBCA client certificate

¢ Downloading the EJBCA certificate chain

o See https://docs.keyfactor.com/how-to/latest/quick-start-issue-client-authentication-certificat for a more
detailed description of the operations below.

Creating an EJBCA certificate profile
If no certificate profile exists for the client certificate, create one as explained below.
To create a certificate profile for the client certificate

1. Login to the EJBCA administration GUI.
2. Navigate to CA Functions > Certificate Profiles.
3. Create a new profile or clone an existing one.
4. Assign the following settings to the profile.
¢ Validity or end date of the certificate
e Type
¢ Available Key Algorithms
* Key Usage
* Extended Key Usage
5. Click Save.

Validity or end date of the certificate

Select an appropriate period, for example: 1y.

Type
Select End Entity.

Available Key Algorithms
Select RSA algorithms with 2048 bits or higher.

Key Usage
Select Digital Signature.

Extended Key Usage
Select Client Authentication (TLS Web Client Authentication)
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Creating an EJBCA entity profile
If no end-entity profile exists for the client certificate, create one as explained below.
To create an end entity profile for the client certificate

1. Login to the EJBCA administration GUI.
2. Navigate to RA Functions > End Entity Profiles.
3. Create a new profile or clone an existing one.
4. Assign the following settings to the profile.
* Available CAs
* Available Certificate Profiles
® Subject DN Attributes
* Default Certificate Profile
5. Click Save.

Available CAs

Select ManagementCA.

Available Certificate Profiles

Select the certificate profile described in Creating an EJBCA certificate profile.

Subject DN Attributes

Select the required Distinguished Name (DN) attributes.

You must select at least the CN attribute.

Default Certificate Profile

Select the certificate profile described in Creating an EJBCA certificate profile.

Issuing the EJBCA client certificate
Issue the client authentication certificate for CA Gateway to authenticate in the EJBCA's APIs.
To issue the client authentication certificate

1. Login to the EJBCARA GUI.
2. Navigate to Enroll > Make New Request.
3. Assign the following settings to the new certificate request.
e Certificate Type
e CA
* Available Key Algorithms
® Subject DN
4. Select the PKCS#12 certificate format.
5. Set a password for the PKCS#12 file.
6. Click Download PKCS#12.
7. When configuring the EJBCA properties, provide the path and password of this PKCS#12 file.

Certificate Type
Select the profile described in Creating an EJBCA entity profile.
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CA

Select ManagementCA.

Available Key Algorithms
Select RSA algorithms with 2048 bits or higher.

Subject DN

The Distinguished Name (DN) for the administrator - for example:

CN=CAGW Admin,0=Your Organization

Downloading the EJBCA certificate chain
Download a trust store containing the CA certificate chain of the client authentication certificate.
To issue the client authentication certificate

1. Login to the EJBCARA GUI.

2. Navigate to CA Certificates and CRLs.

3. In the Certificate chain column of the ManagementCA row, select JKS.
4. Click Download.

o When configuring the EJBCA properties, you must provide the path to the downloaded trust store
file.

Configuring client EJBCA authorization
Grant permissions to the holder of the EJBCA client authorization certificate.
To configure client authorization

1. Login to the EJBCA administration GUI.
2. Navigate to System Functions > Roles and Access Rules.
3. Click Add to create a new one.
4. Configure the following role settings.
* Members
® Role Template
® Access Rules

Members

Click Members and configure the following properties.

Settings Value

Match with  Select either X.509 Certificate Serial Number or X.509: CN, Common name.
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Settings Value

Match value  Enter the serial number or Common Name (CN) of the certificate described in Issuing the EJBCA
client certificate.

CA Select ManagementCA - that is, the same CA that issued the certificate described Issuing the
EJBCA client certificate.

Role Template

We recommend selecting the RA Administrators role as a template.

Access Rules

Click Access Rules and configure the following properties.

Settings Value

Authorized Select only the certificate authorities to which role holders should have access. Do not select
CAs the ManagementCA authority.

End Entity Select only the end entity profiles that should be available. Ensure that each end-entity profile
Profiles has certificate profiles and CAs configured.

Enabling EJBCA API protocols

Enable the required protocols for CA Gateway to consume the EJBCA's APIs.
To enable EJBCA API protocols

1. Login to the EJBCA Administrator GUI.
2. Navigate to System Configuration > Protocol Configuration > Enabled or disable protocol access.
3. Enable the following protocols:
e REST Certificate Management
e REST Certificate Management V2
* Web Service
4. Click Save.

Configuring SANs in EJBCA certificates

Follow the steps below if you need to support Subject Alternative Names (SANs) in issued certificates.
To configure Subject Alternative Names

1. Login to the EJBCA administration GUI.

2. Navigate to RA Functions > End Entity Profiles

3. Select the End Entity Profile you want to configure

4. In the Subject Alternative Name section, add the SAN types you wish to support - for example:
* DNS Name
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IP Address

RFC 822 Name (Email)

URI

UPN (User Principal Name)

5. Configure the Required, Modifiable, and Validation fields for each type.
6. Click Save.

Verifying the EJBCA server SSL certificate
Check that the EJBCA server SSL certificate is properly configured. That is:

® Can be validated using the trust store described in Downloading the EJBCA certificate chain.
¢ Includes the EJBCA server hostname in the Common Name (CN) or SAN (Subject Alternative Names) fields.

Enabling EJBCA dynamic profile generation

When enable-ca-profile-sync parameter is setto true , CA Gateway synchronizes EJBCA profiles as explained
below.

1. CA Gateway queries EJBCA certificate authorities for End Entity Profiles and Certificate Profiles.
2. CA Gateway combines each End Entity Profile with its corresponding Certificate Profiles.

o Each generated profile is defined by a combination of an End Entity Profile identifier and a
Certificate Profile identifier.

3. CA Gateway looks in its configuration for profiles where the certificate-profile and end-entity-
profile properties match the End Entity Profile and Certificate Profile identifiers of an EJBCA-generated
profile.

e |f a profile exists, CA Gateway uses the EJBCA-generated profile to complete only the missing profile
settings. As manually set values always take precedence.
e |f the profile does not exist, CA Gateway uses the EJBCA-generated profile to create a new profile.
4. On certificate enrollment, the requestedProperties also take precedence over EJBCA profile settings.

Integrating an Entrust CA

To connect and perform operations with an Entrust Certificate Authority, CA Gateway requires an administrator
profile issued by the Entrust Certificate Authority. For information about creating this administrator profile, see the
following sections.

¢ Backfilling

® Enabling TLS1.0and TLS 1.1

¢ Creating a certificate type for the administrator profile

¢ Creating a new certificate definition policy for the certificate type
* Mapping the certificate definition policy to the certificate type

¢ Creating a client policy for the administrator profile

¢ Creating a role for the administrator profile

¢ Creating a user entry for the administrator profile

¢ Creating the administrator profile

® Enabling PKCS#12 issuance

¢ Allowing server-generated verification keys

¢ Enabling Entrust Certificate Authority dynamic profile generation

See Entrust CA capabilities for a complete description of the operations supported by these CAs.
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Backfilling

Run the backfill script if the CA you want to connect to is an Entrust Certificate Authority 10.2.x system that was
upgraded from a pre-10.2 release. Specifically, follow the steps described in the following sections of the Entrust
Certificate Authority 10.2 Installation Guide:

¢ Upgrading from previous releases of Entrust Certificate Authority
* Managing the certificate status tracking backfill

At a high level, you need to:

1. Run the certificate status backfill.
* The backfill runs automatically in the background after upgrading to Entrust Certificate Authority
10.2.x from a pre-10.2.x version.
¢ Alternatively, you can run the certificate status backfill on demand using a command in the Entrust
Certificate Authority Control Command Shell (entsh).
2. After the certificate status backfill has finished running, complete the process by running the required
command in the Entrust Certificate Authority Control Command Shell (entsh).

Completing the certificate status backfill is required to retrieve all necessary certificate status
information (including revocation information) for CA Gateway clients.

Enabling TLS1.0and TLS 1.1

CA Gateway communications with early Entrust Certificate Authority versions may require enabling TLS 1.0 and TLS
1.1.

To enable TLS 1.0 and TLS 1.1 in the CA Gateway container
1. Pull or load the CA Gateway Docker image.

docker pull cagw/api:<VERSION> #OR
docker load --input cagw-api-<VERSION>.docker.tar.gz

Where <VERSION> isthe version of the Dockerimage.
2. Create a workaround Dockerfile to overlay on top of the CA Gateway Docker image.

FROM cagw/api:<VERSION> # Temporarily change to root user

USER root

# Remove TLSvl from the disabled list

RUN sed -i 's/TLSvl, //' SJAVA_HOME/conf/security/java.security

# Remove TLSv1l.1l from the disabled list

RUN sed -i 's/TLSv1l.1, //' $JAVA_HOME/conf/security/java.security

# Change back to cagw user
USER cagw

3. Build the workaround Docker image.

docker build . --tag cagw/tls_workaround:<VERSION>
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4.Usethe cagw/tls_workaround:<VERSION> Dockerimage to start the new CA Gateway container with
TLS 1.0 and TLS 1.1 enabled.

docker run -d -p 8444:8080 -v <HOST_CONFIG>:/etc/cagw/config cagw/
tls_workaround:<VERSION>

Where <HOST_CONFIG> isthe folder described in Creating the configuration and credentials folders.

Creating a certificate type for the administrator profile

Create a certificate type for the administrator profile that CA Gateway will use to connect and perform operations
with Entrust Certificate Authority.

0 Skip this section if you are using Post-Quantum Cryptography (PQC) algorithms: ML-DSA algorithms for
signing/verification and ML-KEM algorithms for encryption/decryption. For PQC algorithms, the CA
includes a predefined Admin Services User Management (3-key-pair) (ent_as_ums_3kp) certificate type
that you can use for the administrator profile. This certificate type contains three certificate definitions:
Encryption, Verification, and TlsVerification. The TlsVerification certificate definition policy should use an
RSA-4096 algorithm for TLS client authentication.

To create a certificate type for the administrator profile

1. Export the certificate specifications from the Entrust Certificate Authority:
a. Log in to Entrust Certificate Authority Administration for the CA.
b. Select File > Certificate Specifications > Export.
c. Save the file to a location on the computer.

2. Open the certificate specifications file in a text editor.

3. Add the following to the [Certificate Types] section:

ent_cagwxap_rsal=enterprise,CAGW Admin,CA Gateway XAP Administrator

4. Add the following to the [Extension Definitions] section:

[ent_cagwxap_rsal Certificate Definitions]

1=Dual Usage; Single key dual usage key pair Certificate Type
[ent_cagwxap_rsal Dual Usage Extensions]
keyusage=2.5.29.15,c,m,BitString,101; digitalSignature(0) and
keyEncipherment(2)

; Encodes the entAdminServicesClients policy OID (2.16.840.1.114027.10.4)
certificatepolicies=2.5.29.32,n,0,DER,300D300B06096086480186FAGBOAR4

5. Save and close the file.

6. Import the certificate specifications back into the Entrust Certificate Authority:
a. Log in to Entrust Certificate Authority Administration for the CA.
b. Selecting File > Certificate Specifications > Import.
c. Select the file you edited earlier.
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Creating a new certificate definition policy for the certificate type

The certificate type created in Creating a certificate type for the administrator profile has a Dual Usage certificate
definition. You must create a new certificate definition policy for this certificate definition that disables private key
backup and enforces generating the key at the client application.

To create a new certificate definition policy for the new certificate type

1.
.In the tree view, expand Security Policy > User Policies.

. Select Dual Usage Policy.

. Select Policies > User Policies > Selected User Policy > Copy.

A wWN

o~ o !

Log in to the Entrust Certificate Authority administration console.

The Copy User Policy dialog box appears.
Inthe Label field, enter Dual Usage CAGW Admin Policy .

.Inthe Common name field, enter Dual Usage CAGW Admin Policy.

.Inthe Add to drop-down list, select the searchbase where you want to store the user policy.
. Under Policy Attributes:

¢ Deselect Backup private key.
¢ Select Generate key at client.

. Click OK.
. If prompted, authorize the operation. The operation may require more than one authorization. See the

Entrust Certificate Authority documentation for details.

Mapping the certificate definition policy to the certificate type

After creating a certificate definition policy, you must map this certificate definition policy to the certificate type.

To map the certificate definition policy to the certificate type

1.
2.

3.
4.
5.

Log in to Entrust Certificate Authority Administration for the Entrust Certificate Authority.

In the tree view, expand Security Policy > Certificate Categories > Enterprise > Certificate Types > CAGW
Admin > Dual Usage.

In the Certificate definition policy drop-down list, select Dual Usage CAGW Admin Policy.

Click Apply.

If prompted, authorize the operation. The operation may require more than one authorization. See the
Entrust Certificate Authority Administration documentation for details.

Creating a client policy for the administrator profile

Create a client policy for the administrator profile CA Gateway will use to connect and perform operations with
Entrust Certificate Authority.

To create a new client policy for the administrator profile

1.
. In the tree view, expand Security Policy > User Policies.

. Select Administrator Policy.

. Select Policies > User Policies > Selected User Policy > Copy.

HwN
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Log in to the Entrust Certificate Authority administration portal.

The Copy User Policy dialog box appears.

.Inthe Labelfield, enter CAGW Admin Policy .

. In the Common name field, enter CAGW Admin Policy .

. Inthe Add to drop-down list, select the searchbase where you want to store the user policy.
. Under Policy Attributes, select Permit Server Login usage.

. Click OK.
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10. If prompted, authorize the operation. The operation may require more than one authorization. See the
Entrust Certificate Authority documentation for details.

Creating a role for the administrator profile

To connect and perform operations with an Entrust Certificate Authority, CA Gateway requires an administrator
profile issued by the Entrust Certificate Authority. This profile must have a role with the following permissions.

Permission Permissions
category
Certificates Administer at least one certificate category. Currently, CA Gateway supports only

Enterprise certificate types.

Certificate Types Administer at least one certificate type.

Groups * View
* Administer at least one group

License View
Information

Roles e View
e Administer at least one role.

Searchbases * \View
e Administer at least one searchbase.

Security Policy * View Security Policy
* Export Certificate Specification
® Export User Templates
* Force CRLs
¢ View User Policy

User Templates Administer at least one template
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Permission Permissions

category

User - General e View
e Add

® Reactivate

e Deactivate/Remove

® Change DN

¢ Modify properties

® Revoke certificates

* Update key pairs

¢ Set for key recovery

® Cancel key recovery

¢ Modify key update options
¢ View activation code

® Reissue activation code

User - Advanced ® Change user'srole
® Perform PKIX requests
® Create user profile

o Refer to the Entrust Certificate Authority Administration documentation for more details on role
configuration.

To create a new role for the administrator profile

1. Log in to Entrust Certificate Authority Administration for the Entrust Certificate Authority.
2. In the tree view, expand Security Policy > Roles.
3. Select Policies > Roles > New to create a new role. Alternatively, you can copy the Administrator role
because this role includes most of the permissions required for the new role.
a. Select Administrator.
b. Select Policies > Roles > Selected Role > Copy. A copy of the role appears at the bottom of the list of
roles in the tree view, and the new role’s properties appear in the right pane.
4. Click the Role tab.

a. Into the Unique name field, enter CAGW Admin Role.

b. In the Authorizations field, enter 1.
c. In the User Policy drop-down list, select CAGW Admin Policy. This is the client policy you created
earlier.
d. Unselect the End User check box. This check box should already be deselected.
5. Click the Permissions tab.
6. Configure the permissions documented in the above table and click Apply.
7. If prompted, authorize the operation. As explained in the Entrust Certificate Authority Administration
documentation, the operation may require more than one authorization.
8. A Permission Dependencies pop-up dialog may list additional permissions required for the role to function
properly. Add these missing permissions to the role.

Creating a user entry for the administrator profile

Create a user entry in Entrust Certificate Authority for the administrator profile.
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To create a user entry for the administrator profile

1. Login to the Entrust Certificate Authority administration portal.
2. Select Users > New User to display the New User dialog.
3. Select the following tabs to configure the corresponding fields.
* Naming
® General
e Certificate Info
* Key Update Options
4. Click OK.
5. If prompted, authorize the operation. The operation may require more than one authorization. See the
Entrust Certificate Authority documentation for details.
6. Copy the reference number and authorization code required to create the administrator profile. You will
require them later to create and activate the user’s Entrust digital ID. See the Entrust Certificate Authority
documentation for more details about how the Registration number and Authorization codes are used.

Naming

Configure the following fields under this tab.

Field Value
Type Select a user type.
User fields  Enter a value for all configuration fields of the selected user type.

Add to Select a searchbase for the user - for example, select CA Domain Searchbase to add the user entry
to the default searchbase.

General

Configure the following fields under this tab.

Field Value
Userrole Select the role described in Creating a role for the administrator profile.
User group(s) Assign the user to one or more groups.

Certificate Info

Configure the following fields under this tab.
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Field Value

Catego  Select Enterprise.
ry

Certific  If you are using RSA or EC algorithms for user certificates, select CAGW Admin (the certificate type
ate described in Creating a certificate type for the administrator profile).

Type If you are using Post-Quantum Cryptography (PQC) algorithms - ML-DSA algorithms for signing/
verification and ML-KEM for encryption/decryption - select Admin Services User Management (3-
key-pair). This certificate type contains three certificate definitions: Encryption, Verification, and
TlsVerification. The TlsVerification certificate definition policy should use an RSA-4096 algorithm for
TLS client authentication.

Key Update Options
Under this tab, enable the Use default key update policy option.

Creating the administrator profile

To connect and perform operations with an Entrust Certificate Authority, CA Gateway requires an administrator
profile that is issued by the Entrust Certificate Authority.

To create the administrator profile

1. Install JDK (Java Development Kit) 17 and set the JAVA_HOME environment library.

2. Login to https://trustedcare.entrust.com
3. Go to PKI > Authority >CA Gateway.
4. Download the Profile Creation Utility for your preferred operating system:

e cagw-profilecreationutility-linux64-version.zip for Linux 64-bit.
e cagw-profilecreationutility-win64-version.zip for Windows 64-bit.

5. Extract the file contents.
6. Run the CA Gateway Profile Creation Utility as explained in the following sections.
¢ Creating the administrator profile on software
® Using the Profile Creation Utility to create the administrator profile on hardware

Creating the administrator profile on software
As explained in this section, you can store the administrator profile in software as an Entrust Profile File (EPF).

To create the administrator profile on software

1.Runthe <VERSION> version of the CA Gateway Profile Creation Utility.
e cagw-profilecreationutility-<VERSION>/bin/pcu.sh forLinux.

e cagw-profilecreationutility-<VERSION>/bin/pcu.bat for Windows.

2. Once on the main menu, select option 3 for Create Entrust profile .

3. Select option 1 for File on disk

4. In Take settings from an existing entrust.ini file (y/n)? enter y for yes.
5. In Enter full path to entrust.ini, enter the path of the local file.
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6. In Enter reference number, enter the reference number you obtained when creating a user entry for the
administrator profile.

7. In Enter authorization code, enter the authorization code you obtained when creating a user entry for the
administrator profile.

8. In Enter profile name, enter a file name for the EPF file. Do not include a file name extension because the
utility automatically appends a .epf extension. If you include a .epf extension in the name, it will be added to
the file twice.

9. In Enter profile directory, enter the directory for the EPF file. The name of this file is the name previously
entered in Enter profile name.

10. In Enter profile password, enter a new password to encrypt and MAC the contents of the EPF.

Using the Profile Creation Utility to create the administrator profile on hardware

For information about creating the administrator profile on hardware, see the CA Gateway integration guide for
your hardware security module (HSM).

Enabling PKCS#12 issuance

See below for how to allow Entrust CA to issue PKCS #12 files containing a server-generated key pair and a
certificate.

To enable PKCS#12 issuance

1. Editthe entmgr.ini file
2.Enable the allowServerGenVerCert settingunder policy .

[policy]
allowServerGenVerCert=true

3. Save the changes.

Allowing server-generated verification keys
By default, key pairs can only be generated by client applications of the CA. To enable PKCS #12 enrollment with
client applications, keys must be server-generated - that is, keys generated by the CA.

© sce the Entrust Certificate Authority documentation for instructions on how to export
the entmgr.ini file.
To enable CA-side key pair generation on Entrust CA

1. Exportthe entmgr.ini file using the Entrust Certificate Authority Control Command Shell.

2. Configure the following setting in the entmgr.ini file.
[policy]
allowServerGenVerCert=true

3. Save and close the file.

4. Import the updated entmgr.ini file into the CA using the Entrust Certificate Authority Control Command
Shell,
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Enabling Entrust Certificate Authority dynamic profile generation
When enable-ca-profile-sync parameter is setto true , CA Gateway synchronizes Entrust Certificate Authority
profiles as explained below.

1. CA Gateway mirrors any eligible certificate types and definitions defined in the Entrust Certificate Authority
as basic CA Gateway certificate profiles without the need to define them in the CA Gateway configuration
explicitly.

2. CA Gateway suppresses niche certificate types relating to ePassport applications and legacy software. To
expose these types, enable include-niche-cert-types under Entrust Certificate Authority properties.

Integrating a Sectigo CA

This section explains how to configure CA Gateway to integrate a Sectigo public CA.

¢ Setting Sectigo permissions for API login
¢ Creating the Sectigo SSL credentials trust store
¢ Creating a Sectigo client key store

Sectigo integration only supports TLS profiles. S/MIME profiles are not supported.

See Sectigo CA capabilities for a complete description of the operations supported by these CAs.

Setting Sectigo permissions for API login
You need a Sectigo login with the following minimum privileges.

e SSL certificate privileges
® Domain validation

o See Sectigo CA Properties for how to set the Sectigo user in the CA Gateway configuration.

SSL certificate privileges
Assign at least the following SSL certificate privileges.

® Request SSL certificates

* Revoke SSL certificates

Renew SSL certificates

e Manage SSL certificate requests
¢ Replace SSL certificates

* Manage SSL certificates

Domain validation
Future CA Gateway releases will require at least the following domain validation privileges.

* Manage domain validations
* Manage domains
* Approve domain delegation
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Creating the Sectigo SSL credentials trust store

You need a credentials trust store for SSL communication with the Sectigo API.

o See Sectigo CA Properties for how to set this trust store in the CA Gateway configuration.

To create the trust store for authenticating in the Sectigo API

1. Open a browser to the following URL.

https://cert-manager.com/customer/<customerId>

Where <customer-uri> matchesthe customer-uri value you will configure on the Sectigo CA

Properties.
2. Click the lock icon beside the URL in the address bar and export the certificate chain.

3. Create a trust store containing the exported certificates. For example, use the openssl pkcs12 command
to create a PKCS #12 type trust store.

Creating a Sectigo client key store

As explained in Sectigo CA Properties, you can optionally select a key store as authentication mode for the Sectigo
login. See below for instructions on how to create this key store.

¢ Creating the enrollment form
Adding a person

* |ssuing the client certificate
¢ Creating an administrator

We recommend omitting this section and selecting a password instead when configuring the Sectigo CA
Properties.

Creating the enrollment form
Create an enrollment form for the client certificate.

1. Log in to the Sectigo portal using your browser.

. Go to Enrollment > Enrollment Forms.

. Click the +icon to create a new form.

. In the Name field, enter a name for the enrollment form. For example:

A wWN

myOrganization - Client certificate

(S,

. Inthe Type list, select Client certificate self-enrollment.
.In the Configuration tab, enable Secret ID.
7. Generate the Enrollment Endpoint URL.

(o3}

Adding a person
Add a person to the Sectigo configuration.

1. Navigate to Persons.
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2. Click the +icon.
3. Complete the Add New Person fields. Specifically:
® Provide a secret.
¢ Select the same email address you will later use for the administrator.

Issuing the client certificate
Issue a client certificate to authenticate in the Sectigo API.

1. Open the newly created enrollment form in a new browser tab.

2. Issue a certificate using the same secret and email address configured for the newly created person.

3. Download the PKCS #12 file.

Creating an administrator
Create a user with administrator privileges in Sectigo.

1. Navigate to Settings > Admins.

2. Click the +icon.

3.In the Add Admin Type dialog, select Standard.

4. Complete the Add New Admin fields. Specifically:

5. Use the same email address configured for the newly created person.
6. In the Authentication tab, select the newly issued certificate.
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7 Configuring
To configure CA Gateway, edit the application.yml file and add the following settings.

* cagw

¢ logging
* management
* server

When adding these settings, follow the conventions below.

e Use dashes ("-") instead of underscores ("_") in the key names. For example, we recommend:

aws-api-url

Instead of:

aws_api_url
¢ Expand all properties. For example, instead of:
cagw:
tual.properties: credentials/tual.properties
Expand the parameter as follows:
cagw:

tual:
properties: credentials/tual.properties

¢ In Docker installations, the file paths must not correspond to a directory in the host but to the following

directory mapped in the container.

/etc/cagw/config

For example:

trust-store: /etc/cagw/ssl/truststore.jks

See below for a sample configuration using these conventions.

logging:
level:
root: INFO
jtk:
debug: false
level: 0
ssl:
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jsse:
debug: false
level: ssl
server:
port: 8080
servlet:
context-path: /cagw
ssl:
enabled: true
insecure-mode: false
protocol: TLS
key-alias: cagw
key-store: /etc/cagw/config/keystore.pl2
key-store-password: Password
key-store-type: pkcsl2
trust-store: /etc/cagw/config/truststore.pl2
trust-store-password: Passowrd
trust-store-type: pkcsl2
client-auth: need
management:
server:
port: 9090
ssl:
enabled: true
protocol: TLS
key-alias: cagw
key-store: /etc/cagw/config/keystore.pl2
key-store-password: Password
key-store-type: pkcsl2
trust-store: /etc/cagw/config/truststore.pl2
trust-store-password: Password
trust-store-type: pkcsl2
client-auth: want
endpoint:
health:
group:
custom:
include: diskSpace,ping
show-components: always
show-details: always
endpoints:
web:
base-path: /cagw/management/actuator
exposure:
include: health,prometheus
cagw:
connector-filters:
filter-lists: {}
cert-event-tracking: {}
authorities:
managed-cas: {}
tenants: []
integrators: []
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clients: []

deploy:
enable: {}

caches:

subject-dn-cache: {}
profile-cache: {}
profiles-cache: {}
subject-builder-cache: {}
ca-capabilities-cache: {}
ca-information-cache: {}
requested-properties-cache: {}

license:
signed-path: /etc/cagw/config/license.lic

@ sce Running the Profile Creation Utility for how to create a basic configuration.

cagw
Under this section, define the following application settings.

® authorities

e caches

¢ ca-polling-initial-delay
¢ ca-polling-interval
® cert-event-tracking
e clients

e cmp

e connector-filters

® integrators

® license

e tenants

® tual.properties

authorities
Under this section, define the following authority settings.

¢ halt-for-error
®* managed-cas.<ca>
® ssl

halt-for-error

The performed action when finding an invalid CA configuration.

Value Action

true Halt CA Gateway.

CA Gateway 3.7 - Docker Deployment Guide



@ ENTRUST

Value Action

false Skip the CA, log the detected errors, and connect only to CAs with proper configuration

Mandatory: No. This optional parameter defaults to false.

key-size
Under this section, add the following settings to enable and configure the key size validation.

® min-ecc
® min-rsa
® reject

When defined under different configuration sections, the key-size set of parameters has the following precedence,
from least to greatest (the last listed variables override all other variables).

1. key-size under authorities
2. key-size under managed-cas.<ca>
3. key-size under profiles.<profile>

min-ecc

The minimum key size for elliptic curve keys, as a number of bytes.

min-rsa

The minimum key size for RSA keys, as a number of bytes.

reject

The performed action when the CA key does not meet the min-ecc or min-rsa size requirements.

Value Action

off Nothing

log Log the key size
block Reject the key

managed-cas.<ca>

Under this field, add the following settings for each <ca> managed certificate authority. Where <ca> isthe CA
unique identifier when referenced by:

e Other application.yml settings.

® The CA Gateway API.
e Client applications such as Entrust Certificate Enrollment Gateway.

This value supports:
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* |etters

* numbers

* hyphens

® underscores

We recommend precisely unique identifiers without mixed cases. For example, the following identifiers are not
unique and can lead to unintended consequences due to a feature called "relaxed bindings".

* Managed-CA-01
* ManagedCA01

See below for the required settings under each CA identifier.

® connector-name

¢ enable-ca-profile-sync
® jssuer-dn

* key-size

* name

e profiles.<profile>

® properties

connector-name

The CA connector name. See the table below for the supported values.

Connector CA

com.DigiCertCA DigiCert Certificate Authority
com.EJBCA EJB Certificate Authority
com.entrust.MicrosoftCA Microsoft Certificate Authority
com.SectigoCA Sectigo (for testing purposes only)
com.entrust.SecurityManager Entrust Certificate Authority

Mandatory: Yes.

enable-ca-profile-sync

true to enable profile synchronization with the certificate authority; false otherwise. See below for the
certificate authorities supporting this feature.

Certificate authority provider Synchronization details
Entrust Certificate Authority Enabling Entrust Certificate Authority dynamic profile generation
Sectigo CA Enabling Sectigo CA dynamic profile generation
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Certificate authority provider Synchronization details

EJBCA Enabling EJBCA dynamic profile generation

Mandatory: No. This optional value defaults to false.

issuer-dn

The Distinguished Name (DN) of the CA. For example:

CN = Certificate Authority, O = Entrust, Inc, C = US
CN = "Entrust Class 2 Client CA", OU = "(c) 2010 Entrust, Inc.", OU =
"www.entrust.net/CPS 1is incorporated by reference", 0 = "Entrust, Inc.", C = US

As explained in RFC 2253, you can surround the value of each DN field with quote (""" ASCII 34) characters, which are
not part of the value. Inside the quoted value, the following characters can occur without any escaping:

PeRinll
)

° =1

o 4"

° "<

° "SI

° Il#ll

o .1
)

0 When configuring a DigiCert CA, refer to https://knowledge.digicert.com/general-information/digicert-
trusted-root-authority-certificates for the DN of intermediate certificate issuers.

Mandatory: Yes.

key-size
Under this section, add the following settings to enable and configure the key size validation.

® min-ecc
® min-rsa
* reject

When defined under different configuration sections, the key-size set of parameters has the following precedence,
from least to greatest (the last listed variables override all other variables).

1. key-size under authorities
2. key-size under managed-cas.<ca>
3. key-size under profiles.<profile>

min-ecc

The minimum key size for elliptic curve keys, as a number of bytes.

CA Gateway 3.7 - Docker Deployment Guide 86


https://www.ietf.org/rfc/rfc2253.txt
https://knowledge.digicert.com/general-information/digicert-trusted-root-authority-certificates

@ ENTRUST

min-rsa
The minimum key size for RSA keys, as a number of bytes.
reject

The performed action when the CA key does not meet the min-ecc or min-rsa size requirements.

Value Action

off Nothing

log Log the key size

block Reject the key
name

A friendly name for the CA.
Mandatory: Yes

profiles.<profile>
Under this field, add the following settings for each profile with the <profile> identifier.

® copy-cn-to-san

* key-size (profile)

* name (profile)

¢ CA-specific profile settings

® san-requirements

¢ subject-builder-config

¢ subject-variable-requirements

For example:

profiles:
CA-1003-PROF-1001:
name: default profile
subject-variable-requirements:
- required: true
name: CN
description: common name
subject-builder-config:
subject-builder-name: >-
com.entrust.adminservices.cagw.common.subjects.TemplateSubjectBuilder
properties:
template: cn=<First Name> <Last Name>,ou=CA01l,o0=pki,dc=hooli,dc=com
properties:
cert-type: ent-twokeypair
cert-definition: Verification
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user-type: Person

copy-cn-to-san
true to enable copyingthe CN of the Subject DN as Subject Alternative Name, false otherwise.

Mandatory: No. This optional parameter defaults to false.

key-size
Under this section, add the following settings to enable and configure the key size validation.

® min-ecc
® min-rsa
® reject

When defined under different configuration sections, the key-size set of parameters has the following precedence,
from least to greatest (the last listed variables override all other variables).

1. key-size under authorities
2. key-size under managed-cas.<ca>
3. key-size under profiles.<profile>

min-ecc

The minimum key size for elliptic curve keys, as a number of bytes.
min-rsa

The minimum key size for RSA keys, as a number of bytes.

reject

The performed action when the CA key does not meet the min-ecc or min-rsa size requirements.

Value Action

off Nothing

log Log the key size

block Reject the key
name

A friendly name for the profile.

Mandatory: Yes.
CA-specific profile settings
See below for the profile settings specific to each supported Certificate Authority.

* AWS CA profile settings
¢ DigiCert CA profile settings
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EJBCA profile settings

Entrust Certificate Authority profile settings
GlobalSign profile settings

Microsoft CA profile settings

Sectigo CA profile settings

AWS CA profile settings
Under profiles.<profile>, add a properties section with the following AWS CA-specific settings.

* aws-ca-cert-template-arn
o cert-default-validity-period

aws-ca-cert-template-arn

The AWS ARN that uniquely identifies the certificate template for issuing certificates. For example:

"arn:aws:acm-pca:::template/EndEntityServerAuthCertificate_APIPassthrough/Vv1"
Mandatory: Yes.

cert-default-validity-period

The default validity period, as an 1ISO 8601 string for the corresponding profile. For example, P3YOMOD is a three
years validity period.

Mandatory: Only if your enrollment client does not provide a validity period in the enrollment request for the
profile.

DigiCert CA profile settings
Under profiles.<profile>,add a properties section with the following DigiCert CA-specific settings.

e cert-type

¢ dcv-method

¢ verified-contact-email

¢ signature-hash

¢ order-validity-days

e cert-validity-days
cert-type

Enter the certificate types, also referred to as "DigiCert products", supported by the profile. List them as a comma-
separated string of DigiCert identifiers.

["ss1l_cloud_wildcard", "ssl_plus", "ssl_multi_domain"]

See the available values at:
https://dev.digicert.com/en/certcentral-apis/services-api/glossary.html#product-identifiers

Mandatory: Yes.

dcv-method
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The method to prove control over a domain when requesting an SSL/TLS certificate from a DigiCert CA. Supported
values are the following.

Value Description
dns-cname-token CNAME DNS record validation
http-token HTTP file validation
http-token-dynamic Dynamic HTTP file validation
dns-txt-token TXT DNS record validation

Mandatory: When the selected product requires a validation method.

verified-contact-email
The email address of the Verified Contact associated with the organization requesting an EV certificate.

Mandatory: Only for Extended Validation (EV) certificates.

signature-hash
The cryptographic algorithm for generating a hash of the signed data.
Supported values are:

¢ sha256
e sha384
e sha512

Mandatory: Yes.

order-validity-days

The number of days for which each certificate order remains active, allowing certificates to be issued, reissued, or
renewed under the same order.

Mandatory: No. This optional value defaults to 199 days.
cert-validity-days

The certificate validity period, in days.

Mandatory: No. This optional value defaults to 199 days.

EJBCA profile settings
Under profiles.<profile>, add the following EJBCA-specific settings.

¢ properties (EJBCA)
® requestedProperties (EJBCA)

properties

Under profiles.<profile>, add a properties section with the following EJBCA-specific settings.
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e certificate-profile

¢ end-entity-profile

* key_client_generated

® key-recoverable
certificate-profile

The name of the certificate profile in EJBCA.
Mandatory: Yes.

0 When enable-ca-profile-syncis setto true, this setting is automatically populated; however, manually
configured values take precedence.

end-entity-profile
The name of the end-entity profile in EJBCA.
Mandatory: Yes.

0 When enable-ca-profile-syncis setto true, this setting is automatically populated; however, manually
configured values take precedence.

key_client_generated

The key generation mode.

Value Key generation Default
true Generate the keys on the client side with a CSR o
false Generate the keys on the server side, in a PKCS #12

0 When enable-ca-profile-syncis setto true, this setting is automatically populated; however, manually
configured values take precedence.

key-recoverable

The key recovery status.

Value Key recovery Default
true Server-side-generated keys can be recovered
false Server-side-generated keys cannot be recovered o
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0 When enable-ca-profile-syncis setto true, this setting is automatically populated; however, manually
configured values take precedence.

requestedProperties

Under profiles.<profile>,add a requestedProperties section with the properties users must provide during
EJBCA enrollment.

® username

® password

* key_algs
username

The unique name of the end entity in EJBCA.
Mandatory: Yes.

0 When enable-ca-profile-syncis setto true, this setting is automatically populated; however, manually
configured values take precedence.

password
The password for authenticating enrollment requests in EJBCA

Mandatory: Yes.

0 When enable-ca-profile-syncis set to true, this setting is automatically populated; however, manually
configured values take precedence.

key_algs

The key algorithm for server-side key generation.

The selected value must be included in the Available Key Algorithms list described in Creating an EJBCA
certificate profile.

Mandatory: When disabling key_client_generated under properties.

0 When enable-ca-profile-syncis setto true, this setting is automatically populated; however, manually
configured values take precedence.

Entrust Certificate Authority profile settings
Under profiles.<profile>, add the following Entrust Certificate Authority-specific settings.

e filter-list
® properties
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o See Allowing server-generated verification keys for how to enable PKCS #12 generation on Entrust
Certificate Authority.

filter-list
The identifier of the filter list for issuing trusted certificates.

Mandatory: No.

properties

Under profiles.<profile>, add a properties section with the following Entrust Certificate Authority-specific
settings.

e ca-variable-<i>

e cert-definition

® cert-type

® create-ldap-entry
e directory-mode

e user-role

e user-role-override
® user-type

ca-variable-<i>

When create-ldap-entry is false , use the following set of parameters to define each user variable CA Gateway
supplies to Entrust Authority Entrust Certificate Authority.

® ca-variable-<i>-type

e ca-variable-<i>-name
e ca-variable-<i>-value
e ca-variable-<i>-in-dn

Where <i> isaninteger value number starting at 0. For example:

ca-variable-0-type: UserType
ca-variable-0-name: cn
ca-variable-0-value: <firstname>
ca-variable-0-in-dn: true
ca-variable-1-type: UserType
ca-variable-1-name: sn
ca-variable-1-value: <lastname>
ca-variable-1-in-dn: false
ca-variable-2-type: Custom
ca-variable-2-name: email
ca-variable-2-value: <email>
ca-variable-2-in-dn: false

Mandatory: Only when create-ldap-entry is false.

ca-variable-<i>-type

The type of variable. Supported values are:
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* CertType
e Custom
® UserType
® Variable

ca-variable-<i>-name

The name of the Managed CA variable. See the table below for examples.

name type Value
cn UserType = Common Name attribute in the directory.
sn UserType Serial Number attribute in the directory.

email  Custom The certificate subject's email. Entrust Authority Entrust Certificate Authority and clients
like UMS understand the email variable, so no additional configuration is necessary.

ca-variable-<i>-value

The value of the Managed CA variable. This value must include one or more substrings surrounded by angle
brackets. For example:

e <firstname> forthe user's first name.

e <lastname> forthe user's last name.

Client applications will provide the actual values during enrollment.

ca-variable-<i>-in-dn
true toinclude the variable value in the user's Distinguished Name (DN), false to exclude the variable value
from the user DN.
cert-definition
The certificate definition for processing enrollment requests under the certificate profile. For example:

e Verification
® Dual usage
® Encryption

This certificate definition must have an assigned certificate definition policy. Otherwise, enrollments will fail.

Mandatory: Yes.

cert-type

The Entrust Certificate Authority certificate type to use when processing an enrollment request under the certificate
profile. For example:

¢ ent_twokeypair
¢ ent_default

The administrator EPF for the Managed CA must have permission to administer this certificate type.
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Mandatory: Yes.

create-ldap-entry

The LDAP entry creation mode.

Value Action

true CA Gateway will create the LDAP entry for the user. CA Gateway will connect to the directory using the
LDAP credentials specified for the Managed CA.

false  The Entrust Certificate Authority will create an LDAP entry for the user depending on the managed-

cas.profiles.directory-mode value.

Mandatory: No. This optional parameter defaults to true .

directory-mode

When create-ldap-entry is false, this setting controls whether the Entrust Certificate Authority creates an LDAP
entry for the user.

o When choosing an option that instructs Entrust Certificate Authority to create the directory entry, you
must set the ca-variable-<i> variables.

Value Action
DO_OP_FAIL_IF_NOT_NEEDED Perform the repository operation when needed, and fail if not needed.

DO_OP_SUCCEED_IF_NOT_NEED  Perform the repository operation when needed, and return success if not
ED needed.

NO_OP Omit the repository operation and do not check if the operation is needed.

NO_OP_FAIL_IF_NEEDED Omit the repository operation, but fail if the operation is needed.

In the CA profile, certificate types as vpn_nodir include the following master.certspec advanced setting

under [Extension Definitions].
noUserInDirectory=1

Mandatory: No. This optional parameter defaults to NO_OP .

user-role

The Entrust Certificate Authority role for processing enrollment requests under the certificate profile (for example,
"End User"). The administrator EPF for the Managed CA must have permission to administer this role.

Mandatory: No.
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user-role-override

true to allow enrollment requests to specify a user role that overrides the default role of the
profile; false otherwise.

Mandatory: No. This setting defaults to false.

user-type
The Entrust Certificate Authority user type to use when processing an enrollment request under the certificate
profile. For example:

® Person
e Web Server

The administrator EPF for the Managed CA must have permission to administer this user type.
Mandatory: No. The user type is not required when create-ldap-entry is false.

GlobalSign profile settings

Under profiles.<profile>,add a properties section with the following GlobalSign Certificate Center (GCC)-specific
settings.

e cert-type

® base-option

* key-size

¢ domain-id

¢ validity-months
¢ contact

® campaign

e coupon

cert-type

The type of issued certificate. See the table below for the supported certificates.

cert-type Description

PEV_SHA2 SSL certificate for Extended Validation (EV)

PV_SHA2 SSL certificate with Domain Validation (DV)

PV_INTRA Intranet SSL certificate

PV_INTRA_SHA2 Intranet SSL certificate signed with SHA-256

PV_INTRA_SKIP Intranet SSL signed with SHAL and issued with a CA-generated key pair on a P12

PV_INTRA_SKIP_SHA2 Intranet SSL signed with SHA-256 and issued with a CA-generated key pair on a P12
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cert-type Description

PV_INTRA_ECCP256 Intranet SSL (ECC P-256) certificate
PV_CLOUD Cloud SSL certificate
PV_CLOUD_ECC2 Cloud SSL (ECC) certificate

Mandatory: Yes

base-option

The trust model and validation rules for the requested certificate. See the table below for the supported values for
each certificate type.

base- Trust model Supported certificate types

option

gip GlobalSign Internet PKI for publicly trusted PEV_SHA2, PV_SHA2, PV_CLOUD,
certificate profiles PV_CLOUD_ECC2

private GlobalSign Internet PKI for non-public or PV_INTRA_SKIP, PV_INTRA_SHA?2,
internal certificates PV_INTRA_SKIP_SHA2, PV_INTRA_ECCP256

wildcard A publicly trusted certificate that contains a PEV_SHA2, PV_SHA2, PV_CLOUD,
wildcard SAN, such as x.example.com PV_CLOUD_ECC2

Mandatory: No

key-size
The key size for the issued certificates. Supported values are:

* 2048
* 4096

Mandatory: only for the following certificate types.

* PV_INTRA_SKIP_SHA2
* PV_INTRA_ECCP256

domain-id
The identifier of the managed SSL domain record in the GlobalSign MSSL account.
Mandatory: Yes

validity-months

The default validity period for issued certificates, as a number of months.
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This value is overridden by the validityPeriod enrollment request field (if included).
Mandatory: Yes

contact
The contact details for the certificate order.

* email
® phone
e first-name
e |last-name

Mandatory: Yes

campaign
Analytics tag to associate certificate orders with a specific campaign or cost center.

Mandatory: No.

coupon
Promotional coupon code applied through the reseller billing system, not the GlobalSign CA.

Mandatory: No.

Microsoft CA profile settings
Under profiles.<profile>,add a properties section with the following Microsoft CA-specific settings.

® cert-template

¢ enrollment-agent-p12

* enrollment-agent-p12-password
® key-client-generated

* ra-enroll-key-alias

* ra-enroll-key-password

® ra-enroll-key-store

¢ ra-enroll-key-store-password

¢ ra-enroll-key-store-provider

¢ ra-enroll-key-store-provider-config
® ra-enroll-key-store-type

CA Gateway logs a warning message when the profile definition does not meet the syntax described in the
following sections.

cert-template
The Microsoft Certificate name. No spaces.

Mandatory: Yes.

enrollment-agent-p12
The filename of the PKCS#12 generated when creating RA enrollment agent credentials in a Key Store file.

Mandatory: Only when creating RA enrollment agent credentials in a Key Store file.
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enrollment-agent-p12-password
The password of the PKCS#12 generated when creating RA enrollment agent credentials in a Key Store file.

Mandatory: Only when creating RA enrollment agent credentials in a Key Store file

key-client-generated

The client key generation mode.

Value Key generation mode
true The client generates the key and provides a CSR for CA Gateway to return an X.509 certificate.

false CA Gateway returns a PKCS#12 containing the client's key and certificate.

Mandatory: No. This optional parameter defaults to true .

ra-enroll-key-alias
The alias for accessing the enrollment agent's key in either:

¢ Akey store file.
® An HSM slot. In this case, you can usually omit this value because most HSMs do not protect the slot objects
with an additional password.

Mandatory: Yes.

ra-enroll-key-password
The password for accessing the enrollment agent's key in either:

¢ Akey store file.
® An HSM slot. In this case, you can usually omit this value because most HSMs do not protect the slot objects
with an additional password.

Mandatory: Yes.

ra-enroll-key-store

The path of the file generated when creating RA enrollment agent credentials in a Key Store file. Supported
extensions for this file are:

* pl2
e pfx
® kks
® jceks

Mandatory: Yes.
ra-enroll-key-store-password

The password of the key store containing the enrollment agent credential. Where the key store is either:

¢ Akey store file.
® An HSM slot.

We recommend creating the enrollment agent credentials in a PKCS#11 HSM.
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Mandatory: Yes.

ra-enroll-key-store-provider

The security provider of the key store. When creating RA enrollment agent credentials in a Key Store file, supported
values are the following.

Value Security provider
SunJSSE PKCS#12 and PFX
SUN JKS

SunJCE JCEKS

When creating RA enrollment agent credentials in PKCS#11 HSM, supported values are the following.

Value Security provider
SunPKCS11 nCipher
LunaProvider Luna

CA Gateway tries loading the key store with any available security provider when this value is omitted or
incorrect.

Mandatory: Yes.

ra-enroll-key-store-provider-config
The path of the SunPKCS11 configuration file described in the Thales Luna integration guide.
Mandatory: Yes.

ra-enroll-key-store-type

The type of key store. See the table below for the supported values.

Credential type Supported key store types
RA enrollment agent credentials in a Key Store file pkcs12

pfx

jks

jceks
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Credential type Supported key store types

RA enrollment agent credentials in PKCS#11 HSM pkcsll

Mandatory: Yes.

Sectigo CA profile settings
When integrating a Sectigo CA, configure the Sectigo-specific profile settings as follows.

¢ Configuring the static Sectigo CA profile settings
¢ Enabling Sectigo CA dynamic profile generation

Sectigo integration only supports TLS profiles. S/MIME profiles are not supported.

Configuring the static Sectigo CA profile settings

Under profiles.<profile>, add a static configuration like the following.

profiles:
sectigo-profile-1:
name: "static-profileA-local"
properties:
cert-type: 60515

Where cert-type isthe identifier of a profile configured in Sectigo.

Enabling Sectigo CA dynamic profile generation

After Configuring the static Sectigo CA profile settings:

1. Set the enable-ca-profile-sync flagto true.
2. Make an APl calltothe /vl/certificate-authorities/{cald}/profiles endpoint.

CA Gateway will return the static configuration merged with profiles configured at Sectigo. For example:

{
"message": {
"message'": "Profiles retrieved successfully.",
"details": []
3,
"profiles": [
{
"id": "sectigo-profile-1",
"name": "static-profileA-local",

"properties": {

"cert_type": "60515"
3,
"protocols": [],
"requestedProperties": [],
"subjectAltNameRequirements": [],
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"subjectVariableRequirements": []
1,
{
"id": "60515",
"name": "profileA",
"properties": {
"cert_type'": "60515",
"description": "',

|lkey_typel|: |l{\||EC\I|: [\||P_256\|l’\||P_384\|l’\l|P_521\|l] ’\HRSA\": [\"2048\" ,

\||3072\|| ,\"4@96\",\"8192\"]}",
"terms": "[30]",

"use-secondary-org-name": "false"

1,

"protocols": [],
"requestedProperties": [],
"subjectAltNameRequirements": [],
"subjectVariableRequirements": []

|lkey_typel|: |l{\||EC\I|: [\||P_256\|l’\||P_384\|l] ’\HRSA\": [\"2048\" ’\|I4G)96\|l’

1,
{
"id": "63999",
"name": "Sectigo Enterprise Pro - Multi-Domain (OV)",
"properties": {
"cert_type'": "63999",
"description'": "',
\"8192\"]1}",
"terms": "[47, 200, 365, 397]",
"use-secondary-org-name": "false"
1,
"protocols": [],
"requestedProperties": [],
"subjectAltNameRequirements": [],
"subjectVariableRequirements": []
1,
{

"id": "64442",
"name": "test",
"properties": {
"cert_type'": "64442",
"description": "asdfsadf",

|lkey_typel|: |l{\||EC\I|: [\||P_256\|l s \||P_384\|l s \||P_521\|l] , \HRSA\"

\"3072\",\"4096\",\"8192\"]}",
"terms": "[30]",
"use-secondary-org-name": "false"
1,
"protocols": [],
"requestedProperties": [],
"subjectAltNameRequirements": [],
"subjectVariableRequirements": []
}
1,

"type": "ProfilesResponse"
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}

See below for the main parameters in this configuration.

* key-types
® terms

0 In this API response, some parameter names include underscores for backwards compatibility, and key
type values are escaped because they contain embedded JSON code.

key-types
A list of supported key types for the issued certificate.

This parameter is dynamically provisioned by Sectigo when enabling the enable-ca-profile-sync flag, so
you do not need to set it manually.

For example

llkey_typesll : Il{\IIEC\II : [\IIP_256\I| , \IIP_384\I|] 5 \IlRSA\II : [\|l2048\|l 5 \I|4096\I| , \|l8192\|l] }Il
As described in the table below, the requested validity (if any) must be included on this list.

Request type Requested key type Key type for the issued certificate

PKCS #10 Included in the key-types list As selected in the request
Not included in the key-types list Error

PKCS #12 — Thefirstin the key-types list, if key-type is not
available, uses default.

Mandatory: No, this optional value defaults to a list containing a single RSA 2048 key type.

terms

A list of supported certificate validity periods, in days.

This parameter is dynamically provisioned by Sectigo when enabling the enable-ca-profile-sync flag, so
you do not need to set it manually.

For example

terms": "[47, 200, 365, 397]"

As described in the table below, the requested validity (if any) must be included on this list.
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Request type Requested validity Validity of the issued certificate

PKCS #10 Included in the terms list As selected in the request

Notincludedinthe terms list Error

None Thefirstinthe term list, if term list not available, uses
default.

PKCS #12 — The first in the term list, if term list not available, uses
default.

Mandatory: No, this optional value defaults to a list containing a single 30-day period.

san-requirements

Under this section, define the requirements of the Subject Alternative Name (SubjectAltName) expected during
enrollment requests.

* type
® required

For example:

san-requirements:
- type: rfc822Name
required: false
- type: otherName
required: false

type
The type for the Subject Alternative Name, as defined by RFC 5280. For example:

¢ rfc822Name
e dNSName

Mandatory: Yes.
required
true if the Subject Alternative Name is required, false if the Subject Alternative Name is optional.
Mandatory: Yes.
subject-builder-config

Under this section, define the Subject Builders for constructing the subject DN for the enrollment request.

¢ subject-builder-name
® properties
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subject-builder-name
The class name of the subject builder.

® com.entrust.adminservices.cagw.common.subjects.BasicSubjectBuilder
® com.entrust.adminservices.cagw.common.subjects.SubAltNameSubjectBuilder
® com.entrust.adminservices.cagw.common.subjects.TemplateSubjectBuilder

CA Gateway ignores this setting, and the subject name in the CSR prevails when an enrollment request for
a Sectigo CA specifies the PEM, PEM_WITHOUT_LINE_BREAKS, or X509 formats.

Mandatory: No. This optional parameter defaults to
com.entrust.adminservices.cagw.common.subjects.BasicSubjectBuilder.
com.entrust.adminservices.cagw.common.subjects.BasicSubjectBuilder

Select this subject builder to append all the supplied subject variables together in the order of arrival.
Sample BasicSubjectBuilder

- name: "Use BasicSubjectBuilder"
unique-id: "CA-1003-PROF-1001"
subject-builder-config:
subject-builder-name:
"com.entrust.adminservices.cagw.common.subjects.BasicSubjectBuilder"

Sample subject variables

"subjectVariables" : [

{
lltype" : chll’
"value" : "test"

1,

{
lltype" : "o")
"value" : "pki"

}

Subject DN generated by the sample builder when parsing the sample variables

cn=test,o=pki

com.entrust.adminservices.cagw.common.subjects.SubAltNameSubjectBuilder

Select this subject builder to construct the Subject DN from the Subject Alternative Name provided in the request or
CSR. Specifically, this builder:
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1. Pulls out the SAN as per the order of the san-type-order property.
2. Uses the first SAN as the subject by filling the provided template. This SAN type can have only one value.
3. Gives priority to SAN from the request over the SAN provided in CSR.

This subject builder is useful when subject is not provided in both the request and CSR.
Sample SubAltNameSubjectBuilder

- name: "Use SubAltNameSubjectBuilder"
unique-id: "CA-1003-PROF-1003"
subject-variable-requirements:
- name: SAN
description: "Subject Alternative Name"
required: true
subject-builder-config:
subject-builder-name:
"com.entrust.adminservices.cagw.common.subjects.SubAltNameSubjectBuilder"
properties:
template: "cn=<SAN>,ou=CA01,o0=pki,test,dc=com"
san-type-order:
dNSName,iPAddress,registeredID, rfc822Name,uniformResourceldentifier

Sample subject variables

"subjectVariables" : [
{
"type" : "Subject Alternative Name",
"value" : "SAN"
}

1,

"subjectAltNames" : [ {
"type" : "dNSName",
"value" : "cagw.test"

1]

Subject DN generated by the sample builder when parsing the sample variables

cn=cagw.test,ou=CA01,o0=pki,test,dc=com

com.entrust.adminservices.cagw.common.subjects.TemplateSubjectBuilder

Select this subject builder to replace DN (Distinguished Name) variables in a template with variables from the CSR
(Certificate Signing Request).

¢ Example: building the Common Name from Subject Variables
¢ Example: building the Common Name when no Subject Variables are provided

CA Gateway 3.7 - Docker Deployment Guide 106



@ ENTRUST

Example: building the Common Name from Subject Variables

To build the final DN, the following template expects an enrollment request with subject variables for "First Name"
and "Last Name".

o When subject variables are sent, any fields in the template are considered required and must be supplied
in the request as subject variables.

- name: "Use TemplateSubjectBuilder"
unique-id: "CA-1003-PROF-1002"
subject-variable-requirements:
- name: First Name
description: "First Name"
required: true
- name: Last Name
description: "Last Name"
required: true
subject-builder-config:
subject-builder-name:
"com.entrust.adminservices.cagw.common.subjects.TemplateSubjectBuilder"
properties:
template: "cn=<First Name> <Last Name>, ou=CAOl,o=pki,dc=test,dc=com"

For example, when receiving the following request values.

"subjectVariables" : [

{

"type" : "First Name",
"value" : "PKI"

1,

{

"type" : "Last Name",
"value" : "Test"

}

]

The template builds the following Distinguished Name.
cn=PKI Test,ou=CAQl,o0=pki,dc=test,dc=com

Example: building the Common Name when no Subject Variables are provided

To build the final DN when no Subject Variables are provided, the following template parses the CSR for common
name.

o When no subject variables are sent, this configuration will scrape the CN and UID from the CSR. No other
fields are supported.
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- name: "Use TemplateSubjectBuilder"
unique-id: "CA-1003-PROF-1002"
subject-builder-config:
subject-builder-name:
"com.entrust.adminservices.cagw.common.subjects.TemplateSubjectBuilder"
properties:
template: "cn=<cn>,ou=CA01,o0=pki,dc=test,dc=com"

Parsing a CSR with multiple common names requires indexing the template output, starting with cn.1. For
example;

template: "cn=<cn.1>, cn=<cn.2>, cn=<cn.3>, ou=CA01l,o0=pki,dc=test,dc=com"

The use of <CN> or <cn> should be consistent.

properties
Under this section, configure the following Subject Builder properties.

* template
® san-type-order

template

The DN template to use for constructing the subject. For example:

subject-builder-config:
subject-builder-name:
"com.entrust.adminservices.cagw.common.subjects.TemplateSubjectBuilder"
properties:
template: "cn=<CN>,ou=CA01,o0=pki,dc=hooli,dc=com"

Mandatory: When the value of subject-builder-name
is com.entrust.adminservices.cagw.common.subjects.SubAltNameSubjectBuilder.

san-type-order
The SAN types to be used as the subject, in order of preference. Supported SAN types are:

e dNSName

iPAddress

e registeredID

¢ rfc822Name

¢ uniformResourceldentifier

Mandatory: When the value of subject-builder-name
is com.entrust.adminservices.cagw.common.subjects.SubAltNameSubjectBuilder.
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subject-variable-requirements

Under this section, define the subject variables for an enrollment operation with the certificate profile. When CA
Gateway clients query the certificate profile, these variables inform the subject variable to supply when enrolling for
a certificate using the profile.

* name
e description
® required

For example:

subject-variable-requirements:
- name: First Name
description: "First Name"
required: true
- name: Last Name
description: "Last Name"
required: true

name
The name of the variable.

Mandatory : Yes.

description
A friendly description of the variable.

Mandatory : Yes.

required

true if the variable is required, false if the variable is optional.

As of CA Gateway 3.3, this setting is enforced by policy. CA Gateway may throw an error if set to false for
a variable that is actually required by a template.

Mandatory : Yes.

properties
The CA-specific properties described in the following sections.

® AWS CA properties

DigiCert CA properties

EJBCA properties

Entrust Certificate Authority properties
GlobalSign properties

Microsoft CA properties

Sectigo CA Properties

Mandatory: Yes.
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AWS CA properties
Under properties, configure the following AWS CA-specific settings.

® aws-api-url

® aws-assume-role-arn

® aws-ca-arn

® aws-ca-audit-report-s3-bucket-name
® aws-ca-s3-crl-arn

® aws-region

* aws-sts-token-duration-in-seconds
® aws-user-access-key-id

® aws-user-arn

® aws-user-login-url

® aws-user-secret-access-key

e certificate-events-storage-method
¢ dynamodb-table-name

aws-api-url

The AWS CA API regional URL for the plugin to interact with AWS. For example:

"https://acm-pca.us-east-1.amazonaws.com:443/"
Mandatory: Yes.

aws-assume-role-arn

The AWS ARN that uniquely identifies the IAM role. This is used when your AWS user configured above does not have
the required permission under the AWS user. If this parameter is defined, the plugin will assume the AWS IAM role
defined and obtain temporary security credentials in order to access the AWS resources needed.

o Your AWS user should have a role with permissions for the required resources such as dynamodb access,
awscm private ca access, S3 CRL, and audit report access.

Mandatory: No.

aws-Ca-arn

The AWS ARN that uniquely identifies the AWS CA. For example:

"arn:aws:acm-pca:us-east-1:422825380052:certificate-authority/b6fd6660-
e6eb-4fed-9fe9-d5a82f952ed4"

Mandatory: Yes.

aws-ca-audit-report-s3-bucket-name

The AWS S3 bucket name uniquely identifying the bucket for saving AWS Audit Reports. For example:

"cagw-audit-report"
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o You can generate multiple Audit Reports in a shared bucket. Each generated report in the bucket will be an
object with a unique key.

Mandatory: No.

aws-ca-s3-crl-arn

The AWS ARN uniquely identifying the bucket for saving the CRL. For example:

"arn:aws:s3:::wy-crl"
Mandatory: Yes.

aws-region

The AWS region of the CA. For example:
"us-east-1"

CAinstances are only available in their region.
Mandatory: Yes.

aws-sts-token-duration-in-seconds

The duration in seconds that the STS temporary credential should remain valid. Default is 1200 seconds if not
specified.

Mandatory: When defined together with properties.aws-ca-cert-template-arn inthe AWS CA profile
settings.

aws-user-access-key-id

The AWS APl username. For example:

"AKIAWE4S3JDKMNSG5K5T"
Mandatory: Yes.

aws-user-arn
The AWS ARN that uniquely identifies the IAM user
Mandatory: Yes.

aws-user-login-url
The AWS sign URL for the IAM user
Mandatory: Yes.

aws—user—secret—access—key

The AWS API password.
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Mandatory: Yes.

certificate-events-storage-method

The storage type for recording events - for example:

“DynamoDb”
Mandatory: No

dynamodb-table-name

The name of the Dynamo database for storing the events.

Mandatory: When the value of certificate-events-storage-method is"Dynamo DB".

DigiCert CA properties
Under properties, configure the following DigiCert CA-specific settings.

® services-url

* api-key

® org-id

® payment-method

® proxy-host-name

® proxy-port

® proxy-username

® proxy-password
services-url

The base URL for the request ot the DigiCert services API. For example:

https://www.digicert.com/services/v2
Mandatory: Yes.
api-key
The API key for consuming the CA services.
In production mode, move this value to a jTinyUAL encrypted file.
Mandatory: Yes.

org-id
The identifier of your organization in the DigiCert services.

Mandatory: Yes.

payment-method
The method for billing requests to the DigiCert services. Supported values are:

* balance
e profile
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Mandatory: No. This value defaults to balance .

proxy-host-name

The hostname of the proxy for accessing the CA server.

0 The proxy configured using this parameter is part of your corporate infrastructure; it is not an Entrust
product.

Mandatory: Only when traffic to the CA server passes through a proxy.

proxy-port
The port for accessing the proxy.

Mandatory: Only when traffic to the CA server passes through a proxy.

proxy-username
The username for authenticating in the CA server proxy.

Mandatory: Only when the proxy requires authentication.

proxy-password
The password for authenticating in the server proxy.

Mandatory: Only when the proxy requires authentication.

EJBCA properties
Under properties, configure the following EJBCA CA-specific settings.

® ca-name

¢ edition

® base-url

® admin-p12

® admin-p12-password

e trust-store

e trust-store-type

e trust-store-password
Cca-name

The CA name - for example:

abc-issuing
Mandatory: Yes.

edition

The identifier of the EJBCA edition. See below for the supported value.
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Identifier Edition

CE EJBCA Community Edition.

Mandatory: No. This value defaults to the CE .

base-url
The hostname or IP address of the EJBCA server.

Mandatory: Yes.

admin-p12
The path of the PKCS #12 file described in Issuing the EJBCA client certificate.
Mandatory: Yes.

admin-p12-password
The password of the PKCS #12 file described in Issuing the EJBCA client certificate.
Mandatory: Yes.

trust-store
The path of the file described in Downloading the EJBCA certificate chain.
Mandatory: Yes.

trust-store-type
The type of the file described in Downloading the EJBCA certificate chain. Supported values are:

* JKS
* PKCS12

Mandatory: No. This optional value defaults to JKS .

trust-store-password

The password of the file described in Downloading the EJBCA certificate chain. Leave empty if the file is not
password-protected.

Mandatory: No. This optional value defaults to no password.

Entrust Certificate Authority properties
Under properties, configure the following Entrust Certificate Authority-specific settings.

¢ admin-epf

¢ admin-epf-data

¢ admin-epf-password

¢ admin-pll-apf

¢ admin-pll-library

¢ admin-pll-password

¢ admin-pll-slot

¢ allow-full-pkup

¢ include-niche-cert-types
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¢ |dap-ca-cert

e |dap-cert

¢ |dap-credential

¢ |dap-host

¢ |dap-port

¢ |dap-principal

® |daps-port

¢ oid.<oidName>

¢ pkix-port

® sm-host

® xap-connections-idle-timeout
® xap-connections-init

® xap-connections-max

® xap-connections-socket-timeout
* xap-debug

* xap-debug-level

¢ xap-debug-log-file

® Xxap-port

admin-epf

The path of the administrator's Entrust Profile File (EPF) for connecting to the Entrust Certificate Authority
instance.

o See Configuring for how to reference file paths.
Mandatory: When saving the user settings in an Entrust Profile File (EPF).

admin-epf-data
The administrator's Entrust Profile File (EPF), as Base64 text.

Mandatory: When saving the administrator's settings in an Entrust Profile File (EPF).

This setting takes preference over admin-epf.

admin-epf-password
The password for decrypting the administrator's Entrust Profile File (EPF).

Mandatory: When saving the administrator's settings in an EPF.
admin-p11-apf
The path of the APF (Auxiliary Profile File).

o See Configuring for how to reference file paths.

Mandatory: When saving the user settings in a PKCS #11 hardware security module (HSM) and archiving old private
keys locally (to make them available for other purposes).

admin-pl1-library
The full path of the PKCS#11 native library.
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Mandatory: When saving the user settings in a PKCS #11 hardware security module (HSM).

admin-pll-password
The PKCS#11 user PIN to log in to the PKCS#11 slot.
Mandatory: When saving the user settings in a PKCS #11 hardware security module (HSM).

admin-pl1-slot
The slot number of the PKCS#11 slot.
Mandatory: When saving the user settings in a PKCS #11 hardware security module (HSM).

allow-full-pkup

The value of the PrivateKeyUsagePeriod extension in certificates issued by Entrust Certificate Authority when
the request:

¢ Includesthe optionalCertificateRequestDetails.validityPeriod field,and

® Does notinclude the optionalCertificateRequestDetails.privateKeyUsagePercentage field.

See below for the values supported by this setting.

apply-full-pkup PrivateKeyUsagePeriod
true The 100% of the optionalCertificateRequestDetails.validityPeriod value.

false Set by the CA.

0 As explained in RFC2459, the PrivateKeyUsagePeriod extension "allows the certificate issuer to
specify a different validity period for the private key than the certificate".

Mandatory: No. This optional value defaultsto true.

include-niche-cert-types

true to expose certificate types relating to ePassport applications and legacy software, false otherwise.

Mandatory: No. This optional parameter defaults to false.

ldap-ca-cert
The PEM encoding of the root CA certificate for validating the LDAPS certificate.

¢ Add the encoding of a single certificate.
* Configure also the ldap-cert parameter if a subordinate CA issued the LDAPS certificate.

Mandatory; When the Java truststore cannot validate the LDAPS certificate.

ldap-cert
The PEM-encoded certificate of the subordinate CA that issued the LDAPS certificate.

¢ Add the encoding of a single certificate.
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* Omit this parameter if the LDAPS certificate was issued by the root CA selected with the ldap-ca-

cert parameter.

Mandatory; When a subordinate CA issued the LDAPS certificate, and the Java truststore cannot validate the
certificate.

|dap-credential

The password of the LDAP user.

Save this property in secure storage such as Vault rather than directly in a configuration file.
Mandatory: Yes

ldap-host
The hostname of the directory instance.

Mandatory: Yes.

ldap-port

The port number for LDAP connections with the Entrust Certificate Authority directory.

0 This value is typically 389, the well-known port for LDAP.
Mandatory: When using an LDAP connection.
ldap-principal
The name of the LDAP user for logging in to the directory.

Save this property in secure storage such as Vault rather than directly in a configuration file.

Mandatory: Yes
ldaps-port
The port number for LDAPS connections with the Entrust Certificate Authority.

0 This value is typically 636, the well-known port for LDAPS.
Mandatory: When using an LDAPS connection.

oid.<oidName>

The attribute with the <oidName> OID. This property allows CA Gateway clients to request non-standard Subject DN
attributes. For example:

oid.jurisdictionOfIncorporationLocalityName: 1.3.7.1.4.1.311.60.2.1.1

Where 1.3.7.1.4.1.311.60.2.1.1 is the jurisdictionOflncorporationLocalityName numerical value.

Entrust Certificate Authority also requires configuring the OIDs in the CA configuration:

1. Editthe manager/entrust.ini file.
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2. Add entries for each OID under boththe [0IDTable] and [X500AttrSyntax] sections.

For example:

[OIDTable]
jurisdictionOfIncorporationLocalityName=1.3.7.1.4.1.311.60.2.1.1

[X500AttrSyntax]
jurisdictionOfIncorporationLocalityName=caseIgnoreStringSyntax

See the Entrust CA Operations Guide for further detail.
Mandatory : No.

pkix-port
The PKIX-CMP port number of the Entrust Certificate Authority instance
Mandatory: Yes

sm-host
The hostname of the Entrust Certificate Authority instance.

Mandatory: Yes

xap-connections-idle-timeout
The idle timeout of the Entrust Certificate Authority XAP connection, in seconds.

Mandatory: No. This optional parameter defaults to 30 seconds.

xap-connections-init
The initial number of XAP connections to the Entrust Certificate Authority.

Mandatory: No. This optional parameter defaults to 20 connections.

xap-connections-max
The maximum number of XAP connections to the Entrust Certificate Authority.

Mandatory: No. This optional parameter defaults to 20 connections.

xap-connections-socket-timeout
The socket timeout of the Entrust Certificate Authority XAP connection, in seconds.

Mandatory: No. This optional parameter defaults to 60 seconds.

xap-debug

true forlogging the XAP debugging to file; false otherwise.
Mandatory: No. This optional parameter defaults to false.
xap-debug-level

The XAP debug log level, from 0 (no logging) to 7 (maximum logging).

Mandatory: No. This optional parameter defaults to 0.
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xap-debug-log-file

The full path of the XAP debug log file.

Mandatory: Only when xap-debug is true.

xap-port

The XAP port number of the Entrust Certificate Authority instance.
Mandatory: Yes.

GlobalSign properties

Under properties, configure the following GlobalSign Certificate Center (GCC)-specific settings.

e username

¢ login-password

e profile-id

® mssl-api-url

® query-api-url
username

The account username to authenticate with the GlobalSign Certificate Center (GCC) service.

This value must match the name of an authorized user in the GCC system.
Mandatory: Yes.

login-password
The password associated with the username.

Mandatory: Yes.

profile-id
The identifier of the GlobalSign Certificate Center Managed SSL profile for issuing certificates.
Mandatory: Yes.

mssl-api-url
The endpoint for the Managed SSL Service (MSSL) API.
Mandatory: Yes.

query-api-url
The endpoint of the GAS Service (GlobalSign Approval Service).
Mandatory: Yes.

Microsoft CA properties
Under properties, configure the following Microsoft CA-specific settings.

® ca-host
® ca-name
® ca-proxy-url
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® key-recovery-agent-pl2-<i>
® key-recovery-agent-pl2-password-<i>
¢ |dap-host
¢ |dap-port
® |daps-port
® proxy-host-name
® proxy-password
® proxy-port
® proxy-ssl
® proxy-username
ca-host
The CA hostname, as either:

e AnIP
e Ahostname
e AFQDN

As long as it resolves from the DNS.

Mandatory: Yes.

Cca-name

The CA name - for example:

abc-issuing
Mandatory: Yes.

ca-proxy-url

The URL of the Entrust Proxy for Microsoft CA, in the following format.

https://<server>:8443/MSCAProxy
Mandatory: Yes.

key-recovery-agent-p12-<i>

The path of the key PKCS#12 generated when creating the RA recovery agents (if any). Where <i> isaninteger
greater than or equal to 0.

Mandatory: Only when creating the RA recovery agents.

key-recovery-agent-p12-password-<i>
The password of the key recovery agent PKCS#12.

Mandatory: Only when creating the RA recovery agents.

ldap-host

The Microsoft Active Directory, as an IP, a hostname, or an FQDN (as long as it resolves from the DNS). The host
must be in the ca-host domain because:
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¢ CA Gateway only talks to the Entrust Proxy for Microsoft CA.
® The Entrust Proxy for Microsoft CA is on the CA's same domain and talks to the CA.

For example:

ca-host: msca.abccorp.dev.entrust.com
ca-name: abccorpsub

ldap-port: 389

ldap-host: dc.abccorp.dev.entrust.com

Mandatory: Yes.

ldap-port

The port number for LDAP connections with Microsoft Active Directory (for LDAPS connections, configure ldaps-

port instead).

o The port is anonymously bound. The Microsoft CA proxy connects to Active Directory to get certificate
template information.

This value is typically 389, the well-known port for LDAP.

Mandatory: When not configuring ldaps-port.

ldaps-port

The port number for LDAPS connections with Microsoft Active Directory (for LDAP connections, configure ldap-

port instead).

° The port is anonymously bound. The Microsoft CA proxy connects to Active Directory to get certificate
template information.

This value is typically 636, the well-known port for LDAPS.

Mandatory: When not configuring ldap-port .

proxy-host-name

The hostname of the proxy for accessing the CA server.

0 The proxy configured using this parameter is part of your corporate infrastructure; it is not an Entrust
product.

Mandatory: Only when traffic to the CA server passes through a proxy.

proxy-password
The password for authenticating in the server proxy.

Mandatory: Only when the proxy requires authentication.

proxy-port
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The port for accessing the proxy.

Mandatory: Only when traffic to the CA server passes through a proxy.

proxy-ssl

Under this section, configure the following authentication settings.

Parameter

client-cert-key-alias

client-cert-key-store

client-cert-key-store-
password

client-cert-key-store-type

ssl-trust-store

ssl-trust-store-password

ssl-trust-store-type

proxy-username

Description

The alias of the CA Gateway client key

The filename of the CA Gateway client JKS

The password of the CA Gateway client JKS

Set this parameterto JKS

The path of the CA Gateway trust store (See Configuring for how
to reference file paths)

The password of the CA Gateway trust store.

The type of CA Gateway trust store. Supported values are JKS
and PKCS12.

The username for authenticating in the CA server proxy.

Mandatory: Only when the proxy requires authentication.

Sectigo CA Properties

Under properties, configure the following Sectigo CA-specific settings.

® Sectigo settings

¢ Authentication settings

e SSL settings
Enrollment settings
® Proxy settings

© sce Configuring for how to reference file paths.

Sectigo settings

Configure the following mandatory Sectigo settings.
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Setting Value

customer-uri The customer identifier provided by Sectigo
org-id The organization identifier provided by Sectigo
url The URL of the Sectigo API

Authentication settings
CA Gateway supports the following modes to authenticate in the Sectigo API.

e Password (recommended)
* Key store
¢ APl key (future releases)

See below for the settings each mode requires.

Setting Value Passwo
rd
login A Sectigo login name for a user with the privileges described in Setting @

Sectigo permissions for API login

login- The password of the selected Sectigo login name o
password

client-cert-key-  The path of the client trust store described in Creating a Sectigo client
store key store

client-cert-key-  The alias of the client key in the client trust store
alias

client-cert-key-  The password of the client trust store
store-
password

client-cert-key-  The type of client trust store. Supported values are JKS and PKCS12 .
store-type

SSL settings
Configure the following mandatory SSL settings to connect with the Sectigo API.
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Setting Value

ssl-trust-store The path of the trust store described in Creating the Sectigo SSL credentials trust store
ssl-trust-store- The password of the trust store

password

ssl-truststore-type The type of CA Gateway trust store. Supported values are JKS and PKCS12.

Enrollment settings

The following settings control the enrollment requests.

Key Value

enroll-back-off-timer The starting back-off period for certificate retrieval

enroll-max-back-off-timer  The maximum back-off period before the next certificate retrieval
attempt

enroll-max-attempts The maximum number of certificate retrieval attempts

After submitting an enrollment, CA Gateway waits for the following period.

min(enroll-back-off-timerfattempt, enroll-max-back-off-timer)

Where the attempt value:

1. Starts at 1 on the first enrollment attempt.

2. Isincreased by 1 after each retrieval attempt, until reaching the enroll-max-attempts value.

CA Gateway responds with the following HTTP codes to the client enrollment requests.

Code Description

HTTP 200 The certificate has been retrieved on time

Default

2 sec

32 sec

HTTP 202  The request has been processed, but CA Gateway has exceeded the enroll-max-attempts

period

HTTP 404 Any other failure

When receiving a HTTP 202 response, you can:
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1. Look up the certificate using the {caId} Certificate Authority identifier and the {dn} Distinguished
Name.

/vl/certificate-authorities/{cald}/subjects/{dn}

2. Ascertain the serial number from the response.
3. Look up the certificate using the {sn} serial number.

/vl/certificate-authorities/{cald}/certificates/{sn}

Proxy settings

Configure the following settings if traffic to the CA server passes through a proxy.

° The proxy configured using these settings is part of your corporate infrastructure; it is not an Entrust

product.
setting Value
proxy-host-name The hostname of the proxy for accessing the CA server.
proxy-port The port for accessing the proxy
proxy-username The username for authenticating in the proxy (if required)
proxy-password The password for authenticating in the proxy (if required)

ssl

Configure the following settings when communicating with Entrust Certificate Services using a non-standard
certificate. For example, for QA purposes.

e trust-store
® trust-store-password

€ Do not use these settings in production.

trust-store

The full path of the truststore that contains the CA certificates.

© see Configuring for how to reference file paths.

Mandatory: Yes.
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trust-store-password
The password of the truststore referenced by the trust-store parameter.

Mandatory: Yes.

caches

See the following table for the cache parameters each CA Gateway APl supports and their default value.

API Main YAML expire- expire- expire- expire-after- initial- maximu
parameter after- after- after- value capacit m-size
access write unit y
ca- ca- false false 10 500
capabilitie  capabilities-
s-cache cache
calnforma  ca- false false 60 (with 10 500
tion information- internal
cache eviction policy)
CMPv2 cmp- (Not true SECONDS 10 2 2
enrollmen  transaction- supported)
t cache
profile profile-cache  false false 20 100
profiles profiles- false false 20 100
cache
requested  requested- false false 60 (with 20 100
Properties  properties- internal
cache eviction policy)
subjectBui  subject- false false 20 100
lder builder-cache
subjectDN  subject-dn- false false 2000 10000
Cache cache

For example:

caches:
ca-information-cache:
enabled: true
maximum-size: 500
initial-capacity: 10
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expire-after-write: true
expire-after-value: 60
expire-after-unit: SECONDS
profiles-cache:
enabled: false
maximum-size: 100
initial-capacity: 20
expire-after-access: true
expire-after-value: 10
expire-after-unit: SECONDS

See below for a description of each parameter.

® Enabled parameter
® Expiry start parameters
® Cache size parameters

Q Setting the following parameters is an expert-level configuration.

Enabled parameter

All API caches support the enabled boolean parameter to enable or disable the cache.

Expiry start parameters

If you want to configure the expiry of an APl cache, select the event that triggers the expiry countdown.

Parameter Event

expire-after-access = The most recent event among: cache creation, most recent cache replacement, latest
cache access.

expire-after-write The most recent event among: cache creation, most recent cache replacement.

These parameters are mutually incompatible. When both are setto True ,the expire-after-
access parameter takes precedence.

Expiry period parameters

After selecting the event that triggers the cache expiry, use the following parameters to set the timeout.

Parameter Value
expire-after-unit The time unit for the expiry period: SECONDS, MINUTES, HOURS
expire-after-value The number of time units before removing an entry from the API cache.

CA Gateway will disable cache expiry for the selected API unless:
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e Eitherthe expire-after-access orthe expire-after-write parametersaresetto True.

® Boththe expire-after-unit and expire-after-value parameters are configured.

Cache size parameters

Use the following parameters to set the size of a cache API.

Parameter Value
initial-capacity The initial number of entries in the API cache.
maximum-size The maximum number of entries supported by the API cache.

ca-polling-initial-delay

The number of seconds before starting the CA Health Check service. This service polls the CAs configured under
managed-cas.<ca> with a ca-polling-interval periodicity.

Mandatory: No. This optional parameter defaults to 30 seconds.

ca-polling-interval

The number of minutes between each execution of the CA Health Check service. This service polls the CAs
configured under managed-cas.<ca>.

Mandatory: No. This optional parameter defaults to 5 minutes.

cert-event-tracking
Under this section, configure the following settings.

¢ default-aws-query-backoff-seconds
¢ default-query-page-size

¢ overhead-epoch-adjustment

® sm-clock-drift-tolerance

[ 0 Setting the following parameters is an expert-level configuration. ]

default-aws-query-backoff-seconds

The number of seconds to back off between queries to AWS certificate authorities.

Q Setting this parameter is an expert-level configuration. ]

Mandatory: No. This optional value defaults to 5.

default-query-page-size

The default page size to use when making queries, as an integer value equal to or greater than 1.

CA Gateway 3.7 - Docker Deployment Guide 128



@ ENTRUST

Mandatory: No. This optional value defaults to the following sizes.

CA Default
AWS 25
Entrust Certificate Authority 1000
Microsoft CA 1000
Sectigo 10

The default values of this parameter are set to ensure good performance for the Certificate events
endpoint endpoint. Please consider this before selecting higher values.

overhead-epoch-adjustment

The overhead epoch adjustment for Entrust Certificate Authority authorities, as a percentage in decimal format. For
example, to set a 30% value:

overhead-epoch-adjustment: .3

The minimum supported value is 0.

€ Ssetting this parameter is an expert-level configuration.

Mandatory: No. This optional parameter defaultsto .1 (thatis, to 10%).

sm-clock-drift-tolerance

The number of seconds to be applied as back-off for all the times sent to Entrust Certificate Authority authorities
when querying over a time range. While this increases the number of repeated records, it allows adjustments that
ensure times are properly overlapping in their environment.

¢ When the Entrust Certificate Authority authority is ahead of CA Gateway, there is an increase in the number
of previously retrieved records in subsequent queries. This expected behavior is due to grey zone issues and
causes no problem for the client. In this scenario, clock drift tolerance only increases the probability of more
previously retrieved records being returned and does not generate an error.

¢ Detecting when the Entrust Certificate Authority authority has fallen behind is more complicated as it only
manifests when observed state changes are not in the query's result. In this case, clock drift tolerance allows
evaluating how many seconds back-off the queries sent to Entrust Certificate Authority.

Time drift can continue over time, possibly resulting in the drift falling outside the configured value. Thus, constant
monitoring of the times is needed, and periodic changes may become necessary.

Q Setting this parameter is an expert-level configuration.

Mandatory: No. This optional value defaults to 0.
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clients

In CA Gateway, a client is an authorized end entity of the CA Gateway's API. Each client is:

¢ Assigned a role that controls how the client can structure certificate requests (see Role permissions).
* Mapped to either a tenant or an integrator.

Under this section, add the following properties for each client.

® integrator-id

® role

® subject-dn
* tenant-id

integrator-id

The integrator identifier.

0 This value is mapped with the client and is mutually exclusive with tenant-id.

Mandatory: Yes.

role

One of the following roles.

Role
identifier

integrator

policy-con
strained-te
nant

policy-
override-
tenant

read-only-
integrator

read-only-
tenant

Role main permissions

Access to multiple CAs. For example, as an organization providing
services or capabilities to customers, such as Identity Management
service providers like Microsoft Intune.

View a single CA. For example, as a consumer of the services provided by
the Integrator.

Control the naming information in the certificates requested to Entrust
Certificate Authority. The CA policy of the requested certificate profile
determines all other certificate content.

Access multiple CAs and perform get operations on any of them.

Access one CA and perform get operations.

Granted by default

Default role for
clients mapped to an
integrator.

Default role for
clients mapped to a
tenant.

See the following table for a more detailed description of the permissions assigned to each predefined role.
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Permission

Access multiple CAs

Request explicit
extensions

Request private key usage
period

External public keys (no
CSR)

Override Proof of
Possession

Request explicit validity
dates

CSR

PKCS#12

Subject DN Naming Info
(including subjectDn and
previousSubjectDn
optional parameters)

Subject Alternative Names

Manage certificates
(revoke, suspend,
unsuspend)

Search in the certificate
inventory

Certificate events

integ
rator

o

o

o

o

policy-
override-
tenant

Single CA
only

o

o

policy- constrained- tenant

Single Entrust Certificate
Authority only

(]

Can shorten the lifetime in
CSR enrollments (relative to
the CA policy).

o

o

o

Authorized users can request certificates with the following contents.
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e Certificate Lifetimes.

¢ Certificate naming information: Subject DN (subject to CA DIT constraints), Subject Alternative Names.

* Key Usage
* Private Key Usage Percentage
* Required Certificate Extensions

No client role can request the following extensions from Entrust Certificate Authority.

¢ authorityKeyldentifier (2.5.29.35)

¢ basicConstraints (2.5.29.19)

e cRLDistributionPoints (2.5.29.31)

e cRLNumber (2.5.29.20)

e entrustVersinfo (1.3.0040.113533.7.65.0)

e invalidityDate (1 2.5.29.24)

e issuingDistributionPoint (2.5.29.28)

* netscapeRevocationUrl (2.16.840.1.113730.1.3)
¢ reasonCode (2.5.29.21)

¢ subjectKeyldentifier (2.5.29.14)

Q CA Gateway will ignore these extensions when included in a CSR sent from a client.

Each role can access any of the REST APIs. However, based on the role, the requested action is scoped to the
allowed set of managed CAs.

Mandatory: No. This optional parameter defaults to the lowest privileged role.

subject-dn
The subject DN of the client.

You must issue the client a digital certificate with this subject DN.

Mandatory: Yes.

tenant-id

One of the tenant identifiers listed under tenants.

€ Thisvalue is mapped with the client and is mutually exclusive with integrator-id.

Mandatory: Yes.

cmp
The configuration settings for enrolling certificates using the CMPv2 certificate management protocol.

¢ shared
® specification.customization
e trust-store (cmp)

0 Setting the following parameters is an expert-level configuration.

CA Gateway 3.7 - Docker Deployment Guide

132



@ ENTRUST

shared
The settings for each connection between the CMP enrollment server and the potential request transmitters.

e server.dn
® transmitters

Mandatory: Yes.

server.dn

The subject's distinguished name of the certificate the enrollment server will use to sign the issued certificates.

0 The certificate must be included in the trust-store selected with the trust-store parameter

Mandatory: Yes.

transmitters
A list of potential CMP request transmitters. Under this field, define each transmitter with the following settings.

® -dn
* secrets

Mandatory: Define at least one transmitter.

-dn

The subject's distinguished name of the certificate the transmitter will use to sign CMP requests.

0 The certificate must be included in the trust-store selected with the trust-store parameter

Mandatory: Yes.

secrets

A list of request signing keys. Under this field, define each transmitter key with the following settings.

Setting Value
- key-identifier =~ The identifier of the key in the trust-store selected with the trust-store parameter.

passcode The password for accessing the key in the trust-store selected with the trust-store parameter.
Mandatory: Define at least one signing key.

specification.customization

Definea <specification-id>.validation field for each CMPv2 specification, where <specification-id>
is the specification identifier. See below for the supported specification settings.

excluded-tests
* implementation
¢ minimum-ec-key-length
* minimum-rsa-key-length
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® permitted-digest-algorithms

® permitted-ec-public-key-algorithms
® permitted-mac-algorithms

® permitted-signature-algorithms

® permitted-signature-classes

For example, the following code defines customization rules with the enable-shal, relaxed and password-

based identifiers.

cagw:
cmp:
specification:
customizations:
enable-shal: # value used to identify this entry, i.e. specificationName
passed in the request
validation:
permitted-digest-algorithms:
- SHA-1 # Adds this value to the list if not already present

relaxed:
validation:
permitted-digest-algorithms:
- SHA-1
- SHA-384- # If the last character is '-' it means remove this value

from list if it is present
excluded-tests:
- TS_33_310.certRequestId # Ignore the actual value, the spec says this
value MUST be 0 but AS tool does not use that value
- certConf.SignatureBased.extraCertsPresent # Ignore checking if
extaraCerts are present, spec says they SHALL be omitted but AS tool provides them
and we're just going to dignore them
password-based:
validation:
permitted-digest-algorithms:
- SHA-1
excluded-tests:
- TS_33_310.certRequestId
- dr.Protection.rejectPBM # Enable PBM for just IR operations as KUR
must be signed by previously dissued certificate for the device
- certconf.Protection.rejectPBM # Since only IR is PBM enabled, and
certConf uses the same protection as the initial request, certConf for KUR won't be
affected

Mandatory: Define at least one specification.

excluded-tests
The list of specific tests to be excluded during validation of the message.

Mandatory: No.

implementation

The extended validation mechanism. Supported values are:
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* RFC_4210
e TS_33_310

Mandatory: No. This optional value defaultsto TS_33_310.

minimum-ec-key-length
The minimal key length allowed for EC (Elliptic-curve) public keys.
Mandatory: No. This optional value defaults to 256 bits.

minimum-rsa-key-length
The minimal key length allowed for RSA public keys.
Mandatory: No. This optional value defaults to 2048 bits.

permitted-digest-algorithms
The list of supported one-way digest algorithms. Supported list items are:

* SHA-256
¢ SHA-384

Mandatory: No. When omitting this optional value, both SHA-256 and SHA-384 are supported.

permitted-ec-public-key-algorithms
The list of algorithms of supported EC public keys. Supported list items are:

® secp256rl
® secp384rl

Mandatory: No. When omitting this optional value, both secp256r1 and secp384r1l aresupported.

permitted-mac-algorithms

The list of supported MAC (Message Authentication Code) algorithms.

Mandatory: No. When omitting this value, a default list is built from the permitted-digest-algorithms value.

permitted-signature-algorithms

The list of supported signing algorithms.

Mandatory: No. This option defaults to a list built from the following specification.customization settings.
* permitted-digest-algorithms
® permitted-signature-classes

permitted-signature-classes

The list of supported signature algorithm classes. Supported list items are:

® rsa
® ecdsa

Mandatory: No. When omitting this optional value, both rsa and ecdsa are supported.
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trust-store
The configuration settings of the trust-store that contains root CA certificates for verifying CMP messages.

e aliases

¢ allow-expired-vendor-certs
® |ocation

® password

* type

Mandatory: Yes.

aliases

A list of aliases of trusted root CA certificates. Under this field, define each alias with the following settings.

-name
The alias assigned to the certificate when stored in the trust store

Mandatory: Yes.

dn
The DN (Distinguished Name) of the certificate.
Mandatory: Yes.

allow-expired-vendor-certs
true to allow clients to authenticate with an expired vendor certificate, false otherwise.

Mandatory: No. This optional parameter defaults to false.

location

The full path of the truststore that contains the CA certificates.

© sce Configuring for how to reference file paths.
Mandatory: Yes.

password
The password of the truststore that contains the CA certificates.

Mandatory: Yes.

type

The type of truststore containing the CA certificates.

Type Description

jks Java truststore
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Type Description

pkcs12 PKCS #12 truststore

Mandatory: Yes.

connector-filters

Under this section, add the following settings for each filter.

connector_filters:
filter_lists:
<filter_id>:
filters:
- name: <filter_name>
connector_name: <connector>
properties: <properties>

Where:

e <filter_id> isthe filteridentifier.
e <filter_name> isthe filter descriptive name.

e <connector> isone of the following connector identifiers.

e com.entrust.CAAuthorization
e com.entrust.CertificateEvents
* com.entrust.CertTransparency

® <properties> isa lists of the properties supported by the selected connector.

com.entrust.CAAuthorization

Filter to conduct CA Authorization checks for certificates intended for public trust. When selecting this filter,
configure the following settings under properties.

® check-domains-external-to-cs
check-domains-from-csr

® dns-server.<i>.<setting>

® issuer-string

* |og-server.<i>.<setting>

check-domains-external-to-cs

true for CA Gateway to make CAA checks for domains in the subjectAltNames field external to the
CSR, false otherwise.

Mandatory: No. This optional parameter defaults to true .
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check-domains-from-csr

true for CA Gateway to make CAA checks for domains inside the CSR, false otherwise.

Mandatory: No. This optional parameter defaults to true .

dns-server.<i>.<setting>

The DNS settings, where "i" is an index starting at 0. You can omit this index when defining a single DNS.

<setting>

port

timeout-first-
seconds

timeout-
second-
seconds

timeout-
dsquery-
seconds

Mandatory: Yes.

issuer-string

Value Defaul

t

The IP address of the local DNS server that CA Gateway will use to look up the DNS
issuer resource record.

The port of the DNS server. 53
The timeout of the first DNS lookup attempt, in seconds. 3
Timeout of the second DNS lookup attempt, in seconds. Applicable if the first 7

attempt results in an error.

Timeout in seconds of the Delegation Signer (DS) query when querying DNSSEC 7
support.

The CAAissuer name, as expected in the DNS resource record. Real-world examples include:

* entrust.net
* pki.goog

The name is owned and defined by the issuer and registered in DNS for any CA to check.

Mandatory: Yes

log-server.<i>.<setting>

The settings of each log server CA Gateway must contact to request the signed CT response. Therefore, you must
define at least one server, with <i> startinga 0.

<setting>

name

Value

A friendly name for the log server. For example: "Google Log Server".
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<setting> Value
url The URL of the log server
google True if the SCTs produced by this log server are Google Chrome compatible.

public-key The public key of the log server, as a Base64 DER-encoded public key. Log servers typically
advertise their keys publicly.

tls-trust- The trust anchor for the CT Filter to perform the TLS handshake with the log server, as a Base64
anchor DER-encoded certificate.

Mandatory: Yes.

com.entrust.CertificateEvents
Convenience filter to:

1. Read a certificate.
2. Extract data from the certificate.
3. Add the data to the response so that the caller does not have to immediately decode the certificate.

0 This filter does not require configuring properties.

com.entrust.CertTransparency
Filter to:

1. Collect a set of signed CT log server responses.
2. Ask the underlying CA if the certificates for public trust include these responses in an SCT List extension.

When selecting this filter, configure the following settings under properties.

¢ connection-timeout-millis
e ct-policy-json
¢ log-server.<i>.<setting>
¢ proxy-host-name
¢ socket-timeout-millis
connection-timeout-millis
The connection timeout for the HTTP communication with the log server, in milliseconds.

Mandatory: No. This optional parameter defaults 5000 milliseconds.

ct-policy-json

The number of log server responses CA Gateway must wait for.
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o CA Gateway can cope with slow running or unresponsive log servers when the number of servers
configured under log-server.<i>.setting exceedsthe number of required responses.

The general form of this JSON value is:

{
sct-policy: [
[<months-threshold>,<threshold-equals>,<google-min-responses>,<non-google-min-
responses>]
1,

insurance:<insurance>

}

See below for a description of each field.

* months-threshold
threshold-equals

e google-min-responses

® non-google-min-responses
® insurance

Mandatory: No. This optional parameter defaults to:

{
sct-policy: [
[39,true,0,1]
1,

insurance:0

}

In the configuration, you can flatten this default value to:

{sct-policy:[[38,true,0,1]],insurance:0}

months-threshold
The applicability of the sct-policy policy according to the certificate lifetime, as a number of months.

e When defining multiple policies, this value determines which policy to apply for issuing a certificate.
¢ Specifying a high value ensures this policy applies to all certificates issued.

threshold-equals

The operator for comparing the months-threshold and the actual certificate lifetime.

Value Operator

true =
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Value Operator

false <=

google-min-responses

The minimum number of Google-compatible log server responses to include in the issued certificate.
non-google-min-responses

The minimum number of non-Google-compatible log server responses to include in the issued certificate.

insurance

The number of log server responses to collect above the following minimum.
google-min-responses + non-google-min-responses
log-server.<i>.<setting>

The settings of each log server CA Gateway must contact to request the signed CT response. Therefore, you must
define at least one server, with <i> startinga 0.

<setting> Value

name A friendly name for the log server. For example: "Google Log Server".

url The URL of the log server

google True if the SCTs produced by this log server are Google Chrome compatible.

public-key The public key of the log server, as a Base64 DER-encoded public key. Log servers typically
advertise their keys publicly.

tls-trust- The trust anchor for the CT Filter to perform the TLS handshake with the log server, as a Base64
anchor DER-encoded certificate.

Mandatory: Yes.

proxy-host-name

The hostname of the proxy for accessing the CA server.

o The proxy configured using this parameter is part of your corporate infrastructure; it is not an Entrust
product.

Mandatory: Only when traffic to the CA server passes through a proxy.
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socket-timeout-millis
The TCP Socket timeout for the HTTP communication with the log server, in milliseconds.

Mandatory: No. This optional parameter defaults 5000 milliseconds.

integrators
Under this section, add the following properties for each integrator.

®* name
® tenant-ids
® unique-id

name

A friendly name for the integrator.

Mandatory: Yes.

tenant-ids

One or more of the tenant identifiers defined when configuring tenants. This setting maps an integrator to one or
more tenants.

Q Do not map multiple integrators to the same tenant. Errors will occur if you map more than one integrator
to the same tenant.

Mandatory: Yes.

unique-id

A unique identifier for the integrator. When creating certificates for clients, you can specify this integrator ID to map
aclient to an integrator.

Mandatory: Yes.

license
Under this section, define the license settings required by your installation mode.

® signed-path
® zip-path
® zip-password

signed-path
The path of the signed license file.

¢ [fthefileisin the host configuration folder, you only must provide the file name.
¢ If you place the file outside of the host configuration folder, you must provide the full path and grant to this
file the same permissions granted to the host configuration folder.
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o See Creating the configuration and credentials folders for details on the host configuration folder path and
the required permissions.

Mandatory: In Docker deployments, when not selecting a zipped license with the zip-path parameter.

zip-path

The relative path of the ZIP license file inside the <hostConfig >folder (see the CA Gateway deployment guide for
details on this folder) .

Docker deployments support zipped license files for backward compatibility only.

Mandatory: In Docker deployments, when not selecting a signed license with the signed-path parameter.

zip-password

The password of the zipped license file.
Docker deployments support zipped license files for backward compatibility only.

Mandatory: In Docker deployments, when selecting a zipped license file with the zip-path parameter.

tenants

Under this section, add the following properties for each tenant.

® ca-id
® name
® unique-id

ca-id

The CA unique identifier in CA Gateway.

Q Map each tenant to a different managed CA. Errors will occur if you map multiple tenants to the same
managed CA.

Mandatory: Yes.

name
A friendly name for the tenant.

Mandatory: Yes.

unique-id

A unique identifier for the tenant. When configuring integrators, you will specify this identifier for mapping an
integrator to a tenant.

Mandatory: Yes.
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tual.properties
The path of the file jTinyUAL properties file.
Mandatory: When Securing settings with jTinyUAL.

logging
Under this section, define the following logging settings.

° jtk
* level.root
® ssl.jsse

jitk
Under this section, define the following JTK logging settings.
¢ debug

e level

debug

true toenable JSTK logging, false otherwise.

Required: No. This optional parameter defaults to false.

level
The level of detail for the JSTK logs.

Required: No. This optional parameter defaults to 0.

level.root

The level of detail for the root CA Gateway logger. In increasing severity.

Level Description
TRACE  Captures the most detailed information
DEBUG Provides diagnostic information, such as HTTP headers

INFO Records general operational events that confirm the system is working as expected

CA Gateway 3.7 - Docker Deployment Guide

144



@ ENTRUST

Level Description

WARN Indicates a potential issue or unexpected situation that does not stop the application but may require
attention

ERROR  Reports errors that prevent a specific operation from completing, but do not cause the entire
application to stop

FATAL  Signals a severe failure that forces the application or a major subsystem to shut down

OFF Disables all logging output

Each level sets the lowest message level to show. For example, the WARN level provides messages with
the WARN, ERROR ,and FATAL status.

Required: No. This optional parameter defaults to INFO.

ssl.jsse
Under this section, define the following JSSE (Java Secure Socket Extension) logging settings.

e debug
e level

debug
true to enable JSSE (Java Secure Socket Extension) logging, false otherwise.

Required: No. This optional parameter defaultsto false.

level
The level of detail for the JSSE logs. Supported values are:

e ss|
¢ ssl:handshake
e all

Required: No. This optional parameter defaultsto sst.

management

Under this section, configure the Spring actuator-based liveness and health check endpoints for CA Gateway.

® endpoint
* endpoints
® server
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endpoint
Under this section, define the health endpoint settings for each custom group with the <group> name.

¢ health.group.<group>.include
¢ health.group.<group>.show-components
¢ health.group.<group>.show-details

health.group.<group=>.include

The list of endpoint health parameters to monitor for the <group-name> group. Although not advised, you can
expose all endpoints using the * wildcard character. We recommend instead exposing only the following endpoints.

diskSpace, ping

@ sce the CA Gateway guide for how to access endpoints.

Mandatory: No. This optional parameter defaults to the * wildcard. Thus, we recommend selecting the minimum
required health status and metrics information.

health.group.<group>.show-components

Whether to show information on the endpoint health. Set this field to:

always

Mandatory: Yes.

health.group.<group>.show-details
Whether to show details on the endpoint health. Set this field to:

always

Mandatory: Yes.

endpoints
Under this section, define the following web settings.

* web.base-path
® web.exposure.include

web.base-path
The base path for all the endpoints.
Mandatory: Yes.
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web.exposure.include

A comma-separated list of the endpoints you want to expose. Although not advised, you can expose all endpoints
using the * wildcard character. We recommend instead exposing only the following endpoints.

health, prometheus

0 See the CA Gateway guide for how to access endpoints.

Mandatory: No. This optional parameter defaults to the * wildcard. Thus, we recommend selecting the minimum
required health status and metrics information.

server
The connection and authentication settings for the endpoints.

® port
e ss|

port
The endpoint port.

Map this port to an external port when running the CA Gateway Docker container

Mandatory: Yes.

ssl
Under this section, define the following server SSL settings.

¢ client-auth

® enabled

® key-alias

® key-store

® key-store-type

® protocol

e trust-store

® trust-store-password
® trust-store-type

client-auth

The client authentication requirement. See the following table for the supported values.

Value Authentication
Need Mandatory.
Want Wanted but not mandatory.
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Value Authentication

None Not wanted.

Mandatory: Yes.

enabled

true toenable SSL/TLS, false otherwise.

Mandatory: No. This optional parameter defaults to true .

key-alias
The alias of the SSL key in the keystore.
Mandatory: Yes.

key-store

The path of the keystore that contains the SSL server certificate.

0 See Configuring for how to reference file paths.
Mandatory : Yes.

key-store-type

The type of keystore containing the SSL server certificate.

Type Description
jks Java keystore
pkcs12 PKCS #12 keystore

Mandatory: Yes.

protocol

Set this parameter to:

TLS
Mandatory: Only when enabled is true.

trust-store

The full path of the truststore that contains the CA certificates.

© sce Configuring for how to reference file paths.
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Mandatory: Yes.

trust-store-password

The password of the truststore that contains the CA certificates.

Mandatory: Yes.

trust-store-type

The type of truststore containing the CA certificates.

Type Description
jks Java truststore
pkcs12 PKCS #12 truststore

Mandatory: Yes.

server

Under this section, define the following server settings.

* port
¢ servlet.context-path
® ss|

port

The CA Gateway port. Map this port to an external port when running the CA Gateway Docker container.

Mandatory: No. This optional parameter defaults to 8080.

servlet.context-path

The context path for CA Gateway in the endpoint URLs, preceded by a forward slash.

/<context-path>

Mandatory : No. This optional parameter defaults to:

/cagw

ssl
Under this section, define the following server SSL settings.

® ciphers
¢ client-auth
e enabled
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® insecureMode

® key-alias

® key-store

® key-store-password
* key-store-type

* protocol

e trust-store

e trust-store-password
e trust-store-type

ciphers

The list of allowed SSL ciphers - for example:

ciphers: "TLS_DHE_RSA_WITH_AES_128_GCM_SHA256,TLS_DHE_RSA_WITH_AES_256_GCM_SHA384,\
SSL_DHE_RSA_WITH_3DES_EDE_CBC_SHA,TLS_RSA_WITH_AES_128_GCM_SHA256"

Mandatory: No. Omitting this parameter allows all the ciphers CA Gateway supports.

client-auth

Set this parameter value to:

Need

Mandatory: Yes.

enabled

true toenable SSL/TLS, false otherwise.

Mandatory: No. This optional parameter defaults to true .

insecureMode

true when enabled is false ,omitthis parameter otherwise. This parameter reinforces that the user truly
wants to run CA Gateway as an insecure setup.

€ Theinsecure mode is for testing environments only.

Mandatory: No. This optional parameter defaultsto false.

key-alias
The alias of the SSL key in the keystore.
Mandatory: Yes.

key-store

The path of the keystore that contains the SSL server certificate.
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o See Configuring for how to reference file paths.

Mandatory : Yes.

key-store-password

The password of the keystore that contains the server SSL certificate.

Mandatory: Yes.

key-store-type

The type of keystore containing the SSL server certificate.

Type Description
jks Java keystore
pkcs12 PKCS #12 keystore

Mandatory: Yes.

protocol

Set this parameter to:

TLS

Mandatory: Only when enabled is true.

trust-store

The full path of the truststore that contains the CA certificates.

© see Configuring for how to reference file paths.

Mandatory: Yes.

trust-store-password

The password of the truststore that contains the CA certificates.

Mandatory: Yes.

trust-store-type

The type of truststore containing the CA certificates.
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jks Java truststore
pkcs12 PKCS #12 truststore

Mandatory: Yes.
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8 Starting up and deploying
See below to start up and deploy CA Gateway.

Configuring the Docker installation
Configuring clock synchronization
Running the CA Gateway Docker container

[ ]
[ ]
[ ]
® Stopping the execution

Configuring the Docker installation

See below how to configure the deployment environment and run CA Gateway.

® Running the CA Gateway container on multiple machines
¢ Disabling the journald logging rate limit
® Replacing the logging driver

Running the CA Gateway container on multiple machines
To run the container on another machine or multiple machines, you will want to set up a Docker registry.

1. Set up the Docker registry, as explained in https://docs.docker.com/registry
2.Pushthe entrust/cagw-api latestimage to the registry using a combination of the Docker tag and push

commands.
3. From the target machine, pull and run the image from the registry.

Disabling the journald logging rate limit

On Linux platforms, Docker will direct all logging to the system's journald service. By default, journald will apply a
rate limit on incoming logging that can cause log truncation. If this behavior is not desirable:

1. Editthe /etc/systemd/journald.conf file
2.Set RateLimitIntervalSec to 0 for disabling rate limiting

For more information, see the journald.conf(5) manual page at https://www.freedesktop.org/software/
systemd/man/journald.conf.html

Replacing the logging driver

As explained in https://docs.docker.com/config/containers/logging/configure ® Docker supports logging drivers
other than the default journald driver.

Configuring clock synchronization

Configure the Docker installation to:

¢ Synchronize clocks with the hosting OS.
e Use NTP at the host level rather than within the Docker container.

Otherwise, the clock drift between CA Gateway and the managed CAs can lead to certificate state change events not
being reported.
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The decision on synchronization depends on the deployed environment. System administrators must
observe the nodes and detect if the lack of synchronization impacts the results.

Running the CA Gateway Docker container

Use the following Docker command to run the CA Gateway container in SSL/TLS secure mode.

docker run -d -p <CAGW_HOST_PORT>:<server.port> -p
<MONITOR_HOST_PORT>:<management.server.port> -v <HOST_CONFIG>:/etc/cagw/config -h
<HOST> cagw/api:latest --cap-drop ALL

If the host system uses SELinux, append a Z to the volume mount string. For example:

docker run -d -p 8444:8080 -p 9444:9090 -v /home/myuser/cagw/config:/etc/cagw/

config:Z -h myserver cagw/api:latest --cap-drop ALL

See the following sections for a description of each option.

e ——cap-drop ALL

e d

-h <HOST>

-p <CAGW_HOST_PORT>:<server.port>

-p <MONITOR_HOST_PORT>:<management.server.port>
-v <HOST_CONFIG>:/etc/cagw/config

-e JAVA_OPTS="-Dcagw.enable.crldp.checking=true"

--cap-drop ALL

Drop all Linux capabilities from the Docker container.

-d

Launch the container in the background. Remove this option to see the CA Gateway log output while running,
although it might terminate CA Gateway when closing the terminal.

-h <HOST>

Use <HOST> when logging the active URL, where <HOST> is the hostname of the CA Gateway server. When
omitting this option, the active URL recorded in the logs displays a random hostname. For example:

Active URL: http//f719b61263fa:8444/cagw/swagger-ui/index.html

-p <CAGW_HOST_PORT>:<server.port>
Map the following ports.

® The <CAGW_HOST_PORT> user-selected port to expose CA Gateway on the host machine.
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® The <server.port> value of the server port configuration parameter in the application.yml file.

-p <MONITOR_HOST_PORT>:<management.server.port>
Map the following ports:

® The <MONITOR_HOST_PORT> user-selected port to expose the monitoring service on the host machine.
® The <management.server.port> value of the management server port configuration parameter in the

application.yml file.

See Checking the CA Gateway health for how to check the health check and monitoring service.

-v <HOST_CONFIG>:/etc/cagw/config
Map the following folders.

® The <HOST_CONFIG> configuration folder described in Creating the configuration and credentials folders.

® The /etc/cagw/config configuration folder in the Docker container.

Alternatively, you can add several -v flags to map different files and folders. For example:

-v /home/myuser/cagw/config/application.yml:/etc/cagw/config/application.yml:ro

-v /home/myuser/cagw/config/tls/cagw-tls.pl2:/etc/cagw/config/cagw-tls.pl2:ro

The ro option sets the read-only mode for the mapped file.

-e JAVA_OPTS="-Dcagw.enable.crldp.checking=true"

Enable CRL checking. This command adds the following option to the JAVA_OPTS environment variable passed to
the CA Gateway.

-Dcagw.enable.crldp.checking=true

When the revocation checking is enabled, all client certificates must include a CDP extension pointing to
an up-to-date CRL. Handshakes will not complete if the client certificate does not include a CDP extension
or the URL in this extension is unavailable.

Stopping the execution

To look up the name of the Docker container:

docker container 1s

To stop the Docker container with <CONTAINER_ID> identifier:
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docker container stop <CONTAINER_ID>
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9 Enabling CRL revocation check

When starting the CA Gateway server, you can use the -e option to enable CRL checking. See Running the CA
Gateway Docker container for details.

A\ When the revocation checking is enabled, all client certificates must include a CDP extension pointing to
an up-to-date CRL. Handshakes will not complete if the client certificate does not include a CDP extension
or the URL in this extension is unavailable.
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10 Configuring clients

To configure a client of the CA Gateway API, set the following parameters in the application.yml file.

* managed-cas.<ca>
¢ clients

* tenants

® integrators
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11 Issuing public trust certificates

CA Gateway supports issuing certificates intended to be publicly trusted. See the following sections for how to
enable this feature using filter lists.

® CA Authorization
¢ Certificate Transparency

o In the current release, only the Entrust CA described in Integrating an Entrust CA supports this feature.

CA Authorization

With the configured CAA filter, CA Gateway lookups CAA records for the domain and each parent domain. For
example, for the following domain:
www.acme.com

CA Gateway performs the following lookups:

www.acme.com
acme.com

com

CA Gateway traverses up the tree in search of CAA records. This CAA check passes if:

® Theissuerin a CAA record matches the issuer defined in the issuer-string setting of the

com.entrust.CAAuthorization filter.

* No CAA record defines an issuer or specifies "Any CA". In this case, the domain owner is not asserting a
particular issuing CA.

* No CAArecord is found. In this case, the domain owner is not asserting a particular issuing CA.

The above applies to each domain requested in the CA Gateway enrollment request. For example, domains inside
the CSR, subject to the following flag if applied.

optionalCertificateRequestDetails/useSANFromCSR

Domains are requested in the separate subjectAltNames, or in the following fields externally to the CSR.

optionalCertificateRequestDetails/extensions

CA Gateway will check CAA records for wildcard domains under RFC8659 .
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Defining Multiple DNS Servers

When defining multiple DNS servers, the DNS lookups run in parallel. The check for a domain stops when reaching
the number of positive responses defined in the dns.response-threshold configuration parameter. Thus, this

parameter provides additional assurance by forcing consultation of multiple separate DNS responders while
allowing some contingency if a DNS server fails to respond quickly.

For example, when using three DNS servers, setting dns.response-threshold to "2" ensures at least two

positive DNS checks against two distinct responders while allowing for the unavailability of one of the three
responders.

DNS Infrastructure Guidance

Before using the CAA check feature of CA Gateway, read RFC8659 with particular attention to section 5 covering
security considerations. This RFC provides rules and advice for CAA checking. Deploying the DNS infrastructure is
the responsibility of the customer.

The DNS responders referenced in the CA Gateway configuration are under the CA and CA Gateway responsibility
(not under the control of a third-party cache such as Google or CloudFlare). All records received by CA Gateway
come from authoritative nameservers. Caching of these records at the responder is allowed.

DNSSEC

As stated by RFC8659 , DNSSEC allows CA Gateway to ensure that an empty resource record (potentially containing
the domain owner's stated issuer) is legitimately empty or not empty after a record suppression. CA Gateway will
validate DNSSEC if present but still proceed if no DNSSEC applies for the domain.

o CA Gateway does not archive the DNSSEC proof for future audits.

Certificate Transparency

CA Gateway can collect a set of signed CT log server responses and ask the underlying CA if the certificates for
public trust include these responses in an SCT List extension. The certificate transparency filter:

1. Sends parallel requests to all of the configured log servers.

2. Waits for sufficient log server responses to arrive. In the filter configuration, a certificate transparency policy
states the type and the minimum of required responses.

3. Requests the final certificate to the CA.

This approach allows defining a surplus of log servers to guard against slow or offline servers.
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12 Administrating the deployment

Once deployed, you can administrate CA Gateway as explained below.

Checking the CA Gateway health
Checking the health of a CA
Managing logs

Updating the configuration

Checking the CA Gateway health

As explained in APl endpoints, CA Gateway provides the following endpoints to check the health of the CA Gateway
server.

® Health endpoint
® Disk space endpoint
® Metrics endpoint

Checking the health of a CA

As explained in API endpoints, CA Gateway provides the CA status endpoint endpoint to check the health of a
Certificate Authority.

Managing logs

On-premises CA Gateway sends all logging to the standard output captured by the Docker or Podman
infrastructure.

¢ Getting the container identifier
* Viewing logs
* Following logs
* Dumping logs
® Checking error codes
Getting the container identifier

Run the following command to get the <CONTAINER_ID> identifier of the container recording the logs

[docker|podman] ps

For example

$ docker ps
CONTAINER ID IMAGE COMMAND CREATED STATUS PORTS NAMES

f5ed108d9981 cagw/api:1.6.0 "/entrypoint.sh" 25 hours ago Up 25 hours
0.0.0.0:443-8080/tcp unruffled_curran
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Viewing logs

Run the following container to view the logs recorded by the container with the <CONTAINER_ID> identifier.

[docker|podman] logs <CONTAINER_ID>

Following logs

Run the following container to follow the logs recorded by the container with the <CONTAINER_ID> identifier.

[docker|podman] logs <CONTAINER_ID> -f

Dumping logs

Run the following container to dump into the <FILE> file the logs recorded by the container with the
<CONTAINER_ID> identifier.

[docker|podman] logs <CONTAINER_ID> > <FILE>

Checking error codes

For a description of each error code recorded in the CA Gateway logs, see the CA Gateway APl documentation at:

https://<HOST>:<CAGW_HOST_PORT>/<server.servlet.context-path>/docs

Where <HOST> and <CAGW_HOST_PORT> are the hostname and port of the CA Gateway service. CA Gateway logs
can also include the following warning message.

Version <= 1.4 profile configuration detected for CA <ca>. This configuration syntax
is deprecated. Please update.

CA Gateway records this warning message when the YAML configuration includes a deprecated profile syntax under:

cagw.authorities.managed-cas.<CA>

To avoid this message, configure the CA profiles as described in the configuration guide.

Updating the configuration

Occasionally, you may need to update the configuration files used by CA Gateway. For example, you may need to
add or edit a managed CA.

To update the configuration files for CA Gateway
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1. Stop CA Gateway, as explained in Stopping the execution.
2.In a location outside the container, make changes to the configuration files.
3. Re-mount the modified files into the container.

4. Restart CA Gateway with the Docker restart command instead of run . Otherwise, the container will no

longer decrypt the tual files. You will need to add the original unencrypted secrets again to the tual files and
remove the encrypted entries.
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13 APl endpoints

To enable endpoints in Docker deployments, you must:

1. Configure the health.group.<group>.include parameter in the application.yml file.

2. Run CA Gateway with the -p command described in Running the CA Gateway Docker container.

CA Gateway will expose the following endpoints.

Description

CA properties endpoint

CA status endpoint

Certificate actions endpoint
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Endpoint

https://{host}:
{port}/
<server.servlet.
context-path>/
vl/certificate-
authorities/
{caId}/
properties?
fields={properti
es}

https://{host}:
{port}/
{server.servlet.
context-path}/
vl/certificate-
authorities/
{caId}/status

https://{host}:
{port}/
<server.servlet.
context-path>/
vl/certificate-
authorities/
{caId}/
certificates/
{sn}/actions
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Description

Certificate events endpoint

Disk space endpoint

Documentation endpoint

Domain actions endpoint
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Endpoint

https://{host}:
{port}/
<server.servlet.
context-path>/
vl/certificate-
authorities/
{caId}/
certificate-
events

https://{host}:
{port}/
<management.endp
oints.web.base-
path>/health/

{group}/
diskSpace

https://{host}:
{port}/
{server.servlet.
context-path}/
doc

https://{host}:
{port}/
<server.servlet.
context-path>/
vl/certificate-
authorities/
{caId}/domains/
{domain}/actions
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Description Endpoint

Domains endpoint

https://{host}:
{port}/
<server.servlet.
context-path>/
vl/certificate-
authorities/
{caId}/domains

Enrollments endpoint

https://{host}:
{port}/
<server.servlet.
context-path>/
vl/certificate-
authorities/
{cald}/
enrollments

Health endpoint

https://{host}:
{port}/
{management.endp
oints.web.base-
path}/health

Metrics endpoint

https://{host}:
{port}/
{management.endp
oints.web.base-
path}/prometheus

Ping endpoint

https://{host}:

{port}/
{management.endp
oints.web.base-
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Description Endpoint

path}/health/
{group}/ping

Swagger endpoint

https://{host}:
{port}/
{server.servlet.
context-path}/
swagger-ui

Version endpoint

https://{host}:
{port}/
{server.servlet.
context-path}/v1

CA properties endpoint

The following endpoint returns property values on certificate authorities.

https://{host}:{port}/{server.servlet.context-path}/vl/certificate-authorities/
{cald}/properties?fields={properties}

See the table below for a description of each field.

Field Value
{host} The hostname or IP address of the CA Gateway host server
{port} The port of the CA Gateway service

{server.servlet.context- The value of the servlet.context-path parameter
path}

{cald} The certificate authority identifier
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Field Value

{properties} A comma-separated list of the defaultPolicyOIDs, encryptionPolicy0OIDs,

and verificationPolicy0IDs propertyidentifiers

For example, the following request checks all these properties on the Entrust Certificate Authority with
the CA3 identifier.

GET https://localhost:8444/cagw/vl/certificate-authorities/CA3/status?
fields=defaultPolicyOIDs,encryptionPolicy0IDs,verificationPolicy0IDs

The response looks like the following.

{
"type": "CAPropertiesResponse",
"CAPropertiesInformation": {
"properties": {
"defaultPolicyOIDs": [
"1.1.1.1",
"2.2.2.2"
1,
"encryptionPolicyOIDs": [
"1.1.1.1"
1,
"verificationPolicyOIDs": [
"2.2.2.2"
]
}
}
}

CA status endpoint

The following endpoint returns the UP or DOWN status of a certificate authority.

https://{host}:{port}/{server.servlet.context-path}/vl/certificate-authorities/
{cald}/status

See the table below for a description of each field.

Field Value

{host} The hostname or IP address of the CA Gateway host server
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Field Value

{port} The port of the CA Gateway service
{server.servlet.context-path} The value of the servlet.context-path parameter
{cald} The certificate authority identifier

For example, the following request checks the status of a certificate authority with the CA3 identifier.

GET https://localhost:8444/cagw/vl/certificate-authorities/CA3/status
The response looks like the following.
{

"type" : "CAStatusResponse",
"status" : "UP",

Certificate actions endpoint

The following endpoint returns the supported actions for a certificate.

https://{host}:{port}/{server.servlet.context-path}/vl/certificate-authorities/
{caId}/certificates/{sn}/actions

See the table below for a description of each field.

Field Value
{host} The hostname or IP address of the CA Gateway host server
{port} The port of the CA Gateway service

{management.endpoints.web.base-path}  The value of the management.endpoints.web.base-path parameter

{group} One of the groups listed by the Health endpoint

See below for CA-specific considerations on this endpoint.

* Revoking GlobalSign certificates with the certificate actions endpoint
* Renewing GlobalSign certificates with the certificate actions endpoint
* Renewing Sectigo CA certificates with the certificate actions endpoint
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Revoking GlobalSign certificates with the certificate actions endpoint

When using the certificate actions endpoint to revoke a certificate issued by a GlobalSign Certificate Center (GCC)

authority, the action.reason parameter is:

* Required by the CA gateway API.

¢ Ignored by the GlobalSign MSSL (Managed SSL) API, which does not support specifying a revocation reason.

Therefore, this value must be included in the requests, although it will not be evaluated. For example:

{
"action": {
"comment": "revoke'",
"succeedIfAlreadyInRequestedState": true,
"type": "RevokeAction",
"reason": "unspecified"
}
}

See below for a parameter reference.

® action.comment

¢ action.succeedIfAlreadylnRequestedState
® action.reason

® action.type

Parameter names are case sensitive.
action.comment

A descriptive text on the requested action.

Mandatory: No.

action.succeedIfAlreadylnRequestedState

The request output when the requested action has already been performed.

Value Request output
true Success (the operation is idempotent)
false Error

Mandatory: No. This optional value defaults to false.

action.reason
The certificate revocation reason. Supported values are the following.

* unspecified
¢ keyCompromise
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* affiliationChanged
® superseded
¢ cessationOfOperation

Mandatory: Yes.

action.type

The type of action requested to the endpoint.

Endpoint Value Action

CA actions RenewAction Renew a certificate

CA actions RevokeAction Permanently invalidate a certificate

CA domain ReverifyDomainA  Reverify a previously validated domain because the prior validation
actions ction expired, failed, or must be refreshed to meet CA/Browser Forum or

GlobalSign requirements.

Mandatory: Yes.

Renewing GlobalSign certificates with the certificate actions endpoint

When using the certificate actions endpoint to renew a certificate issued by a GlobalSign Certificate Center (GCC)
authority, the JSON request must include the action.properties.validityPeriod field. For example:

{
"action": {
"comment": "renew",
"properties": {
llcsrll: ll-.-ll,
"validityPeriod": "P1YOMOD"
3,
"type": "RenewAction"
}
}

See below for a parameter reference.

e action.comment

® action.properties.csr

e action.properties.validityPeriod
® action.type

Parameter names are case sensitive.

action.comment

A descriptive text on the requested action.
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Mandatory: No.

action.properties.csr

The base64 encoding of a certificate request.

Mandatory: When requesting or enewing a certificate for a client-generated key pair and CSR.

action.properties.validityPeriod

The duration for which the certificate will be valid, as an 1ISO-8601 duration. See the table below for examples.

validityPeriod

Start date Duration End date

"2018-07-06T13:00Z/

2019-07-06T13:00:00Z"

"2018-07-06T13:00Z/
P1Y3MODTOHOM"

"POY3MODTOHOM/
2018-12-31T00:00Z"

"P1Y3M10DTOHOM"

July 6,2018 at 13:00
uTC

July 6,2018 at 13:00
uTC

Automatically
calculated

Current date

Automatically
calculated
1year and 3 months

3 months

1year, 3 months, 10

July 6,2019 at 13:00
UTC

Automatically
calculated

31,2018 at 00:00 UTC

Automatically

days calculated

The selected value must comply with the GlobalSign profile maximum validity rules.

action.type

The type of action requested to the endpoint.

Endpoint

CA actions

CA actions

CA domain
actions

Mandatory: Yes.

Value

RenewAction

RevokeAction

ReverifyDomainA
ction
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Renew a certificate

Permanently invalidate a certificate

Reverify a previously validated domain because the prior validation
expired, failed, or must be refreshed to meet CA/Browser Forum or
GlobalSign requirements.
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Renewing Sectigo CA certificates with the certificate actions endpoint

When using the certificate actions endpoint to renew a certificate issued by a Sectigo CA, the JSON request must
include the action.properties.csr field. For example:

{

"action": {
"comment": "Test",
"properties": {

"csr':

"MIIC1TCCAbOCAQAWIZEhMB8GALUEAWWYbWF3aWEudGVzdC5zZWNOaWdvLnJI1bmV3MIIBIjANBgkghkiGOw0OB
AQEFAAOCAQSAMIIBCgKCAQEAtL/
hiyBuXWjhsnhIrr32Xnv9fUwrUKru4UjuNEtmgtOftfNkUMNnBmwKFZ1DxHeuatzeVYXPCXoWAfteU2g4JibAC
MJAEDMARA338Xi0VDRZW2e /V0s49wZIN9q7 f+IFVw5B3x4qCDSE7zjsohgP3/
ISvMyHkjs9h4sYw+Bn9+VBk1yA+S3IrWigbMASILod2y+MKZ6F2kdcgKl6ytFzDFVIn3TgzpIKVaQvgH696b6
+4cqZM10On+2ScuQDI+b1ZixpqrsnT9agd4It2RPtpu+IX/
DW5LVHFfGE5RPYD+GI10hi6B8iUxmewfpcGwzkxsy8F51ZAD5FKUVKk94M4+yaAwIDAQABoGOwawYJKoZIhvc
NAQkOMV4wXDAJIBgNVHRMEAjAAMASGA1UdDwQEAwWIFoDAdBgNVHSUEFjAUBggrBgEFBQcDAQYIKwYBBQUHAWIwW
IwYDVRORBBwwGOIYbWF3aWEudGVzdC5zZWNOaWdvLnI1bmV3MAOGCSqGSIb3DQEBCWUAA4IBAQAK7YbCBIrgnN
fhJIsNQbdTa68bt8UTqbPL/2PsapskPOkPugggN5dPOD5g1zRG/ t1BhsNNxjEPW+TKyX7g8j5ACHCt5r/
cSy3zKkj9Z2TICjOyt+wC1lGYqDLse7vHgb+102920GwqY/dRYq/uswuP4ZTo/
TpVIEbwhXZzWVfaAC40F809Wb8S8UCYyuv2hV+NWIgE9bTEC1sNr1XU9+5TxikRbHda2SPqR+pK2/
yfdMQ970e827 fHisvBIWKHBNnbvd3yrRVECKIOkQ1lyuuR2/
kzPdfB3DG5xkDIcNodvDznKEMHLY5bR8f+kz1lz4poYggZa2Kw617pUgB5GGP2AIWiHN/"

3,

"type": "RenewAction"

}

}

See below for a parameter reference.

® action.comment
® action.properties.csr
® action.type

Parameter names are case sensitive.

action.comment
A descriptive text on the requested action.

Mandatory: No.

action.properties.csr
The base64 encoding of a certificate request.

Mandatory: When requesting or enewing a certificate for a client-generated key pair and CSR.

action.type
The type of action requested to the endpoint.
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Endpoint Value Action

CA actions RenewAction Renew a certificate

CA actions RevokeAction Permanently invalidate a certificate

CA domain ReverifyDomainA  Reverify a previously validated domain because the prior validation
actions ction expired, failed, or must be refreshed to meet CA/Browser Forum or

GlobalSign requirements.

Certificate events endpoint

The following endpoint returns a list of events in the certificates issued by a certificate authority.

https://{host}:{port}/{server.servlet.context-path}/vl/certificate-authorities/
{caId}/certificate-events

See the table below for a description of each field.

Field Value

{host} The hostname or IP address of the CA Gateway host server
{port} The port of the CA Gateway service
{server.servlet.context-path} The value of the servlet.context-path parameter

{group} One of the groups listed by the Health endpoint

This endpoint returns the following values.

* events
¢ nextPagelndex
¢ hasMore

events

Alist of events on the issued certificates. For example, certificate revocation.

© The endpoint retrieves 0 events for days without events.

nextPagelndex

An index to track which day and which event should be collected next.
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¢ This index depends on the value assigned to the default-query-page-size configuration parameter.
¢ After the first query to the endpoint, all subsequent queries must include this index.

hasMore

Aflagindicating if the endpoint has more results to return.

Value Description
true The endpoint can return more events from the last nextPageIndex till today
false All events have been collected, so the caller can stop invoking the endpoint

Disk space endpoint
The following endpoint returns the disk space of the CA Gateway server for a group.
To enable this endpoint, you must configure the management.endpoints.web.exposure.include

parameter.

https://{host}:{port}/{management.endpoints.web.base-path}/health/{group}/diskSpace

See the table below for a description of each field.

Field Value
{host} The hostname or IP address of the CA Gateway host server
{port} The port of the CA Gateway service

{management.endpoints.web.base-path} = The value of the management.endpoints.web.base-path parameter
{group} One of the groups listed by the Health endpoint

For example, to check the disk space for the custom group.

https://localhost:9444/cagw/management/actuator/health/custom/diskSpace

If the server is up, this endpoint will return a response like the following.

{"status":"UP","details":
{"total":1013309239296,"free'":765931622400,"threshold":10485760,"exists":true}}
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Documentation endpoint

The following endpoint provides documentation on using the CA Gateway API for certificate policy, certificate
issuance, and certificate lifecycle management.

https://{host}:{port}/{server.servlet.context-path}/doc

See the table below for a description of each field.

Field Value

{host} The hostname or IP address of the CA Gateway host server
{port} The port of the CA Gateway service
{server.servlet.context-path} The value of the servlet.context-path parameter

Domain actions endpoint

The following endpoint supports domain-related actions.

https://{host}:{port}/{server.servlet.context-path}/vl/certificate-authorities/
{cald}/domains/{domain}/actions

See the table below for a description of each field.

Field Value

{host} The hostname or IP address of the CA Gateway host server
{port} The port of the CA Gateway service
{server.servlet.context-path} The value of the servlet.context-path parameter

{cald} The certificate authority identifier

{domain} The domain identifier

See below for CA-specific considerations on this endpoint.

* Verifying a GlobalSign domain with the domain actions endpoint
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Verifying a GlobalSign domain with the domain actions endpoint

To check if a GlobalSign profile supports the domains endpoint, navigate to the profile information under Managed

SSL.

Order Add New Manage Other
Certificate Domain Domains Actions

When displayed, the EV - Available message indicates that the profile supports requests to add a domain - for

example:
{
"name": "mydomain.com"
}

The request to the domain actions endpoint must contain the following parameters.

® action.type
¢ action.verificationMethod
® action.properties.taglLocation

For example:

{
"action": {
"properties": {
"taglocation": "store.example.com,example.com"

1,
"type": "ReverifyDomainAction",
"verificationMethod": "dns"

action.type

The identifier of the domain action. See below for the values supported by this parameter.
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Value Action

ReverifyDomain  Verify a previously validated domain because the prior validation expired, failed, or must be

Action refreshed to meet CA/Browser Forum or GCC requirements.

action.verificationMethod

The identifier of the domain verification method. See below for the values supported by this parameter.

Value Verification

dns DNS-based domain verification, GCC requires a unique Domain Validation Code (DVC) in a DNS TXT

record to confirm domain control.

webSe  HTTP-based verification, also called file-based domain verification. GCC requires a Domain Validation

rver Code (DVC) on the web server to confirm domain control.

action.properties.taglLocation

The location of the domain validation control number.

© When providing multiple values, separate them with commas.
See below for sample values when verificationMethod is dns.

Value

a.b.c.example.com,b.c.example.com,c.example.com,example.com

store.example.com,example.com

example.com

See below for sample values when verificationMethod is webServer .
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a.b.c.example.com

store.example.com

example.com
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Value Requested domains

https://example.com/.well-known/pki-validation/gsdv.txt *.example.com
example.com

https://example.com/.well-known/pki-validation/ *.sub.example

gsdv.txt,https://sub.example.com/.well-known/pki-validation/ .com

gsdv.txt sub.example.c
om

https://example.com/.well-known/pki-validation/ * . www.example

gsdv.txt,https://www.example.com/.well-known/pki-validation/ .com

gsdv.txt sub.example.c
om

Domains endpoint

The following endpoint supports adding domains for EV (Extended Validation) profiles.

https://{host}:{port}/{server.servlet.context-path}/vl/certificate-authorities/
{caId}/domains

See the table below for a description of each field.

Field Value

{host} The hostname or IP address of the CA Gateway host server
{port} The port of the CA Gateway service
{server.servlet.context-path} The value of the servlet.context-path parameter

{cald} The certificate authority identifier

Enrollments endpoint

The following endpoint allows enrolling and renewing certificates.
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https://{host}:{port}/{server.servlet.context-path}/vl/certificate-authorities/
{caId}/enrollments

See the table below for a description of each field.

Field Value

{host} The hostname or IP address of the CA Gateway host server
{port} The port of the CA Gateway service
{server.servlet.context-path} The value of the servlet.context-path parameter

{cald} The certificate authority identifier

See below for CA-specific considerations on this endpoint.

* Renewing GlobalSign certificates with the enrollments endpoint
® Renewing Sectigo CA certificates with the enrollments endpoint
® Requesting GlobalSign certificates with the enrollments endpoint

Renewing GlobalSign certificates with the enrollments endpoint

When using the enrollments endpoint to renew a certificate from a GlobalSign CA, the request body must contain
one of the following parameters.

® properties.renewalOrderID
® properties.renewalOrderld
® properties.renewalSerialNumber

For example:

llcsrll: Il...ll’

"includeCa": false,

"optionalCertificateRequestDetails": {
"subjectDn": "cn=grapefruitdesk.com,o=Test Company,c=CA",
"useSANFromCSR": false,
"validityPeriod": "P1YOMOD"

s

"profileId": "profileA",

"renewal": true,

"requiredFormat": {

"format": "pem"
}s
"properties": {

"renewalOrderID": "mssl-order-id"
}

}
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See below for a parameter reference.

® csr

¢ includeCa

¢ optionalCertificateRequestDetails.subjectDn

¢ optionalCertificateRequestDetails.useSANFromCSR
¢ optionalCertificateRequestDetails.validityPeriod
e profileld

® properties.renewalOrderID

® properties.renewalOrderld

® properties.renewalSerialNumber

® properties.speciallnstructions

* renewal

¢ requiredFormat.format

Parameter names are case sensitive.

Csr
The base64 encoding of a certificate request.

Mandatory: When requesting or enewing a certificate for a client-generated key pair and CSR.

includeCa
true to return the certificate and the issuing CA chain; false to return only the end-entity certificate.

Mandatory: No. This optional value defaultsto false.

optionalCertificateRequestDetails.subjectDn

A Distinguished Name string used to override or supplement the DN from the CSR.

o Some GlobalSign issuance modes allow subject override; others require the subject to match the CSR.

Mandatory: No.

optionalCertificateRequestDetails.useSANFromCSR
A boolean controlling whether the CA should pull Subject Alternative Names (SANs) directly from the CSR.

Value Action
true Copy SANs from CSR.

false SANs will not be taken from the CSR (they must come from other profile rules or request attributes).

Mandatory: No. This optional value defaults to false.
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optionalCertificateRequestDetails.validityPeriod

The duration for which the certificate will be valid, as an 1ISO-8601 duration. See the table below for examples.

validityPeriod Start date Duration End date
"2018-07-06T13:00Z/ July 6,2018 at 13:00 Automatically July 6,2019 at 13:00
2019-07-06T13:00:00Z" uTC calculated uTC
"2018-07-06T13:00Z/ July 6,2018 at 13:00 1year and 3 months Automatically
P1Y3MODTOHOM" UuTC calculated
"POY3MODTOHOM/ Automatically 3 months 31,2018 at 00:00 UTC
2018-12-31T00:00Z" calculated
"P1Y3M10DTOHOM" Current date 1year, 3 months, 10 Automatically

days calculated

The selected value must comply with the GlobalSign profile maximum validity rules.

Mandatory: No. This optional value defaults to the profile validity period.

profileld

The identifier of the certificate profile to issue or renew the certificate. To request a PKCS #12 containing a
certificate and key pair generated by a GlobalSign CA, this value must identify a profile with one of the following
product codes.

Product code Certificate type
PV_INTRA_SKIP IntranetSSL using AutoCSR signed with SHA1
PV_INTRA_SKIP_SHA2 IntranetSSL using AutoCSR signed with SHA-256

To request a certificate for a client-generated key pair and CSR, this value must identify a profile with any other
product codes.

Mandatory: Yes.

properties.renewalOrderID

The existing GlobalSign order identifier of the certificate renewed certificate - for example: "mssl-order-id

0 This parameter name differs from properties.renewalOrderID only by the uppercase "D".

Mandatory: certificate renewal requires using one of the following fields.

¢ properties.renewalOrderID
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® properties.renewalOrderld
® properties.renewalSerialNumber

properties.renewalOrderld

The existing GlobalSign order identifier of the certificate renewed certificate - for example: "mssl-order-id".

0 This parameter name differs from properties.renewalOrderID only by the lowercase "d".

Mandatory: certificate renewal requires using one of the following fields.

¢ properties.renewalOrderID
¢ properties.renewalOrderld
¢ properties.renewalSerialNumber

properties.renewalSerialNumber
The serial number of the renewed certificate.
Mandatory: certificate renewal requires using one of the following fields.

e properties.renewalOrderID
® properties.renewalOrderld
® properties.renewalSerialNumber

properties.speciallnstructions
Free-text field for internal notes about the order - for example: “contact ops before issuing”.

Mandatory: No.

renewal
true to request the renewal of an existing certificate; false torequestacompletely new certificate.

Mandatory: No. This optional value defaults to false.

requiredFormat.format

The certificate output format.

Value Format
pem Base64-encoded certificate
der Binary DER

pkcsl2  PKCS #12 containing a certificate and key pair generated by the CA (if supported by the selected
profile).
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Mandatory: Yes.

Renewing Sectigo CA certificates with the enrollments endpoint

When using the enrollments endpoint to renew a certificate issued by a Sectigo CA, the JSON request must include
the properties.renewalSerialNumber setting. For example:

"csr':
"MIIC2zCCAcMCAQAwWIjEKMCIGALUEAwWwWbbWF3aWEudGVzdC5zZWNOaWdvLnJI1lbmV3LjA2MIIBIjANBgkghkiG
9wOBAQEFAAOCAQ8AMIIBCgKCAQEA6xeRXTqPSvmTVCtLi17pvGH2d5zQP2uiU5CR1r70fGjIVumktroMUf4DW
mAgaaumkmjnOxRMSew4viE99NONP7XfciJLBRKgjBBnwrOfLCCiGRVKLr3PiTQ/
N9J60gt8KkVYZ94Z1HmiGtXye6cZHX2ibngfcW//
tN5ewUrzQTfLYyIAiwOOqRPkt1OM4xFrRtFv2dO7bfer PS75VCjYdfUaerHf8aOmllFWzmeciYazkGM2/
Uds+rel+0eVT8gzBqAqvgxCRXf20n67acXV1ix2gStaa+tuImk46EacLtL+b/
DHX1igoNSqruchMUdHQfqnd8DtVVCjPy2nTBrHmBv18wIDAQABoHAwWbgYJIKoZIhvcNAQKOMWEWXzAJBgNVHRME
AjAAMAsSGA1UdDWQEAwWIFoDAdBgNVHSUEFjAUBggrBgEFBQcDAQYIKwYBBQUHAWIwWIgYDVRORBB8WHYIbbWF3a
WEudGVzdC5zZWNOaWdvLnI1lbmV3LjA2MAOGCSqGSIb3DQEBCWUAA4IBAQCdKzAHBavqRIDZzVuUlVSjoObI/
VjgOcF982p6/1PnFKf1+13fxsTUNOO3kG/uuh4Zdxo/0O0VMH6EVSi+T4I06Gu0/
7LoMgT7oAxgN1FaBjK5VwINAUro2uS54FGz+2ubYS8F+cTQXffMOuerNgVIXGFKaaHtrcoDynfp9PgyJg+I4zB
aPR/5E051Am2t5K+wQHtsO+ThoInnK5iwslE+SUnzCZwGwk f50Uf450/
pyjKnUKsjXpdfPSoTrkVEFTniNkM+FzFwjjhECp536EzWLlLsX/C3d/
QGTndH4c4GN9qFGaybDmWZHHIHabj52/CeORImkrIOREQi1ROFSGW8Zb66DZ9" ,

"renewal": true,

"properties": {

"RenewalSerialNumber": "4c56db9f8f07afle93c66a37e041lef8e"

1,

"profileId": "profileA-local",

"requiredFormat": {

"format": "PEM"

}

}

See below for a parameter reference.

® csr

profileld

® properties.renewalSerialNumber
* renewal

¢ requiredFormat.format

Parameter names are case sensitive.

Csr
The base64 encoding of a certificate request.

Mandatory: When requesting or enewing a certificate for a client-generated key pair and CSR.
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profileld
The identifier of the certificate profile to use to issue or renew the certificate.

Mandatory: Yes.

properties.renewalSerialNumber
The serial number of the renewed certificate.

Mandatory: Yes.

renewal
true to request the renewal of an existing certificate; false torequestacompletely new certificate.

Mandatory: No. This optional value defaultsto false.

requiredFormat.format

The certificate output format.

Value  Format
pem Base64-encoded certificate
der Binary DER

pkcsl2  PKCS #12 containing a certificate and key pair generated by the CA (if supported by the selected
profile).

Mandatory: Yes.

Requesting GlobalSign certificates with the enrollments endpoint

When using the enrollments endpoint to request a certificate from a GlobalSign CA, the profileId parameter
must identify a GlobalSign MSSL (Managed SSL) profile. For example:

"esr': ML,

"includeCa": false,

"optionalCertificateRequestDetails": {
"subjectDn": "cn=grapefruitdesk.com,o=Test Company,c=CA",
"useSANFromCSR": false,
"validityPeriod": "P1YOMOD"

}s

"profileId": "profileA",

"renewal": false,

"requiredFormat": {
"format": "pem"
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}
}

See below for a parameter reference.

® csr

® includeCa

¢ optionalCertificateRequestDetails.subjectDn

¢ optionalCertificateRequestDetails.useSANFromCSR
¢ optionalCertificateRequestDetails.validityPeriod

e profileld

® properties.speciallnstructions

* renewal

¢ requiredFormat.format

Parameter names are case sensitive.

Csr
The base64 encoding of a certificate request.

Mandatory: When requesting or enewing a certificate for a client-generated key pair and CSR.

includeCa
true to return the certificate and the issuing CA chain; false to return only the end-entity certificate.

Mandatory: No. This optional value defaults to false.

optionalCertificateRequestDetails.subjectDn

A Distinguished Name string used to override or supplement the DN from the CSR.

o Some GlobalSign issuance modes allow subject override; others require the subject to match the CSR.

Mandatory: No.

optionalCertificateRequestDetails.useSANFromCSR
A boolean controlling whether the CA should pull Subject Alternative Names (SANs) directly from the CSR.

Value Action
true Copy SANs from CSR.

false SANs will not be taken from the CSR (they must come from other profile rules or request attributes).

Mandatory: No. This optional value defaults to false.
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optionalCertificateRequestDetails.validityPeriod

The duration for which the certificate will be valid, as an 1ISO-8601 duration. See the table below for examples.

validityPeriod Start date Duration End date
"2018-07-06T13:00Z/ July 6,2018 at 13:00 Automatically July 6,2019 at 13:00
2019-07-06T13:00:00Z" uTC calculated uTC
"2018-07-06T13:00Z/ July 6,2018 at 13:00 1year and 3 months Automatically
P1Y3MODTOHOM" UuTC calculated
"POY3MODTOHOM/ Automatically 3 months 31,2018 at 00:00 UTC
2018-12-31T00:00Z" calculated
"P1Y3M10DTOHOM" Current date 1year, 3 months, 10 Automatically

days calculated

The selected value must comply with the GlobalSign profile maximum validity rules.

Mandatory: No. This optional value defaults to the profile validity period.

profileld

The identifier of the certificate profile to issue or renew the certificate. To request a PKCS #12 containing a
certificate and key pair generated by a GlobalSign CA, this value must identify a profile with one of the following
product codes.

Product code Certificate type
PV_INTRA_SKIP IntranetSSL using AutoCSR signed with SHA1
PV_INTRA_SKIP_SHA2 IntranetSSL using AutoCSR signed with SHA-256

To request a certificate for a client-generated key pair and CSR, this value must identify a profile with any other
product codes.

Mandatory: Yes.

properties.speciallnstructions
Free-text field for internal notes about the order - for example: “contact ops before issuing”.

Mandatory: No.

renewal

true torequest the renewal of an existing certificate; false torequestacompletely new certificate.
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Mandatory: No. This optional value defaults to false.

requiredFormat.format

The certificate output format.

Value Format
pem Base64-encoded certificate
der Binary DER

pkcsl2  PKCS #12 containing a certificate and key pair generated by the CA (if supported by the selected
profile).

Mandatory: Yes.

Health endpoint
The following endpoint returns information on the CA Gateway server health.
To enable this endpoint, you must configure the management.endpoints.web.exposure.include

parameter.

https://{host}:{port}/{management.endpoints.web.base-path}/health

See the table below for a description of each field.

Field Value
{host} The hostname or IP address of the CA Gateway host server
{port} The port of the CA Gateway service

{management.endpoints.web.base-path}  The value of the management.endpoints.web.base-path parameter

For example:

{"status":"UP","groups":["custom"]}

See below for a description of each value.

e status
® groups
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status
The ping status of the CA Gateway server.

groups

The list of user groups defined under the endpoint parameter.
Metrics endpoint
The following endpoint returns CA Gateway metrics in Prometheus-compliant format.
To enable this endpoint, you must configure the management.endpoints.web.exposure.include

parameter.

https://{host}:{port}/{management.endpoints.web.base-path}/prometheus

See the table below for a description of each field.

Field Value
{host} The hostname or IP address of the CA Gateway host server
{port} The port of the CA Gateway service

{management.endpoints.web.base-path}  The value of the management.endpoints.web.base-path parameter

For example:

# HELP jvm_threads_1live_threads The current number of live threads including both
daemon and non-daemon threads

# TYPE jvm_threads_1live_threads gauge

jvm_threads_1live_threads 51.0

# HELP spring_security_filterchains_AnonymousAuthenticationFilter_before_total

# TYPE spring_security_filterchains_AnonymousAuthenticationFilter_before_total
counter
spring_security_filterchains_AnonymousAuthenticationFilter_before_total{security_secu
rity_reached_filter_section="before",spring_security_filterchain_position="0",spring_
security_filterchain_size="0",} 8.0

# HELP jvm_gc_live_data_size_bytes Size of long-lived heap memory pool after
reclamation

# TYPE jvm_gc_live_data_size_bytes gauge

jvm_gc_live_data_size_bytes 8.7626752E7

# HELP executor_completed_tasks_total The approximate total number of tasks that have
completed execution

# TYPE executor_completed_tasks_total counter
executor_completed_tasks_total{name="applicationTaskExecutor",} 0.0
executor_completed_tasks_total{name="taskScheduler",} 2.0
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# HELP system_cpu_count The number of processors available to the Java virtual
machine

# TYPE system_cpu_count gauge

system_cpu_count 8.0

Ping endpoint
The following endpoint returns the ping status of the CA Gateway server for a group.
To enable this endpoint, you must configure the management.endpoints.web.exposure.include

parameter.

https://{host}:{port}/{management.endpoints.web.base-path}/health/{group}/ping

See the table below for a description of each field.

Field Value
{host} The hostname or IP address of the CA Gateway host server
{port} The port of the CA Gateway service

{management.endpoints.web.base-path}  The value of the management.endpoints.web.base-path parameter
{group} One of the groups listed by the Health endpoint

For example, to check the ping status for the custom group.

https://localhost:9444/cagw/management/actuator/health/custom/ping

If the server is up, this endpoint will return the following response.

{"status":"UP"}

Swagger endpoint

The following endpoint provides a Swagger Ul to visualize and interact with the CA Gateway REST API.

https://{host}:{port}/{server.servlet.context-path}/swagger-ui

See the table below for a description of each field.
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Field Value

{host} The hostname or IP address of the CA Gateway host server
{port} The port of the CA Gateway service
{server.servlet.context-path} The value of the servlet.context-path parameter

Q CA Gateway includes this Ul to assist developers with APl integrations, but it is not for, nor will it be
supported for, production use. It is not a substitute for an administrator Ul. We recommend using Entrust
Certificate Hub or an equivalent interface provided by another product.

To test CA Gateway with Swagger

1.Inthe application.yml file, configure a tenant, or an integrator.

2. Install the tenant or integrator credential in the browser.
3. Make sure that the certification chain of the CA Gateway TLS certificate is trusted.
4. Navigate to the URL of the Swagger Ul. For example:

https://localhost:8444/cagw/swagger-ui
5. When prompted by the browser, select the tenant or integrator credential.

6. Use the Swagger options to generate curl commands. For example, the following command lists the CAs
visible to the tenant or integrator.

curl --cert-type P12 --cert tentant.pl2:mypassword -X GET "https://cicd-

cagw.dev.entrust.local/cagw/vl/certificate-authorities" -H "accept:
application/json"

€ When running curl commands, some Linux versions do not support authenticating with a P12 file.

Version endpoint

The following endpoint returns version information on CA Gateway.

https://{host}:{port}/{server.servlet.context-path}/vl

See the table below for a description of each field.

Field Value

{host} The hostname or IP address of the CA Gateway host server
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Field Value
{port} The port of the CA Gateway service
{server.servlet.context-path} The value of the servlet.context-path parameter

© This endpoint is the main entry point for invoking API capabilities.
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14 CA Capabilities reference

The "Get CA Capabilities" endpoint of the CA Gateway API informs on the capabilities supported by each type of CA.

The following sections give a complete reference of the returned values.

* Digicert CA capabilities

EJBCA capabilities
Entrust CA capabilities
GlobalSign capabilities
Microsoft CA capabilities
Sectigo CA capabilities

Digicert CA capabilities

See below for the capabilities supported by Digicert Certificate Authorities.

certificates

status

general

enrollments

enrollments

ca-properties

certificate-events

See below for the enrollment-supported capabilities

Name

EnrollmentByCS
R

X509CertificateR
esponse

PKCS12Respons
e

SANINCSR

SANInRequest

SubjectNamelnR
equest

Description

Process certificate signing requests

Returns certificate in X509 form

Return certificate and key in PKCS#12 form

Process Subject Alternative Names (SANs) in
CSR

Process Subject Alternative Names (SANs) in
enrollment request

Supply subject name parameters in request to
construct a subject DN in the supplied order
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/v1/certificate-authorities/
{cald}/enrollments

/v1/certificate-authorities/
{cald}/enrollments

/v1/certificate-authorities/
{cald}/enrollments

/v1/certificate-authorities/
{cald}/enrollments

/v1/certificate-authorities/
{cald}/enrollments

/v1/certificate-authorities/
{cald}/enrollments

Suppor
ted
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Name

CAGeneratedKey

KeylnRequest

CAGeneratedKey
Backup

ClientGenerated
KeyBackup

ExtensionInCSR

ExtensioninRequ
est

ValidateProofOf
Possesion

ValidityPeriodIn
Request

certificates

Description

Generate the key and returned it to client in
PKCS#12 form

Supports client-generated keys for enrollment

in the enrollment request

Supports key backup for CA generated keys

Supports key backup for client-generated keys

Process extension request in CSR

Process extension request in enrollment

request

Validates proof of possession if requested

Supports validity period in request

See below for the certificate-supported capabilities

Name

SearchBySerial

CertificateActio
n

CertificateRevo
cationReason

Description Endpoint

Endpoint

/v1/certificate-authorities/
{cald}/enrollments

/v1/certificate-authorities/
{cald}/enrollments

/v1/certificate-authorities/
{cald}/enrollments

/v1/certificate-authorities/
{cald}/enrollments

/v1/certificate-authorities/
{cald}/enrollments

/v1/certificate-authorities/
{cald}/enrollments

/v1/certificate-authorities/
{cald}/enrollments

/v1/certificate-authorities/
{cald}/enrollments

Lookup certificate by serial
number

List supported actions on a
certificate

List supported revocation reasons
for the certificate RevokeAction
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certificate-events

See below for the certificate-event-supported capabilities

Name Description Endpoint Supported

CertificateEvents Support certificate events /v1/certificate-authorities/{cald}/ (V]
certificate-events

MaxCertificateEve Return the maximum size of the /v1/certificate-authorities/{cald}/ (V]
ntsPageSize certificate events Page certificate-events
status

See below for the status-supported capabilities

Name Description Endpoint Supported
CAStatus ~ Check whether the CAis up or down /v1/certificate-authorities/{cald}/status (x]

ca-properties

See below for the CA property-supported capabilities

Name Description Endpoint Supported

CAPropertiesRetrieval  Retrieve CA properties  /vl/certificate-authorities/{cald}/properties (]

general

See below for the general capabilities

Name Description Endpoint Supported

PermitsDefaultCA Can operate as the default CA o

SupportsMultipleCAs Supports multiple CA configurations o
EJBCA capabilities

See below for the capabilities supported by EJB Certificate Authorities (EJBCAs).

¢ enrollments
e certificates
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ca-events
recoveries
subjects
status

enrollments

ca-properties

certificate-events

See below for the enrollment-supported capabilities

Name

EnrollmentByCS
R

X509CertificateR
esponse

PKCS12Respons
e

SANInCSR

SANInRequest

SubjectNamelnR
equest

CAGeneratedKey

KeylnRequest

CAGeneratedKey
Backup

ClientGenerated
KeyBackup

Description

Process certificate signing requests

Returns certificate in X509 form

Return certificate and key in PKCS#12 form

Process Subject Alternative Names (SANSs) in
CSR

Process Subject Alternative Names (SANs) in
enrollment request

Supply subject name parameters in request to
construct a subject DN in the supplied order

Generate the key and returned it to client in
PKCS#12 form

Supports client-generated keys for enrollment
in the enrollment request

Supports key backup for CA generated keys

Supports key backup for client-generated keys
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/v1/certificate-authorities/
{cald}/enrollments

/v1/certificate-authorities/
{cald}/enrollments

/v1/certificate-authorities/
{cald}/enrollments

/v1/certificate-authorities/
{cald}/enrollments

/v1/certificate-authorities/
{cald}/enrollments

/v1/certificate-authorities/
{cald}/enrollments

/v1/certificate-authorities/
{cald}/enrollments

/v1/certificate-authorities/
{cald}/enrollments
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Name Description Endpoint Suppor
ted
ExtensionInCSR Process extension request in CSR /v1/certificate-authorities/ o

{cald}/enrollments

ExtensionInRequ  Process extension request in enrollment /v1/certificate-authorities/ (]
est request {cald}/enrollments
ValidateProofOf  Validates proof of possession if requested /v1/certificate-authorities/ o
Possesion {cald}/enrollments
ValidityPeriodIn  Supports validity period in request /v1/certificate-authorities/ o
Request {cald}/enrollments

certificates

See below for the certificate-supported capabilities

Name Description Endpoint Supporte
d

SearchBySerial  Lookup certificate by serial /v1/certificate-authorities/{cald}/ o

number certificates/{serial}

CertificateActio  List supported actionson a /vl/certificate-authorities/{cald}/ o

n certificate certificates/{serial}/actions

CertificateRevo  List supported revocation reasons  /v1/certificate-authorities/{cald}/ o

cationReason for the certificate RevokeAction certificates/{serial}/actions

certificate-events

See below for the certificate-event-supported capabilities

Name Description Endpoint Supported

CertificateEvents Support certificate events /v1/certificate-authorities/{cald}/ (V]
certificate-events

MaxCertificateEve Return the maximum size of the /v1/certificate-authorities/{cald}/ (V]
ntsPageSize certificate events Page certificate-events
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ca-events

See below for the event-supported capabilities

Name Description Endpoint Supported
CAEvents Support CA events /v1/certificate-authorities/{cald}/ca-events (]
recoveries
See below for the recovery-supported capabilities
Name Description Endpoint Supported
Recover Recover certificate by DN /v1/certificate-authorities/{cald}/recoveries/{dn} (V]
subjects
See below for the subject management-supported capabilities
Name Description Endpoint Supported
SearchBySubject =~ Lookup certificates by subject /v1/certificate-authorities/{cald}/subjects/ @
DN DN {dn}
SubjectDNAction  List supported actions on a /v1/certificate-authorities/{cald}/subjects/ @
subject DN {dn}/actions
status

See below for the status-supported capabilities

Name Description

CAStatus  Check whether the CAis up or down

ca-properties
See below for the CA property-supported capabilities

CA Gateway 3.7 - Docker Deployment Guide

Endpoint Supported

/v1/certificate-authorities/{cald}/status o

198



@ ENTRUST

Name

Description Endpoint

CAPropertiesRetrieval Retrieve CA properties  /vl/certificate-authorities/{cald}/properties

Entrust CA capabilities

See below for the capabilities supported by Entrust Certificate Authorities.

certificates

subjects
domains
status

enrollments

enrollments

ca-properties

certificate-events

See below for the enrollment-supported capabilities

Name

EnrollmentByCS
R

X509CertificateR
esponse

PKCS12Respons
e

SANINCSR

SANInRequest

SubjectNamelnR

equest

CAGeneratedKey

Description

Process certificate signing requests

Returns certificate in X509 form

Return certificate and key in PKCS#12 form

Process Subject Alternative Names (SANs) in
CSR

Process Subject Alternative Names (SANs) in
enrollment request

Supply subject name parameters in request to
construct a subject DN in the supplied order

Generate the key and returned it to clientin
PKCS#12 form
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Endpoint

/v1/certificate-authorities/
{cald}/enrollments

/v1/certificate-authorities/
{cald}/enrollments

/v1/certificate-authorities/
{cald}/enrollments

/v1/certificate-authorities/
{cald}/enrollments

/v1/certificate-authorities/
{cald}/enrollments

/v1/certificate-authorities/
{cald}/enrollments

/v1/certificate-authorities/
{cald}/enrollments

Supported

Suppor
ted
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Name

KeylnRequest

CAGeneratedKey
Backup

ClientGenerated
KeyBackup

ExtensionInCSR

ExtensionlnRequ
est

ValidateProofOf
Possesion

ValidityPeriodIn
Request

certificates

Description

Supports client-generated keys for enrollment

in the enrollment request

Supports key backup for CA generated keys

Supports key backup for client-generated keys

Process extension request in CSR

Process extension request in enrollment

request

Validates proof of possession if requested

Supports validity period in request

See below for the certificate-supported capabilities

Name

SearchBySerial

CertificateActio
n

CertificateRevo
cationReason

Description

Lookup certificate by serial
number

List supported actionson a
certificate

List supported revocation reasons
for the certificate RevokeAction

certificate-events

See below for the certificate-event-supported capabilities
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Endpoint

Endpoint

/v1/certificate-authorities/
{cald}/enrollments

/v1/certificate-authorities/
{cald}/enrollments

/v1/certificate-authorities/
{cald}/enrollments

/v1/certificate-authorities/
{cald}/enrollments

/v1/certificate-authorities/
{cald}/enrollments

/v1/certificate-authorities/
{cald}/enrollments

/v1/certificate-authorities/
{cald}/enrollments

/v1/certificate-authorities/{cald}/
certificates/{serial}

/v1/certificate-authorities/{cald}/
certificates/{serial}/actions

/v1/certificate-authorities/{cald}/
certificates/{serial}/actions

Suppor
ted

Supporte
d

o
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Name Description Endpoint Supported
CertificateEvents Support certificate events /v1/certificate-authorities/{cald}/ (V]
certificate-events

MaxCertificateEve Return the maximum size of the /v1/certificate-authorities/{cald}/ (V]
ntsPageSize certificate events Page certificate-events

subjects

See below for the subject management-supported capabilities
Name Description Endpoint Supported

SearchBySubject =~ Lookup certificates by subject /v1/certificate-authorities/{cald}/subjects/ @

DN DN {dn}
SubjectDNAction  List supported actions on a /v1/certificate-authorities/{cald}/subjects/ @
subject DN {dn}/actions
domains

See below for the domain-supported capabilities

Name Description Endpoint
Verification  List of supported /v1/certificate-authorities/
Method verification methods {cald}/domains/{domain}

Verification =~ Supported verification = /v1/certificate-authorities/

Status statuses {cald}/domains/{domain}
Filter Supported filters for /v1/certificate-authorities/
domain search {cald}/domains
status

See below for the status-supported capabilities

CA Gateway 3.7 - Docker Deployment Guide

Supported

dns, email, manual, unknown,
webServer

APPROVED, CANCELLED, DECLINED,
EXPIRED, EXPIRING,
INITIAL_VERIFICATION

domainName, evEligible, evExpiry,
ovEligible, ovExpiry,
verificationMethod, verificationStatus
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Name Description Endpoint

CAStatus  Check whether the CAis up or down /v1/certificate-authorities/{cald}/status

ca-properties

See below for the CA property-supported capabilities

Name Description Endpoint

CAPropertiesRetrieval Retrieve CA properties  /vl/certificate-authorities/{cald}/properties

GlobalSign capabilities

See below for the capabilities supported by EJB Certificate Authorities (EJBCAs).

¢ enrollments

e certificates

e certificate-events
e domains

[ ]
[ ]

ca-properties

enrollments

See below for the enrollment-supported capabilities.

Name Description Endpoint
EnrollmentBy  Indicates that the CA supports certificate signing /vl/certificate-
CSR requests. authorities/{cald}/
enrollments
X509Certificat ~ Certificate can be returned in X509 form. /v1/certificate-
eResponse authorities/{cald}/
enrollments

PKCS12Respo  Certificate (and key) can be returned in PKCS#12 form. /v1/certificate-

nse authorities/{cald}/
enrollments

SANInCSR Subject alternative names in CSR are processed. /v1/certificate-
authorities/{cald}/
enrollments

CA Gateway 3.7 - Docker Deployment Guide
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Name

SANInRequest

SubjectNamel
nRequest

CAGenerated
Key

KeylnRequest

CAGenerated
KeyBackup

ClientGenerat
edKeyBackup

ExtensionInCS
R

ExtensionInRe
quest

ValidateProof
OfPossesion

ValidityPeriod
InRequest

Description

Subject alternative names in enrollment request are
processed.

Supply subject name parameters in request to construct
a subject DNin the supplied order. This applies to
requests with CSR.

Key can be generated by the CA and returned to
client(P12).Individual profiles may prevent keys from
being generated by the CA.

Client can send a key to be used for the enrollment in

the enrollment request.

Key backup can be requested if the CA generated the
key.

Key backup can be requested if the client supplies the
key during the request.

Extension request in the CSR will be processed.

Extension request in enrollment request will be

processed.

Validate proof of procession if requested.

A validity period can be supplied in the request

CA Gateway 3.7 - Docker Deployment Guide

Endpoint

/v1/certificate-
authorities/{cald}/
enrollments

/v1/certificate-
authorities/{cald}/
enrollments

/v1/certificate-
authorities/{cald}/
enrollments

/vl/certificate-
authorities/{cald}/
enrollments

/vl/certificate-
authorities/{cald}/
enrollments

/vl/certificate-
authorities/{cald}/
enrollments

/vl/certificate-
authorities/{cald}/
enrollments

/v1/certificate-
authorities/{cald}/
enrollments

/v1/certificate-
authorities/{cald}/
enrollments

/v1/certificate-
authorities/{cald}/
enrollments

Suppo

rted
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certificates

See below for the certificate-supported capabilities.

Name Description

Lookup certificate by serial
number.

SearchBySerial

CertificateActio =~ Supported actionson a
n certificate.

CertificateRevo  Supported revocation reasons for

cationReason the certificate RevokeAction.

certificate-events

Endpoint

/v1/certificate-authorities/{cald}/
certificates/{serial}

/v1/certificate-authorities/{cald}/
certificates/{serial}/actions

/v1/certificate-authorities/{cald}/
certificates/{serial}/actions

See below for the certificate-event-supported capabilities.

Name Description

CertificateEvents Supports certificate events.

Maximum Size of content in
Certificate Events Page

MaxCertificateEve
ntsPageSize

domains

See below for the domain-supported capabilities.

Name Description

VerificationMet

hod

VerificationStat ~ Possible domain verification
us status states.

Filter Possible domain query filters

CA Gateway 3.7 - Docker Deployment Guide

Available verification methods.

Endpoint

/vl/certificate-authorities/{cald}/
certificate-events

/vl/certificate-authorities/{cald}/
certificate-events

Endpoint

/v1/certificate-authorities/{cald}/
domains/{domain}

/v1/certificate-authorities/{cald}/
domains/{domain}

/v1/certificate-authorities/{cald}/domains

Supporte
d

(/]

Supported

o

o

Supported

]

o
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status

See below for the status-supported capabilities.

Name Description Endpoint Supported
CAStatus  Return whether the CAis up or down. /v1/certificate-authorities/{cald}/status (x]
ca-properties
See below for the CA property-supported capabilities.
Name Description Endpoint Supported

CAPropertiesRetrieval ~ Retrieves CA properties  /v1/certificate-authorities/{cald}/properties (x]

Microsoft CA capabilities

See below for the capabilities supported by Microsoft Certificate Authorities.

enrollments
certificates
certificate-events
recoveries
subjects

status
ca-properties

enrollments

See below for the enrollment-supported capabilities

Name Description

EnrollmentByCS  Process certificate signing requests
R

X509CertificateR  Returns certificate in X509 form
esponse

PKCS12Respons  Return certificate and key in PKCS#12 form
e
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{cald}/enrollments

/v1/certificate-authorities/ o
{cald}/enrollments

/v1/certificate-authorities/ o
{cald}/enrollments
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Name

SANInCSR

SANInRequest

SubjectNamelnR
equest

CAGeneratedKey

KeylnRequest

CAGeneratedKey
Backup

ClientGenerated
KeyBackup

ExtensionInCSR

ExtensioninRequ
est

ValidateProofOf
Possesion

ValidityPeriodIn
Request

certificates

Description

Process Subject Alternative Names (SANs) in
CSR

Process Subject Alternative Names (SANs) in
enrollment request

Supply subject name parameters in request to
construct a subject DN in the supplied order

Generate the key and returned it to client in
PKCS#12 form

Supports client-generated keys for enrollment

in the enrollment request

Supports key backup for CA generated keys

Supports key backup for client-generated keys

Process extension request in CSR

Process extension request in enrollment

request

Validates proof of possession if requested

Supports validity period in request

See below for the certificate-supported capabilities

CA Gateway 3.7 - Docker Deployment Guide

Endpoint

/v1/certificate-authorities/
{cald}/enrollments

/v1/certificate-authorities/
{cald}/enrollments

/v1/certificate-authorities/
{cald}/enrollments

/v1/certificate-authorities/
{cald}/enrollments

/v1/certificate-authorities/
{cald}/enrollments

/v1/certificate-authorities/
{cald}/enrollments

/v1/certificate-authorities/
{cald}/enrollments

/v1/certificate-authorities/
{cald}/enrollments

/v1/certificate-authorities/
{cald}/enrollments

/v1/certificate-authorities/
{cald}/enrollments

/v1/certificate-authorities/
{cald}/enrollments

Suppor
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Name Description Endpoint Supporte
d

SearchBySerial  Lookup certificate by serial /v1/certificate-authorities/{cald}/ o

number certificates/{serial}

CertificateActio  List supported actionson a /vl/certificate-authorities/{cald}/ o

n certificate certificates/{serial}/actions

CertificateRevo  List supported revocation reasons  /vl/certificate-authorities/{cald}/ o

cationReason for the certificate RevokeAction certificates/{serial}/actions

certificate-events

See below for the certificate-event-supported capabilities

Name Description Endpoint Supported

CertificateEvents Support certificate events /v1/certificate-authorities/{cald}/ (V]
certificate-events

MaxCertificateEve  Return the maximum size of the /vl/certificate-authorities/{cald}/ o
ntsPageSize certificate events Page certificate-events
recoveries

See below for the recovery-supported capabilities

Name Description Endpoint Supported
Recover Recover certificate by DN /v1/certificate-authorities/{cald}/recoveries/{dn} V]
subjects

See below for the subject management-supported capabilities

Name Description Endpoint Supported

SearchBySubject ~ Lookup certificates by subject /v1/certificate-authorities/{cald}/subjects/ @
DN DN {dn}
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Name Description Endpoint Supported
SubjectDNAction  List supported actions on a /v1/certificate-authorities/{cald}/subjects/ @
subject DN {dn}/actions
status

See below for the status-supported capabilities

Name Description Endpoint Supported

CAStatus  Check whether the CAis up or down /v1/certificate-authorities/{cald}/status (x]

ca-properties

See below for the CA property-supported capabilities

Name Description Endpoint Supported

CAPropertiesRetrieval  Retrieve CA properties  /v1/certificate-authorities/{cald}/properties (]

Sectigo CA capabilities
See below for the capabilities supported by Entrust Certificate Authorities.

enrollments
certificates
ca-events
recoveries
subjects
status
ca-properties

enrollments

See below for the enrollment-supported capabilities

Name Description Endpoint Suppor
ted

EnrollmentByCS  Process certificate signing requests /v1/certificate-authorities/ o

R {cald}/enrollments
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Name

X509CertificateR
esponse

PKCS12Respons
e

SANINCSR

SANInRequest

SubjectNamelnR
equest

CAGeneratedKey

KeylnRequest

CAGeneratedKey
Backup

ClientGenerated
KeyBackup

ExtensionInCSR

ExtensioninRequ
est

ValidateProofOf
Possesion

ValidityPeriodIn
Request

Description

Returns certificate in X509 form

Return certificate and key in PKCS#12 form

Process Subject Alternative Names (SANs) in
CSR

Process Subject Alternative Names (SANs) in
enrollment request

Supply subject name parameters in request to
construct a subject DN in the supplied order

Generate the key and returned it to clientin
PKCS#12 form

Supports client-generated keys for enrollment

in the enrollment request

Supports key backup for CA generated keys

Supports key backup for client-generated keys

Process extension request in CSR

Process extension request in enrollment

request

Validates proof of possession if requested

Supports validity period in request
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Endpoint

/v1/certificate-authorities/
{cald}/enrollments

/v1/certificate-authorities/
{cald}/enrollments

/v1/certificate-authorities/
{cald}/enrollments

/v1/certificate-authorities/
{cald}/enrollments

/v1/certificate-authorities/
{cald}/enrollments

/v1/certificate-authorities/
{cald}/enrollments

/v1/certificate-authorities/
{cald}/enrollments

/v1/certificate-authorities/
{cald}/enrollments

/v1/certificate-authorities/
{cald}/enrollments

/v1/certificate-authorities/
{cald}/enrollments

/v1/certificate-authorities/
{cald}/enrollments

/v1/certificate-authorities/
{cald}/enrollments

/v1/certificate-authorities/
{cald}/enrollments

Suppor
ted
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certificates

See below for the certificate-supported capabilities

Name

SearchBySerial

CertificateActio

n

CertificateRevo
cationReason

ca-events

Description

Lookup certificate by serial
number

List supported actionson a
certificate

List supported revocation reasons
for the certificate RevokeAction

See below for the event-supported capabilities

Name

CAEvents

recoveries

Description

Support CA events

Endpoint

See below for the recovery-supported capabilities

Name

Recover

subjects

Description

Recover certificate by DN

Endpoint

Endpoint

/v1/certificate-authorities/{cald}/
certificates/{serial}

/v1/certificate-authorities/{cald}/
certificates/{serial}/actions

/v1/certificate-authorities/{cald}/
certificates/{serial}/actions

/v1/certificate-authorities/{cald}/ca-events

/v1/certificate-authorities/{cald}/recoveries/{dn}

See below for the subject management-supported capabilities

Name

SearchBySubject
DN

SubjectDNAction

Description

Lookup certificates by subject
DN

List supported actions on a
subject DN

CA Gateway 3.7 - Docker Deployment Guide
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Supporte
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o

Supported

o

Supported

o

Supported

/v1/certificate-authorities/{cald}/subjects/ @

{dn}

/v1/certificate-authorities/{cald}/subjects/ @

{dn}/actions
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status

See below for the status-supported capabilities

Name Description Endpoint Supported
CAStatus  Check whether the CAis up or down /v1/certificate-authorities/{cald}/status o

ca-properties

See below for the CA property-supported capabilities

Name Description Endpoint Supported

CAPropertiesRetrieval Retrieve CA properties  /vl/certificate-authorities/{cald}/properties o
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15 Troubleshooting

See below for troubleshooting CA Gateway issues related to EJBCA enrollment.

e EJBCA authentication failures
e EJBCA SSL/TLS Connection Failures
® EJBCA certificate issuance failures

EJBCA authentication failures

If you see authentication errors when enrolling certificates with an EJBCA certificate authority:

1. Verify the client certificate was issued by ManagementCA.
2. Verify the administrator was added as a member of the role with the correct match criteria.
3. Check that the role has access to the required CAs and End Entity Profiles.

See Configuring and issuing the EJBCA client certificate for details on each operation.

EJBCA SSL/TLS Connection Failures

If you see SSL/TLS connection errors when enrolling certificates with an EJBCA certificate authority:

1. Verify the trust store file path is correct.
2. Verify the EJBCA hostname matches the SSL certificate.
3. Check that the trust store contains the correct CA certificates.

4., For password-less JKS files, ensure trust-store-password is empty or omitted.

See EJBCA properties for details on the configuration parameters.

EJBCA certificate issuance failures

If certificates fail to issue with an EJBCA certificate authority:

1. Verify the End Entity Profile has access to the requested certificate profile.
2. Verify the certificate profile is configured for the desired key usage and extensions.

3. Check that Subject Alternative Names (SANs) are enabled in the End Entity Profile (if using SANs).

4. Review EJBCA logs for detailed error messages.

CA Gateway 3.7 - Docker Deployment Guide

212



@ ENTRUST

16 Integration report

A Gateway is a lightweight, container-based module implementing a CA-agnostic Certificate Lifecycle and Policy
Management API. Using CA Gateway, your applications can implement certificate issuance, renewal, and revocation
actions across all your Entrust-supported Certification Authorities (CAs). CA Gateway provides policy retrieval
capabilities that applications can use to customize APl and user-facing dialogs to ensure that certificate actions
conform to organizational policies.

¢ Supported Certificate Authorities

® Open-source plugins compatible with CA Gateway
e Supported Platforms

® Supported HSM

o CA Gateway supports easy upgrades using container technology. We maintain backward compatibility on
the APl so you can upgrade CA Gateway without worrying that consuming applications will encounter API
problems.

Supported Certificate Authorities

CA Gateway is compatible with the following Certificate Authorities.

Product Version Support Notes
AWS ACM CA CA Plugin for cert operations
Digicert CA Service Only supports domain-validated (DV) certificates
EJBCA Community
Edition
Entrust Certificate Authority 8.3 The Events APl is not supported
(ECA)
10.1.1
10.2
Entrust PKlaa$ Service CSRs must be provided on enrollment
GlobalSign Service Only GCC API. Only for testing purposes, not ready for

production environments

Microsoft Active Directory 2019, 2016, 2012 CSRs must be provided on enrollment
Certificate Authority R2
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Product Version Support Notes
Sectigo Certificate Authority Service Only supports TLS profiles. S/MIME profiles are not
supported

Open-source plugins compatible with CA Gateway

CA Gateway is compatible with the following open-source plugin.

o The supportis limited to the CA Gateway interoperation with the plugin.

Plugin Versio Notes

n
Entrust CA N/A This is an Entrust open-source client for Hashicorp Vault that may be obtained
Gateway Vault from https://github.com/EntrustCorporation/CSP CA Gateway-vault-plugin
Client

Supported Platforms

CA Gateway is distributed and operates as a Docker container. Our objective in leveraging Docker is to allow
customers to utilize the broad array of Docker capabilities, features, and plug-in drivers. Entrust will make
reasonable efforts to support our CA Gateway product on the customer's chosen Docker deployment.

Platform Version Note

Docker 20.x Operation as a Docker container is supported on all OS platforms supporting Docker.

Supported HSM

CA Gateway on Docker supports the following hardware security modules (HSMs).

Hardware Client driver Firmware Guide

Entrust nShield 13.9.0 (FIPS 140-2 Level 3 mode 12.60.15 & CA Gateway 3.x - Entrust nShield
Connect XC supported) 12.60.2 Integration Guide

Entrust nShield 5¢ 13.9.0 13.2.4

Thales Luna HSM 7 10.8.0 7.7.1-20 CA Gateway 3.x - Thales Luna

Integration Guide
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Hardware Client driver Firmware Guide

Thales TCT 10.8.0 7.7.1-20

o Log in trustedcare.entrust.com to download the integration guides.
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